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Document Change History 
This version of the document replaces all previous versions. The following table describes the 
most recent changes to this document. 

Revision Date Summary of Changes 
February 3, 2022 Updated the About Brightspace Editor topic with the new page attributes 

(title and language) functionality. 
Updated the Create an agent topic to include adding a category to the 
agent. 
Updated the Edit an agent topic to reflect the new Bulk Edit functionality. 
Added the Configure the visibility of courses in Discover topic.  
Updated the Configure a course for self-enrollment with Discover topic to 
include the ability to configure the visibility of courses. 
Updated the What kinds of files can I use for course content? topic with 
permissions to download and print content. 

January 6, 2021 Updated the Navigating in the Lessons interface topic with the new View 
Reports option. 
Updated the Add Existing material topic as availability dates can now be 
added to LOR linked content. 
Updated the Checking course content statistics topic with steps for 
accessing page using both content experiences. 
Removed the Check course content statistics topic. 
Added the Audio-Video Player topic and the Audio-Video Editor topic. 

December 2, 2021 Updated the Components for Import/Export/Copy topic to note that 
Intelligent Agents can now be imported and exported between courses.  
Updated the Content tool overview for instructors topic with updated 
badges in the Table of Contents. 

November 4, 2021 Updated the About Brightspace Editor topic to include additional tools that 
support the drag/drop and copy/paste functionality.  
Updated the About the Work To Do widget topic to include information 
about configuring date ranges. 

October 7, 2021 Updated the About Brightspace Editor topic. 
Added the View Course Import history topic. 
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September 2, 2021 Updated topic: Adding SCORM objects to Lessons. 
Updated the What course components can be exported? topic to add 
release conditions and any associations. 
 Updated the Components for Import/Export/Copy topic to include the 
ability to export and import release conditions. 

August 5, 2021 Updated topics to replace HTML Editor to read as Brightspace Editor.  
Updated the Create course content in the new Content experience 
(Lessons) topic. 
Updated the Organizing course content in Lessons topic. 
Updated the Navigating in the Lessons interface topic. 
Updated the Create a new unit topic. 
Updated the Create material by adding a link topic. 
Updated the Create a new lesson topic. 
Updated the What kinds of files can I use with Lessons? topic. 
Updated the Create new material topic as External Tool Activity is no 
longer an option in the Create New menu. 
Updated the Add Existing material topic. 
Updated the Using HTML templates in Lessons topic. 
Removed the Exemptions in Lessons topic. 
Updated the Set a course timeframe topic. 
Updated the About Brightspace Editor topic. 



 

15 
© 2022 D2L Corporation. All rights reserved. 

Set up and deliver a course 
To set up and deliver a course to learners, instructors can perform the following tasks: 

• Set up a course 
• Design an accessible course 
• Create course content 
• Administer a course 
• Monitor a course 

Set up course 
Instructors can set up a course with the following tools: 

• Log and classify books as course materials with the Book Management tool 
• Insert third party content into a course with Learning Tools Interoperability (LTI) links 
• Add metadata to learning resources with the Metadata tool 
• Self register into a course with the Self Registration tool 
•  Automatically customize course content with replace strings  
• Find activity that matches certain criteria with the Intelligent Agents tool 
• Define how learning materials interact with one another with SCORM 
• Upload and organize course files with the Manage Files tool 
• Build a course with the Course Builder tool 
• Create a course homepage and widgets 
• Create a course navbar and theme  

Build a course 
Use Course Builder to interact with your course materials, learning experiences, and 
assessments in one consolidated interface, allowing you to visualize and review your entire 
course at once. The Course Builder interface is straightforward and efficient, transforming the 
process of course design and set-up from multiple steps in different tools into simple one-step 
actions.  
As you build your course, Course Builder interacts with the following Brightspace Learning 
Environment tools:  

• Content  
• Manage Files 
• Discussions  
• Assignments  
• Quizzes  
• Grades  
• Competencies  
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Course Builder also extends instructional design guidance provided by the Instructional Design 
Wizard by implementing and displaying the blueprint you create in the wizard. If you decide not 
to use the Instructional Design Wizard, Course Builder still enables you to incorporate 
instructional design best practices when planning your course. As you build your course outline 
with modules and placeholders, you can add notes to each module and placeholder 
summarizing your course goals and learning objectives. When you are ready, you can populate 
your outline by creating appropriate lessons and activities within Course Builder.  

Course Builder terminology 

Item Description 

Nodes Each structure element in the course tree is called a node. Node is a general 
term that can represent a module, placeholder, or object. 

Modules A module is an organization element that can represent different chapters, 
units, or sections of your course. You must create a module in Course Builder 
before you can begin adding objects and placeholders. 

Placeholders A placeholder is essentially a container for an object. It is not visible to learners 
until you add an object to it. There are five placeholder types: link, file, 
discussion, assignment, and quiz. 
Placeholders help you define the structure of your course before you are 
prepared to compile actual course content. This enables you to plan your 
lectures, discussion topics, assignments, tests, and other course activities 
before you begin creating them. 
You can populate placeholders when you are ready by creating new content or 
linking to existing content. For example, if the completion of a particular course 
unit depends on acquiring files from another resource, drag placeholders into 
the course tree to represent those files until you receive them. 

Objects Objects are simply learning materials, activities, or assessments in your course. 
Object types include: links, learning objects, HTML files, discussions, 
assignments, quizzes, grade items, and learning objectives. 
When you create an object in Course Builder, you are in effect creating it within 
its respective tool and adding it to your course content. For example, when you 
drag a quiz object into the course tree from Add Content, Course Builder 
prompts you to enter its basic details and creates the quiz in Manage Quizzes. 
At a later time, you can go to Manage Quizzes to edit advanced quiz properties 
and add questions. 
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Understanding nodes and the course tree 
The course tree represents course content as a hierarchy of nested nodes. The appearance of 
each node denotes its type, the object type it holds, and the actions you can perform on it. 
The first node in the course tree is the course node. When selected, you can change your 
course offering information in the selected node panel.  

 

Course Builder interface overview 
The Course Builder user interface consists of three sections.  
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Section Description 

1) 
Toolbox 

You can add modules, placeholders, and objects to the course tree from three 
areas within the toolbox: Build Outline, Add Content, and Browse Tools.  
Build Outline provides you with module and placeholder elements that you can add 
to your course tree to create your course outline.  
Add Content provides you with a selection of objects you can create and add to the 
course tree or drag onto placeholders in the course tree. Direct access to object 
types within Course Builder enables you to bypass the complexity of setting up 
objects in their individual tool areas. You can create and add the following objects 
to the course tree:  

• Links 
• HTML files 
• Discussion topics 
• Assignments 
• Quizzes 
• Learning objectives 
• Existing learning objects from Brightspace Learning Repository 

Browse Tools displays a library of pre-existing objects in your course tools. From 
Browse Tools, you can locate and add these pre-existing objects to the course tree 
or drag them onto placeholders in the course tree. This section of the toolbox 
features a drill-down menu with breadcrumb links that appear at the top of the 
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toolbox as you navigate deeper into the menu. You can click on breadcrumb links 
to return to a previous section.  

2) Course 
Tree 

The course tree is a visual representation of your course structure. It displays the 
hierarchy of your course content as a series of nested nodes. The course tree 
simplifies the process of rearranging, copying, and deleting your course structure.  
Each structure in the course tree is called a node. Node is a general term that 
represents a module, placeholder, or object.  
Each non-module node in the course tree includes an icon indicating its type. This 
can help you to see what's in your course at a glance.  

3) 
Selected 
Node 
Panel 

When you select a node in the course tree, the selected node panel displays its 
details and enables you to perform actions on that node. From the selected node 
panel you can: 

• View general properties for an object 
• Edit placeholder properties to change the display name or add planning 

notes 
• Edit object properties 
• Launch an object's associated system tool 
• Perform node-related actions 

About course images 
To help instructors and course designers to create great visual experiences for their learners, 
the My Courses widget course tiles now include an instructor-chosen photograph. D2L provides 
an image library of over 3000 images which are licensed for use within the Brightspace Platform. 
Instructors and course designers can also upload their own image. 
Be aware of the following image size recommendations: 

• For logo images used on navbars, ensure that your image is a maximum size of 260 
pixels by 60 pixels, and saved as SVG filetype.  

• For course images, it is recommended that images are 2400 pixels by 960 pixels. Keep in 
mind that the display height and width of these images may vary in different tools and on 
different screens and devices. Ensure that any images that you are using appear correctly 
at different sizes and crop points on laptop, tablet, and mobile device screens.  
Note: To maintain security, ensure any .jpg images are clear of EXIF (exchangeable 
image file) data. 

Change the course image using the My Course widget actions menu 
Instructors with the permissions See Course Info and Change Course Image can change the 
image via the course tile through the following steps: 
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1. Log into Daylight-enabled Brightspace as an Instructor. 
2. In the My Courses widget actions menu, hover over or tab to a course image. 
3. Select More Options. 
4. From the drop-down menu, select Change Image. 
5. In the Course Image Library, find the desired image. 
6. Select Use this image on the image you wish to use. 

Adding an optional course image banner on a widget-based homepage 
It is possible to add a course image banner below the navigation bar on widget-based 
homepages for courses (and other org units such as departments, in the Brightspace Daylight 
Experience). The banner provides a venue to personalize the look and feel of homepages and 
provide a connection between the course tile in the My Courses widget and the homepage. 
Administrators control the prominence of this feature in the Brightspace Daylight Experience. By 
default, the d2l.Tools.Homepages.Banner.DefaultForCourses and the 
d2l.Tools.Homepages.Banner.DefaultForOtherOrgUnits configuration variables are turned 
off, indicating that instructors can opt in to using the banner image. To provide instructors with 
increased homepage personalization options in the Brightspace Daylight Experience, 
administrators should consider turning on the image banner by default and setting the See 
Course Info and Change Course Image permissions at the appropriate org unit levels. If the 
configuration variables are turned on, and the form element Use Course Image is set to Is 
Displayed, instructors can remove the banner using an option on the Course Offering 
Information page. 

Change the course image using the Course Image banner 
Instructors with the permissions See Course Info and Change Course Image can change the 
banner image for the course or custom org unit (i.e. department). 

1. Log into Daylight-enabled Brightspace as an Instructor. 
2. Select a course or org unit. 
3. On the homepage, hover over or tab to the Banner. 
4. In the Banner image, select More Options. 
5. In the drop-down menu, select Change Image. 
6. From the Course Image Library, find the desired image. 
7. Select Use this image for the image you wish to use. 

What is the relationship between Course Builder and Content? 
As you add modules, placeholders, and objects to the course tree, Course Builder synchronizes 
with various tools within Brightspace Learning Environment, including the Content tool. 
The way Course Builder interacts with the Content tool depends on what you add to the course 
tree: 
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• When you add a module to the course tree, the system generates a content module which 
appears in the Content tool. 

• When you add a placeholder to the course tree, the system generates an empty content 
topic. This content topic is hidden from the Content tool until you attach an object to the 
placeholder. 

• When you add an object to the course tree, the system generates a content topic. This 
content topic is visible in the Content tool. If you edit an object's placeholder name or 
notes within Course Builder, you are editing the name and shared designer comments of 
the corresponding content topic within the Content tool. 

To see how Course Builder content displays for learners, from the tool navigation, access the 
Content area. 

Creating a course structure 

Add a module or placeholder 

1. On the navbar, click Course Admin. 
2. Click Course Builder. 
3. From the Build Outline section of the toolbox, do one of the following: 

• Drag a module or placeholder into the course tree in the location you want. 
• Click on a module or placeholder element. From the Select a location dialog, click 

on the location you want to add your module or placeholder. 
4. Enter the module or placeholder details. 
5. Click Create. 

Add a new object  
When you create an object in the toolbox or drag a new object into the course tree, Course 
Builder interacts with its tool, enabling you to populate basic information and attributes. This 
streamlines the process of setting up your resources so you can focus on developing your 
course. From the toolbox or selected node panel, you can launch an object's corresponding tool 
to complete and finalize its details.  

1. On the navbar, click Course Admin. 
2. Click Course Builder. 
3. From the Add Content section of the toolbox, do one of the following: 

• Drag an object type into the course tree in the location you want.  
• Click on the object type you want to create. From the Select a location dialog, click 

on the module or placeholder you want to add your object to.  
4. Enter the object details. 
5. Click Create. 
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Add an existing object 

1. On the navbar, click Course Admin. 
2. Click Course Builder. 
3. From the Browse Tools section of the toolbox, locate the existing object you want to add 

to your course. 
4. Do one of the following: 

• Drag the object you want to add to your course into the course tree in the location 
you want. 

• Select the check box beside the object you want to add to your course structure and 
click Add to Course. From the Select a location dialog, click on the module or 
placeholder you want to add your object to.  

Add a new evaluation object 
After adding activity objects (discussions, assignments, and quizzes) to your course structure, 
you can associate them with evaluation objects (grade items and learning objectives). If an 
evaluation object is already associated with an activity, that association appears in the 
evaluation object's details when you browse objects. At the same time, an activity object 
displays grading details when it is associated with an evaluation object. 

1. On the navbar, click Course Admin. 
2. Click Course Builder. 
3. From the Add Content section of the toolbox, do one of the following: 

• Drag an evaluation object type onto a discussion, assignment, or quiz in the course 
tree. 

• Click on the evaluation object you want to create. From the Select a location 
dialog, click on the discussion, assignment, or quiz you want to add your evaluation 
object to. 

4. Enter your evaluation object's details.  
5. Click Create. 

Add an existing evaluation object 

1. On the navbar, click Course Admin. 
2. Click Course Builder. 
3. From the Browse Tools section of the toolbox, locate the existing grade item or learning 

objective you want to add to your course. 
4. Do one of the following: 

• Drag the evaluation object you want onto a discussion, assignment, or quiz object in 
the course tree. 

• Select the radio button beside the evaluation object you want and click Add to 
Course. From the Select a location dialog, click on the discussion, assignment, or 
quiz object you want to add your grade item or learning objective to. 
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Repair broken objects 
Deleting or moving files, links, discussions, assignment submissions folders, and quizzes within 
their tools can result in broken objects. If an object breaks, Course Builder displays a broken link 
status icon within its node. The object becomes a placeholder retaining its name and notes. 
To repair a broken object, drag an object from the toolbox onto the placeholder. 

Upload and organize course files 
The Manage Files tool is a file management system for your course. You can use this tool to 
organize and upload files associated with your course offering. We recommend that you 
organize your files into folders, creating a folder for each module of content.  
Manage Files enables you to select and upload files from your computer to Learning 
Environment. You can upload most file types to a content directory in Manage Files, but only 
files with specific extensions can be used as content topics.  
The functions you can perform in Manage Files can be divided into the following two categories: 

• Organize and manage course files and folders - Perform tasks such as creating, 
editing, deleting, uploading, moving files and folder, and zipping and unzipping files. 

• Create topics from your files - You can create topics using files from your course 
content structure. 

Note: When you unzip a file on the Manage Files page in a course, a message notifies you that 
the operation is happening in the background and that you will be notified when it is complete. 
This allows you to perform other tasks while waiting for the operation to complete. 
When the file successfully unzips, a notification appears in the minibar. Clicking the notification 
takes you back to the Manage Files page in the course. 
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Apply content permissions on folders in Manage Files 
If your organization enables the enrollment security configuration variable, users with the Access 
Course Files When Enrollment Security is Enabled role permission  can access Manage Files to 
view and download course files.  
If you want to hide specific course files from users, you can store those files in protected folders 
using folder names that begin with a dot (for example, .personal_notes). You can also rename 
existing folders to protect them. Protected folders are only available to users with the See File 
Listing role permission.  

1. Create a folder, or edit an existing folder. 
2. Add a period at the start of the folder name (for example, .personal_notes).  
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Create a Content topic in Manage Files 
To create a Content topic in Manage Files 

You can create a content topic using a file directly from Manage Files. The  Link icon displays 
beside files in use as topics in the Content tool.  

1. On the Manage Files page, select the check boxes beside the files you want to designate 
as topics.  

2. From the action bar, click the Add Content Topics icon.  
3. On the Add Multiple Topics page, from the drop-down list, choose a Parent Module for 

the topics. 
4. Enter Topic Titles. If you rename a file that is a topic in your course, it automatically 

updates the file reference in the Manage Content area.  
5. Click Add. 

Use caution when moving files and folders if they are referenced in the Content area. Moving a 
file that is currently in use as a topic might result in a broken link. 

Create a course homepage and widgets 
The homepage is the first page you see when you view the organization's My Home page or 
enter a course. The typical default homepage is widget-based. Widgets are sections of content 
that provide information and links to tools, courses, and personal settings. Organization and 
course homepages can point to Brightspace Learning Environment tools, such as 
Announcements or Content, or an external URL. 
Widgets are the building blocks of homepages. You can create, edit, delete, customize, and 
preview the widgets in your organization. 
There are two types of widgets available for your homepages: 

• System Widgets 
• Custom Widgets 

Share homepages and widgets 
Homepages and widgets can only be shared downward, to child org units. To ensure that a 
custom widget or homepage can be shared with child org units, create it at the organization, 
department, or semester level.  
To make a homepage available to child org units, on the Edit Homepage page, select the 
Share with child org units check box. When this option is selected, the homepage displays on 
the Homepages page of a child org unit. 
To make a custom widget available to child org units, on the Edit Widget page, select the Add 
an Org Unit check box. When this option is selected, the child org unit displays the custom 
widget in the Add Widgets list. 
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Make a course homepage the active homepage 
All courses are initially set up with a default course homepage by your system administration. 
You can use the Homepage Management tool to create a new homepage and set it as the 
active homepage for your course. Course homepages might be enforced by your organization. If 
so, the homepage listed on Homepages displays an Enforced status, and you cannot change 
your active homepage. 
There are three types of course homepages you can use: Widget-based (Displays a standard 
homepage with various widgets), Tool (Displays a system tool, such as Content, as your 
homepage), and External URL (Displays an external web page as your course homepage).  

1. To make your newly created homepage the active homepage of an org unit, on the 
Homepages page, from the Active Homepage drop-down list, select the homepage 

2. Click Apply. 

Setting column layout on a homepage 

1. On Admin Tools > Homepage Management, select Homepages. 
2. Do one of the following: 

a. Click Create Homepage and name the new homepage 
b. Copy an existing homepage to create a new homepage 

3. Select Share with child org units if the homepage is at the organization or department 
level and you want it to be available to child org units, such as courses. 

4. Select Change Layout and choose a one- or two-panel layout. 
5. Click Add Widgets to put widgets into the panels. 
6. Click Save. 

Create a widget-based homepage 
Widget-based homepages display a standard homepage that contains various widgets. After 
you create the homepage, you can add or remove widgets, customize their appearance, and 
create custom widgets to expand the functionality of your course homepage. 

1. On the navbar, click Course Admin > Homepages > Create Homepage. Or, from the  ... 
[Homepages Action Menu] at the bottom of the homepage, click Manage Homepages.  

2. Click Create Homepage.  
3. Enter a name and description for your homepage. 
4. In the Type drop-down list, select Widget-based. 
5. To add a header to your homepage below the navbar, select Include homepage header.  
6. Enter the replace string of the information that you want it to display. Replace strings are 

placeholders that refer to information in Brightspace Learning Environment; the system 
replaces these placeholders with the corresponding information when you apply them to a 
homepage header.  

7. To choose a layout for a widget-based homepage, click Change Layout. 
8. To add widgets to your homepage, click Add Widgets. 
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9. Style your added widgets by adjusting their properties. 
10. Click Save and Close. 
11. From the Active Homepage drop-down menu, select your homepage and click Apply.  

Add an optional course banner to a widget-based homepage 
It is possible to add a course image banner below the navigation bar on widget-based 
homepages for courses (and other org units, such as departments, in the Brightspace Daylight 
Experience). The banner provides a venue to personalize the look and feel of homepages and 
provide a connection between the course tile in the My Courses widget and the homepage. 
Administrators control the prominence of this feature in the Brightspace Daylight Experience. If 
the feature is turned on, the banner appears at the top of the course homepage by default. If you 
have the appropriate permissions, you can change or remove the course banner using the 
Options menu on the banner, the Edit Homepage menu at the bottom of the homepage, or the 
Homepage Banner setting on the Course Offering Information page. 

Adding a course image banner that is not turned on by default 
If your administrators do not configure the course image banner to be turned on by default, you 
can turn it on using the Course Offering Information page. Course images are used for the My 
Courses Widget, the course image banner and in Brightspace Pulse, and on all devices and 
screen resolutions. While the display size for the banner is 1170 by 200 pixels, it is 
recommended that the image you upload is 2400 by 960 pixels to ensure that the image you 
select displays clearly for all these scenarios. Images are automatically resized for the 
appropriate location and display.  

1. From the navbar, click Course Administration and select Course Offering Information. 
2. Click Browse and search for the image you want to use as the course banner.  
3. Select Display the image in a banner on the course homepage. 
4. Click Save. 

Edit image titles on homepage banners 
Instructors with appropriate permission can change the homepage banner image titles. The title 
can be changed to the Org Unit Name, a custom value (such as Hello {FirstName}) or the title 
can be deleted and nothing displays in the banner. 

1. Hover over or press TAB to enter the homepage banner to see the Banner Settings menu. 
2. Click to open the menu and select Customize Banner Text. 
3. Do one of the following: 

a. Click Org Unit Name and enter or edit the name. This is the default that appears in 
the banner.  

b. Click Custom to enter a custom value (such as Hello {FirstName}). To view 
information about what other strings you can use, click the inline help link.  

c. Click None to delete the current text and display no title on the banner. 
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4. Click Save. 

Editing the widgets on a homepage 
To edit the widgets on a homepage 

1. On the Admin Tools > Homepage Management page, select Homepages. 
2. Click to select the homepage you want to edit. 
3. In the Widgets area, do any of the following: 

• Click Add Widgets to add new widgets to the panels on your homepage. 
• Click Remove to remove an existing widget from the homepage. 
• Click on a widget to edit the appropriate fields to hide the title bar, replace the 

widget name, or restrict the ability to minimize the widget. 
4. Click Save. 

Updating the default settings across all homepages that use a widget 

1. On the Admin Tools > Homepage Management page, select Widgets. 
2. Select the Custom Widgets tab or System Widgets tab. 
3. Click Customize for the selected widget and make the required changes. 
4. Click Save. 

Create a tool-based homepage 
A tool-based homepage displays a system tool, such as Content as your homepage. 

1. On the navbar, click Course Admin > Homepages > Create Homepage. 
2. Enter a name and description for your homepage. 
3. In the Type drop-down list, select Tool. 
4. Select the tool you want to use as the homepage. 
5. Click Save and Close. 

Create a homepage with an external URL 
An external URL homepage displays a web page external to your organization as the course 
homepage. 

1. On the navbar, click Course Admin > Homepages > Create Homepage. 
2. Enter a name and description for your homepage. 
3. In the Type drop-down list, select External URL. 
4. Enter the URL location you want to use as your course homepage. 
5. Click Save and Close. 
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You can use a replace string to populate an external URL for an org unit. If you configure a 
homepage URL as follows: https://www.bing.com/search?q={OrgUnitId}, the replace string is 
populated with the users current OrgUnitId when the homepage is accessed. 

List of system widgets 
System widgets are defined by the Brightspace Learning Environment platform. You cannot 
modify the contents of system widgets or delete them, but you can change where the widgets 
are located on your course homepage and customize their display options. 

Widget Description 

Admin Tools The Admin Tools widget displays all of your available administrative links and 
provides easy access to the tools that you need to manage. The number of 
administrative links you are able to see in the Admin Tools widget is determined 
by your role’s permission settings in the Roles and Permissions tool. 

Announcements The Announcements widget communicates important updates and information to 
users. You can create Announcements items with formatted text, graphics, 
audio, and quicklinks. You can also choose the date range and conditions for a 
Announcements item's availability. 

Awards 
Leaderboard The Awards Leaderboard is a customizable system widget that can be added to 

the homepages of course offerings or any shared homepage. It displays the top 
10 users who have earned badges (Awards) in the course. Course 
administrators can configure the Awards leaderboard to display the learners with 
either the highest Number of Awards or Credits appearing at the top. Learners 
with the same number of awards/credits falling within the top 10 grouping are 
sorted by name in alphabetical order.  
The Awards Leaderboard widget is part of a premium package, and may not be 
available in your organization.  

Bookmarks This widget is used to bookmark pages in course content. The bookmark widget 
is typically located on course offering homepages. 

Calendar The Calendar widget consists of a mini-calendar and a list of upcoming events. It 
displays all events created by instructors and administrators for the applicable 
month. Clicking on a day in the widget's mini-Calendar filters the event list to 
only display events for that day. Clicking on an event in the widget takes you to 
the event in the Calendar tool. 

Capture The Capture widget enables you to access the recording and presentation 
functions of Brightspace Capture Encoder, and provides direct links to all 
Capture presentations in a course to learners.  
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Widget Description 

Content Browser The Content Browser widget enables you to browse course content, view 
recently visited topics, and view bookmarked topics from your course homepage. 
You can access your recently viewed and bookmarked topics from the content 
browser home and use the drill-down menu to navigate course content topics 
and modules. As you navigate deeper into content modules, the navigation at 
the top enables you to move up one module level or jump backwards to the 
Content Browser home. To view a topic, click on its name to launch it in View 
Content. The Content Browser widget retains the place you left off when you 
return to your course homepage. 

Course 
Administration 

The Course Administration widget displays links to your course administration 
tools. The number of links you are able to see in the Course Administration 
widget is determined by your role’s permissions in the Roles and Permissions 
tool. 

Google Search The Google Search widget enables you to search the web from your homepage. 
Your search results open in a new window using your default internet browser. 

My Courses The My Courses widget shows course offerings in which users are enrolled and 
can access. Users can pin courses in the widget and navigate to course 
homepages by clicking the course tiles. Pinned course tiles display notifications 
for unevaluated assignment submissions and quizzes, and unread discussion 
posts.  

My Settings The My Settings widget only displays links the user has permission to view. 
These permissions are located under Account Settings in the Roles and 
Permissions tool. Users with permission to edit specific course offerings can 
access the Course Management tool from the widget menu. 

Office 365 The Office 365 widget allows you to log in to your Office 365 account by entering 
your credentials. When you log in, the widget displays a list of your emails, 
calendar events, and OneDrive documents. Clicking anywhere in the widget 
takes you directly to your email, calendar, or OneDrive, depending on which tab 
you're on. Navigating to an individual email, calendar event, or OneDrive 
document within the widget is currently not supported. 

Role Switch The Role Switch widget enables you to temporarily switch your active role to 
another role in your organization by selecting it from a drop-down list. You can 
then navigate the org unit based on the permissions of another role without 
having to log out and log in as another user. For example, you can select 
another role to see how Course Home or a quiz appears to users in that role. 
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Widget Description 

Tasks The Tasks widget enables you to view and manage tasks from the Calendar 
tool. You can add a due date and additional notes to each task, and the system 
sorts them into the categories of Today, Upcoming, or Someday (no due date). 
If you mark a task complete, it disappears from the list. However, you can click 
the View Completed Tasks link to review the tasks you've finished. 

Updates The Updates widget can be configured to display any of the following links: 

• Unread submission files 
• Unevaluated assignment submissions 
• Unread discussions posts 
• New email 
• Ungraded quizzes 
• Quizzes that have not been attempted 
• Self-registration updates 

The Updates widget can only be configured or updated by a D2L Implementation 
Services Specialist or D2L Support. Please contact D2L Support if you want to 
customize the links displayed. 

User Links The User Links widget allows users to create a personal list of links to external 
websites. 

Work To Do  The Work To Do widget provides learners with a summary of their assigned 
learning activities that are overdue or have an upcoming due date or end date 
across all their courses (when added to the Organization homepage). If the Work 
To Do widget appears on a course homepage, the summary of learning activities 
only applies to the specific course.  

Creating a custom widget 
Custom widgets allow you to expand the functionality of available content in your homepages to 
suit your specific organizational and course needs. You can add custom HTML code to create a 
wide range of widgets. As an Instructor, you can create custom widgets for your courses, or use 
custom widgets shared to your course offerings from the organization, department, or semester 
level. 
Your administrator may have chosen to implement an additional safeguard on custom widgets 
called ‘sandboxing’. When a custom widget is sandboxed, a secure iFrame is created around 
the widget and prevents scripts from executing outside the widget. You can view if a widget is 
sandboxed or not on the list of custom widgets. Un-sandboxed widgets are not unsecured per 
se, but should only be created by trusted roles.  
In the widgets list, un-sandboxed widgets have a warning icon: 
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Figure: The float-over text on the icon indicates that the widget is not sandboxed. 

Create a custom widget 

1. On the Course Home page, click Course Admin > Widgets > Create Widget. 
2. Enter a name and description for the widget. 
3. To add your own HTML content to the widget using the HTML Source Editor, click the 

Content tab >  HTML Source Editor icon. Add your HTML custom code.  
4. To apply different styling options to the widget, click Customize Widget Style.  
5. In Widget Settings, do any of the following: 

• To hide the titlebar, clear the Display Titlebar check box. 
• To enable sandboxing of widget content, click to select Widget is Sandboxed 

and/or Render in iFrame. Note: If your role does not have permission to toggle this 
setting, but you feel your widget needs to be unsandboxed to behave as expected, 
please contact an administrator with the Widget Security permission. 

• To remove the default border style, clear the Display widget container style check 
box.  

• Select Prohibit minimizing widget to prevent users from closing the widget on the 
homepage 

6. To set a custom title, in the Widget Name section, select the Custom radio button. Enter 
your text in the field.  

7. Click Save. 
8. To attach release conditions to the widget, click the Release Conditions tab and do one of 

the following: 
• Click Attach Existing then select from existing release conditions available to the 

org unit. Click Save. From the dropdown list, select All conditions must be met or 
Any condition must be met.  

• Click Create and Attach to create a release condition and attach it. Click Create. 
From the drop-down list, select All conditions must be met or Any condition 
must be met.  

9. Click Save and Close.  

View and edit data on custom widgets 
In order for clients to store data related to Custom Widgets, a dedicated storage area tied to the 
widget, org unit, and user is available. This area can store information such as the settings for a 
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widget, including the status of a user dismissing a message or hiding the custom widget, or 
widget adoption in a specific course. By default, the system does not track custom data; the data 
can be accessed and manipulated using API calls. 
For more information about using APIs to view and manipulate the custom widget data, see 
Brightspace Developer Docs. 

About the Work To Do widget 
The Work To Do widget provides learners with a summary of assigned learning activities from all 
their courses that are overdue or have an upcoming due date or end date. The widget can be 
added to Brightspace homepages to aggregate data from all courses, and to course homepages 
to show only due and overdue learning activities from the course. 
The Work To Do widget displays the following learning activities: 

• Assignments 
• Checklists 
• Content 
• Courses 
• Discussions 
• Surveys 
• Quizzes 

Learning activities only appear in the Work To Do widget when the activity has a defined due 
date or end date. By default, the widget displays activities due or ending in the upcoming 2 
weeks, and overdue work from the previous 12 weeks; however, it is possible to customize 
these date ranges. Administrators with the Can See/Edit Config Variable Values permission 
can set the date ranges using the d2l.Tools.WorkToDo.OverdueWeekLimit and 
d2l.Tools.WorkToDo.UpcomingWeekLimit configuration variables. 
Important: To view the Work To Do widget, learner roles require the View Work To Do Widget 
permission set at the Organization level and/or at the Course Offering level to access the widget 
from the organization homepage or from course homepages. 

Add the Work To Do widget to your course homepage 
Before you begin: The Work To Do widget must be enabled for your organization in order to 
access it from the System widgets list. You must have a widget-based homepage set up for your 
course and permissions to edit homepages. Ensure you have set due dates for all learning 
activities in your course that you want to appear to learners in the Work To Do widget.  

1. At the bottom of your course homepage, click the Homepage Actions Menu.  
2. Click Edit this Homepage. 
3. In the Widgets area, click Add Widgets. 
4. Click System Widgets. Select the Work To Do check box. 
5. Click Add. 

https://docs.valence.desire2learn.com/
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6. Drag and drop the widget to the desired location on your homepage. 
7. Click Save and Close. 

About the My Courses widget 
In the My Courses widget, courses have associated images and learners can access their 
favorite courses by pinning them to the top of their course list. In the mobile view, widgets stack 
on top of each other, and the My Courses widget offers many options to instructors. 
With this widget, instructors and learners see courses by enrollment date, prioritizing current 
enrollments. Administrators and power users see courses by the last accessed date. If there are 
less than 50 total enrollments, they are sorted as follows: 

• The My Courses widget shows manually pinned courses in the Pinned tab. In the All tab, 
pinned courses appear first, followed by current enrollments, then future enrollments (if 
they are available or visible to the user) for a total of 12 enrollments. Note that more than 
12 courses might appear if they are all manually pinned. Pinned course tiles display 
notifications for unevaluated assignment submissions and quizzes, and unread discussion 
posts.  

• The Course Selector drop-down menu shows manually pinned courses, followed by 
current enrollments, then future enrollments (if they are available and visible to the user), 
and finally, past enrollments (if they are visible to the user). 

• The View All Courses navigation drills down into the courses by showing manually pinned 
courses, followed by current enrollments, then future enrollments (if available and visible 
to the user), then past enrollments (if available or visible to the user) as the default sort. If 
the user changes the sort order, the filter does not separate pinned courses from other 
courses based on sort order, filters, and search terms. 

If there are more than 50 total enrollments, they are sorted as follows: 

• The My Courses widget shows manually pinned courses in the Pinned tab. In the All tab, 
manually pinned courses are followed by up to 12 last-accessed courses. Note that more 
than 12 courses might appear in the widget if they are all manually pinned. 

• The Course Selector drop-down menu shows manually pinned courses, followed by up 
to 12 last-accessed courses, followed by all remaining courses available to the user. 

• The View all Courses area shows manually pinned courses followed by up to 12 last-
accessed courses, followed by all remaining courses available or visible to the user as the 
sort order. If the user changes the sort order, the filter does not separate pinned courses 
from other courses based on the sort order, filters, and search terms. 

Additionally, you can use the Customize this Widget option to configure the My Courses 
widget to display tabs that organize courses by Semester Name, Department, or Role for the 
Org. You can choose to sort the Semester Name and Department tabs alphabetically or 
reverse-alphabetically. Users can easily view all their courses by clicking through each tab.  
The following alerts are available in the My Courses Widget: 
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• startedInactiveAlert: You have courses that have started but are set as inactive. 
Users may not be able to access these courses. - This alert only appears to 
administrators and instructors who have access to inactive courses. 

• noCoursesMessage: You don't have any courses to display. - This alert only appears 
to new instructors and new learners who have not yet been enrolled in any course. 

Using images on the My Courses widget 
In the My Courses widget on your homepage, the courses display a default image assigned 
from the curated image library. You can also select an image that is more representative of the 
course from the library provided by D2L, or add your own image for the course tile.  
Any images that you include with the My Courses widget are available to include in the course 
components that you export, copy, or import. 
To change the default image, do the following: 

1. Navigate to your homepage by doing one of the following: 
• If your My Courses widget appears on the My Home page, click the My Home 

button.  
• If your My Courses widget appears somewhere else, navigate to the location of the 

widget. 
2. Hover over the course image and click the More Options menu. If you are using assistive 

technology or keyboard-only navigation, press Tab to access the More Options button 
and press Enter to view the menu items. 

 
3. Select Change Image or press Enter. 
4. Search or browse the list of available images. 
5. Hover over the image you want to use and click Use this image. If you are using assistive 

technology or keyboard-only navigation, press Enter to select the image. 
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Adding a course image to a new course template 
You cannot directly add an image to a course template, however, you can import an image from 
an existing course into the course template. After you have created a course that includes the 
image you want to use, you can use the Copy Components function to add the image to your 
course template. 
Note: To add a course image, you require the Change Course Image and Banner Text 
permission at the course template level. If you do not have this permission, the Course Image 
and Banner Text checkbox does not appear. 

1. Create a new template and select Add Components to the new template.  
2. Click Search for offering to find the course where the component image currently resides. 
3. Enter search parameters for the course. 
4. Select the radio button for the offering you want to use. 
5. Click Course appearance, and click Select individual items to copy. Note that you can 

view the course banner image from Manage files; however, it does not automatically 
appear in the form elements after you copy it.  

6. On the Choose Components to Copy page, select the Course Image and Banner Text 
checkbox. 

7. Click Continue. 
8. Click Finish. 

Adding a course image to an existing course template 
You cannot directly add an image to a course template, however, you can import an image from 
an existing course into the course template. After you have created a course that includes the 
image you want to use, you can use the Copy Components function to add the image to your 
course template. 
Note: The course banner image file does not automatically appear in the form elements when 
you copy it; however, you can view the image file in the Manage Files.  

1. In the Manage Courses tool, on the Templates tab, click the existing template where you 
want to add the My Courses widget image. 

2. Click Course Admin > Import/Export/Copy Components. 
3. Select Copy Components from another Org Unit and click Search for Offering. 
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4. Click Select Components. 
5. Select Course Appearance > Select individual items to copy. Note that you can view 

the course banner image from Manage files; however, it does not automatically appear in 
the form elements after you copy it.  

6. Click Continue. 
7. Select the image you want to copy.  
8. Click Finish. 

Displaying the course code in the My Courses widget 
The My Courses widget can display the course code below the course name if you select the 
Show Course Code option in the widget settings.  

1. On the My Home or Course Home page, navigate to the My Courses widget. 
2. From the My Courses context menu, select Customize this widget. 
3. Select Show Course Code. 
4. Click Save. 

Displaying the semester in the My Courses widget 
The My Courses widget automatically displays a status indicatorfor inactive and closed courses. 
In addition to that information, you can display the semester to which a course is associated 
below the course name if you select the Show Semester option in the widget settings.  

1. On the My Home or Course Home page, navigate to the My Courses widget. 
2. From the My Courses context menu, select Customize this widget. 
3. Select Show Semester. 
4. Click Save. 

Displaying course grouping tabs in the My Courses widget 
The My Courses widget can display tabs that sort courses by Semester name, Department, or 
Role below the course name.  

1. On the My Home or Course Home page, navigate to the My Courses widget. 
2. From the My Courses context menu, select Customize this widget. 
3. Do one of the following:  

• Select None to remove course grouping tabs from the widget. 
• Select Semester, then select an alphabetical sorting option from the drop-down 

menu. 
• Select Department, then select an alphabetical sorting option from the drop-down 

menu. 
• Select Role. 

4. Click Save 
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See future and past courses in the My Courses widget 
The d2l.Security.BypassDateCheck config variable allows users to see future and past 
courses in the My Courses widget, regardless of Access Future Courses or Access Past 
Courses role settings. Future courses will automatically appear in the widget if the user has less 
than 12 current enrolments. Past courses appear in View All Courses. 

Enable users to access future and past courses 

1. As an administrator in Brightspace Learning Environment, select Admin Tools. 
2. In the Admin Tools menu, under Security, select Roles and Permissions. 
3. From the Administrator drop-down menu, select Edit Settings. 
4. Under Course Access Options, Select the Access Future Courses checkbox and/or 

the Access Past Courses checkbox. 
5. Click Save and Close. 

Note: If a user has less than 12 current enrolments, future courses automatically appear in the 
My Courses widget. 

Are there restrictions on sharing custom widgets? 
You can only share a custom widget with child org units if the widget is created at the 
organization, department, or semester level.  
The following are the cascading effects if you share a custom widget from different levels:  

• The organization level - The widget is shared to all departments, semesters, course 
templates, and course offerings in the organization.  

• The department level - The widget is shared to all semesters, course templates, and 
course offerings in the department.  

• The semester level - The widget is shared to all course templates and course offerings in 
the semester.  

Change how a custom widget appears 
All widgets adhere to the Widget container style by default. You can edit the settings of custom 
widgets to customize the widget appearance on homepages. You cannot change how system 
widgets appear.  

1. On the My Home or Course Home page, click Style this widget in the context menu of 
the custom widget you want to change. 

2. Click the Content tab. 
3. Do any of the following to customize your widget appearance: 

• To hide the titlebar, clear the Display Titlebar check box. 
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• To remove the default border style, clear the Display widget container style check 
box.  

• To prevent users from closing the widget on the homepage, select the Prohibit 
minimizing widget check box. 

• To set a custom title, in the Widget Name section, select the Custom radio button. 
Enter your text in the field. 

4. Click Save. 

Change a homepage layout 

1. In the bottom right corner of the homepage, click Edit this homepage. 
2. To view all widgets available for use in the homepage you are editing, in the Widgets 

section, click Add Widgets.  
3. Select the check boxes beside the widgets that you want to add to the homepage panel, 

and click Add.  
Note: The widgets listed in the Add Widgets dialog are dependent on the tools available 
for use within your organization and added to the current org unit. 

4. To change a widget's vertical placement on a panel or move it to another panel, click and 
drag the widget. 

5. Click Save and Close. 

Change personal settings 
You can change your user profile, account settings, notifications, and more using the My 
Settings widget found on the My Home page. 

1. On the navbar, click My Home. 
2. On the My Home page, navigate to the My Settings widget. 
3. From the My Settings widget, click a setting: 

Note: Depending on your permissions, not all of the following settings may appear. 
• Profile - change settings for your profile picture, contact information, social 

networks, and personal information. 
• Account Settings - change settings for fonts, dialogs, Brightspace Editor, reading, 

video, locale and languages, pseudo-localization, signing in, applications, 
Discussions, Email, and metadata. 

• Notifications - change settings for email and mobile contact information, summary 
of course activity, specific tool notifications such as Grades and Quizzes, custom 
notifications, and course exclusions. 

• Email Address. 
• Change Password.  
• View my Progress - change settings for the Class Progress dashboard. 
• Locker - manage your locker and group lockers. 
• Brightspace ePortfolio - manage Brightspace ePortfolio. 

4. On the My Home page, navigate to the My Settings widget. 
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5. From the My Settings widget, click a setting: 
Note: Depending on your permissions, not all of the following settings may appear. 

• Profile - change settings for your profile picture, contact information, social 
networks, and personal information. 

• Account Settings - change settings for fonts, dialogs, Brightspace Editor, reading, 
video, locale and languages, pseudo-localization, signing in, applications, 
Discussions, Email, and metadata. 

• Notifications - change settings for email and mobile contact information, summary 
of course activity, specific tool notifications such as Grades and Quizzes, custom 
notifications, and course exclusions. 
Note: If you add a forwarding email address, or add a reply to address, you receive 
an email prompting you to verify your email address. If set by your administrator, 
this email verification message also lists the UserID or UserName of the person 
initiating the email address update. To verify your email address, click the link in the 
email verification message you received. 

• Email Address. 
• Change Password.  
• View my Progress - change settings for the Class Progress dashboard. 
• Locker - manage your locker and group lockers. 
• Brightspace ePortfolio - manage Brightspace ePortfolio. 

Create a course navbar and theme 
For each course, you can create a navbar with links to course-specific and organization-wide 
tools and resources, and a theme to customize and brand the look and feel of navbars and page 
backgrounds. 

About the navbar 
The navbar contains links to course-specific and organization-wide tools and resources. Each 
course (or org unit) has its own navbar that links to relevant tools for that course. You can create 
custom links and link groups if you want to include URL links to third-party tools and other areas 
of Brightspace Learning Environment. 
Your organization or specific department can share navbars with courses and other org units to 
ensure consistent branding and navigation. If you have permission to manage navbars, you can 
use a shared navbar or create a navbar specifically for your course. New course offerings (or 
org units) use the default navbar set by the organization (or parent org unit). 
Navbars created at the course level cannot be shared with other courses, but you can create 
and store them inside a course template to make them available in course offerings that use the 
course template. 
Navbars consist of two components: a theme that controls the look of the navbar and the navbar 
itself (which controls the links available on the navbar).  
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At the organization level, navbars listed on the Navbars page display information about whether 
a navbar is shared to other org units. At the course offering level, all navbars listed on the 
Navbars page display information about whether they are shared from another org unit (such as 
a department, course template, or the organization), and the name of the org unit sharing the 
navbar. If you have permission to manage shared navbars, the name of the org unit sharing its 
navbar becomes a link to the Navbars page where the navbar was created. 
You can only share navbars with child org units below the org unit in which they were created. 
For example, if you create a navbar in a department you can only share it with all courses in that 
department.  
You cannot add all tools and functionality to a navbar. Some tools are only available in widgets 
and on the minibar. You can now add a link in the navbar to the Agent List page. 

About the Home icon on the navbar 
The appearance of a home icon depends on whether the navbar contains a logo, and the 
content on the org unit level. In some cases, schools or departments at the org level want to 
feature their logo, but also retain access to My Home. The Home icon () and logo adhere to the 
following rules: 

• If there is no logo, a Home icon displays on the navbar. 
• If a logo is set that has a different destination than My Home, the Home icon and logo 

both display on the navbar. 
• If a logo is set and the destination is My Home, only the logo displays on the navbar. 

Create a navbar 
To create a custom navbar 

1. On the navbar, click Course Admin. 
2. Click Navigation & Themes > Create Navbar. 
3. Enter your navbar details. 
4. In the Links area, click Add Links. Select your links, and click Add. The list of links 

available depends on the tools your organization uses, the custom links and link groups 
available, and the tools enabled for your course. 

5. If applicable, click to select Enable Icon-Based Navbar. 
6. If you want to change the theme of your navbar, click Change Theme. Select a new 

theme and click Update. 
7. If applicable, click to select Share with child org units. 
8. Click the context menu to change the title in the navbar, and select the appropriate option 
9. Click Save and Close. 
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Enabling image-based navigation 
Image-based navigation is an image-focused navigation feature in Daylight to aid pre-readers in 
navigating Brightspace Learning Environment. In this mode images supplement text links within 
Daylight. You can use the available images for the most commonly used system links or upload 
custom images. 
Images are sized to 60 pixels by 60 pixels and associated with their corresponding link in the 
navigation bar. A pull-out menu allows for all icons to be seen at once, rather than appearing in 
a separate menu altogether. 
To enable icon-based navigation 

1. In Roles and Permissions, select “Enable Icon Based Navbars” for appropriate roles. 
2. On the Edit Navbar page, enable the field “Icons: Enable Icon-Based Navbar”. 
3. Create an icon link. 
4. Do one of the following to upload an image for the link: 

• Click Upload to browse for a custom icon for the link. 
• Drop a file on the Upload System Icon field to use a custom icon for the link. 
• Verify that the icon that appears to use the system icon. 

5. Click Save. 

Changing the color in the navbar 
The color of the strip across the top of the screen is set from the Themes tab in the Navigation 
and Themes tool. You can select the Organization Default Color or set a unique color for the top 
color strip for each theme. If you do not set a unique color for a theme, the top color strip and 
link area defaults to the Organization Default Color. 
Note: It is good practice to use a color that is WCAG compliant to ensure the best possible color 
contrast with white text. 
To set a unique color for a theme: 

1. Navigate to Course Admin and then click Navigation & Themes. 
2. On the Themes tab, click Create Theme. 
3. Enter a name for the new theme. 
4. Under Primary Color, you can either use the default primary color or select Choose 

colors and select a primary navbar color. 
5. To set the navbar text to be black, select Dark Foreground or to set the navbar text to be 

white, select Light Foreground. 
6. Under Accent Color, you can either use the default accent color or select Choose a 

color and select an accent color. 
7. Click Save and Close. 
8. Add the theme you just created to your navbar.  

a. On the Navbars tab, to edit your Navbar, click on its name.  
Note: You cannot edit the default navbar set by your organization. You must create 
a new navbar if you want to change the color of the navbar. 
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b. Select Change Theme 
c. Find the theme you created and select it. 

9. Click Save and Close. 

Applying logos on department and course level navbars 
You can apply navbar logos at all org unit levels using the active navbar and theme. This feature 
allows organizations to showcase different logos at the org, department, course, and custom org 
unit level. The logo is pulled from the Logo field in the active navbar's current theme.  
Logos should be a maximum size of 260 pixels (width) by 60 pixels (height) for use on the Org 
navbar. Logos are reduced to two thirds (2/3) size when an org unit name is included in the 
course navbar and on mobile displays. D2L recommends that you use an SVG image to ensure 
that the logo image can scale to the appropriate size in the display. 
To change the navbar logo on an existing navbar 

1. In Admin Tools > Navigation and Themes> Themes, click a theme. 
2. In the Logo field, add your file of your chosen logo.  
3. Click Save. 

Applying an org unit name to a navbar 
In addition to the logo, you can configure the org unit name to appear, except on the org navbar 
(which always hides the name), and course navbar (which always shows the name).  
To include the org unit name in the navbar: 

1. From the Admin Tools menu, click Navigation and Themes. 
2. Click Themes. 
3. Click the current theme. 
4. In the Name field, enter the org unit name. 

Add a new custom link to the navbar 

1. On the navbar, click Course Admin. 
2. Click Navigation & Themes. 
3. From the tool navigation, click Custom Links > Create Link and ensure the following 

fields are filled in:  
• Name: The name of the link you want to appear in the navbar. 
• URL: Add the URL path the custom link follows or click Insert Quicklink to link to 

existing course material or third-party tools. 
• Behavior: Determines the behavior of the user interface when the link is clicked. 

• If you selected New window/tab, specify the Width (px) and Height (px) of 
the new window/tab. 
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• Under Browser Attributes, specify if you want the new window to include the 
Menubar (File, Edit, etc.), or the Toolbar (Back, Refresh, etc.) or neither of these 
options. 

• Description: Provides an optional description of the custom link. 
• Icon: An icon to use with the custom link. 
• Availability: Determines the visibility of the custom link.  

• To share with child organization units, select the Share with child org units 
check box. 

• To limit the visibility of the custom link to specific roles, select the Limit to 
specific roles check box and then select the roles. 

• To limit visibility of the custom links to users with specific locales, select the 
Limit to specific locales check box and then select the locales 

4. Click Save. 

  
  
  

Create custom link groups 
Custom link groups are individual links grouped together into sets of links. You can create 
custom link groups and use effective link group names to suggest relationships or common 
features each group shares. For example, you could create an Assessments link group that 
contains links to the Quizzes, Assignments, Surveys, and Self Assessments tools. 
When you create a custom link group and add it to a navbar link area, the link group appears as 
a drop-down menu labeled with the custom link group name. 

1. On the navbar, click Course Admin. 
2. Click Navigation & Themes. 
3. From the tool navigation, click Custom Links > Create Link Group. 
4. Enter a name for your custom link group. 
5. Upload or choose an existing icon for your link group. 
6. Enter a description for your link group. 
7. Select the Share with child org units check box if applicable. 
8. In the Links area, do any of the following: 

• To add existing links to the group, click Add Existing Link. Select the links you 
want to add and click Add. 

• To add a new link to the group, refer to the Add a new custom link to the navbar 
topic. 

9. Click Save. 
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Delete a navbar 
You cannot delete an active or default navbar, and you can only delete a navbar from the org 
unit (or organization) in which it was created. 
If you delete a navbar that is shared to child org units, all child org units using the navbar will 
automatically revert to the default navbar. 

1. On the navbar, click Course Admin. 
2. Click Navigation & Themes. 
3. On the Navbars page, from the context menu of the navbar you want to delete, click 

Delete. 

Change a course navbar 

1. On the navbar, click Course Admin. 
2. Click Navigation & Themes. 
3. From drop-down list under the Active Navbar section, select a navbar for your course. 
4. Click Apply. 

About themes 
Themes enable you to customize and brand the look and feel of navbars and page 
backgrounds. Themes do not control the type of links navbars can contain. When you create a 
theme, there are two colors in the theme you can configure to ensure a consistent user 
experience and adhere to your organization's branding guidelines: the Primary Color and Accent 
Color. The Primary Color modifies the background of the link area in the navbar and units in 
Lessons (each lesson and folder in a unit displays the same color, only lighter), if enabled. The 
Accent Color modifies the thin color strip above the navbar. 
Note: If no color is specified for the Primary Color, the default “rainbow” colour scheme is used 
in Lessons, if enabled. 
At the course offering level, all themes listed on the Themes page contain information about 
whether a theme is shared from another org unit and the name of the org unit sharing the 
theme.  
If your permissions do not allow you to create themes, you must select from existing themes or 
use the default theme.  
Themes created in an org unit are automatically shared with child org units.  
Themes created at the course level cannot be shared with other courses, but you can create 
and store them inside a course template to make them available in course offerings that use the 
course template.  
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Create a theme 
To create a theme 
The Theme Preview area displays changes as you make them. 

1. On the navbar, click Course Admin. 
2. Click Navigation & Themes. 
3. Click Themes > Create Theme. 
4. Enter a Name and Description for your theme. 
5. Upload or choose an existing Logo for your theme. SVG files are recommended for better 

scaling. The logo can be up to 260 x 60 pixels, but displays at smaller sizes for smaller 
devices or when viewing a navbar with a course title. 

6. Choose a Primary Color to modify the background of the link area in the navbar and units 
in Lessons (each lesson and folder in a unit displays the same color, only lighter), if 
enabled.  
Note: If no color is specified for the Primary Color, the default “rainbow” colour scheme is 
used in Lessons, if enabled. 

7. Choose an Accent Color to modify the thin color strip above the navbar. 
8. If you want to customize the link destination, click the context menu and select the correct 

destination from the options in the menu.  
9. Click Save and Close. 

Delete a theme 
You cannot delete a default theme or a theme shared to you from the organization, a parent 
course, or department. 
You are prompted to choose a replacement theme for the navbars using the theme you want to 
delete. If a theme with an identical layout does not exist, you are not allowed to delete the theme 
until you have created an acceptable replacement. 

1. On the navbar, click Course Admin. 
2. Click Navigation & Themes. 
3. On the Themes page, from the context menu of the theme you want to delete, click 

Delete. 
4. In the Choose a Replacement dialog, from the drop-down list, select a new theme. 
5. Click Delete. 

Automatically customize course content using replace strings 
A replacement string allows instructors to customize course content and communications in 
Brightspace Learning Environment by incorporating the intended learner's personalized 
information, such as their name, automatically. This feature can help instructors build better 
relationships with learners, increase engagement levels, and improve the overall learning 
experience. 
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Replace strings, sometimes referred to as display configuration variables, are configuration 
variable names enclosed in curly braces {} that are automatically replaced by the corresponding 
configuration variable values. For example, if you enter the text {OrgUnitID} into a document, 
when you view the document you will see the Organization Unit ID (ou #) of the course.  
Replace strings are used in all tools that use Brightspace Editor. However, evaluation rules for 
the replace strings vary with the tool as follows:  

• For the Content tool, curly braces are stripped even if the string is not a valid configuration 
variable or a replace string that does not apply to the Content tool. Then, replace strings 
are evaluated only once when first entered. Thereafter, there is no record of a 
replacement string having been entered. For example, if you enter {OrgUnitID} into a 
Content topic in course 'A' and later copy that topic into course 'B', the ou # of course 'A' 
course will display in the topic in course 'B'.  

For all other tools, any curly braces are NOT stripped if the string is not a valid configuration 
variable or a replace string that does not apply to the tool. Then the replace string is evaluated 
each time the document containing the replace string is viewed. For example, if you enter 
{OrgUnitID} into a Discussion topic in course 'A' and later copy that topic into course 'B', the ou # 
of course 'B' will display in the post in course 'B'.  

• Not all replace strings apply to all tools as described below.  

Replace strings are particularly useful within the following: 

• Course Homepage Widgets 
• Custom Navigation Bar Links 
• Navigation Bars 
• Mail Templates 
• Grades when adding bulk feedback 

An example of using replace strings in a custom widget for a course home page 
For example, if the text {UserName} is in the code of a custom widget for a course home page, 
users in that course will see their user names displayed.  
The available replace strings are: 

Organization replace string Description 

{OrgId} ID number of the 
organization 

{OrgName} Name of the organization 
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Org Unit replace string Description 

{OrgUnitId} ID number of the organization unit 

{OrgUnitName} Name of the organization unit 

{OrgUnitCode} Code for the organization unit 

{OrgUnitTypeId} ID number of the type of the 
organization unit 

{OrgUnitPath} Path to files for the organization unit 
 

User replace string (Unavailable in the 
Content tool) 

Description 

{UserId} ID number of the user. This value is used internally 
by the system 

{UserName} Full name of the user or the username entered to log 
on 

{OrgDefinedId} Organization ID. This is an identifier specified by the 
campus for the user 

{FirstName} First name of the user 

{LastName} Last name of the user 

{Email} User's internal email address 

{ExternalEmail} User's external email address 

{InternalEmail} User's internal email address 
 

Role replace string (Unavailable in the 
Content tool) 

Description 

{RoleId} Internal ID number for 
user's role 

{RoleCode} Code for user's role 
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Role replace string (Unavailable in the 
Content tool) 

Description 

{RoleName} Name of user's role 
 

Mail Template replace string Description 

{HelpDeskEmail} Email address of the Help Desk 

{HelpDeskName} Name for the Help Desk 

{LoginPath} URL of the login path for this site 

{PasswordResetLink} Link for users to reset their 
passwords 

Log and classify books as course materials 
The Book Management tool enables you to input, edit, and delete book information using 
International Standard Book Numbers (ISBN). You can log books using 10-digit or 13-digit 
ISBNs and classify books as required reading materials for classes. Users require the Manage 
Content permission to access the Book Management tool. 

Add a book 

1. On the navbar, click Course Admin > Book Management. 
2. On the Book Management page, click Add Book. 
3. Enter the ISBN. 
4. If you want to classify the book as required reading material for a course, select the 

Required check box. 
5. Click Add. 

Edit a book 

1. On the navbar, click Course Admin > Book Management. 
2. Beside the ISBN you want to edit, click the Edit icon. 
3. Make your changes. 
4. Click Save and Close. 
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Learning Tools Interoperability: Content-Item Message Service 1.0 
Content-Item Message is an LTI service that allows instructors to insert third party content into 
Brightspace Learning Environment using a standard integration that your administrator needs to 
set up prior to your usage. Placements represent locations in Brightspace Learning 
Environment, in which you can access the integrated third party tool and insert its content. 
Supported placements include Content > Existing Activities, and within Brightspace Editor > 
Insert Stuff, and Insert Quicklink. 

Add third-party content from the Content tool 

1. In Content, from the Existing Activities drop-down list, select the third party tool you 
want to add content from. 

2. In the Add Activity dialog box, select and insert the content you want to add into your 
course. These topics appear as content topics in your course. 

Add third-party content from Insert Stuff 
To add third-party content from Insert Stuff 

1. In Brightspace Editor, click the Insert Stuff icon. 
2. Under Insert Stuff, select the tool that you want to select content from. 
3. Select and insert the content you want to add into your course. 
4. Preview the selected content and click Insert. 

Add third-party content from Insert Quicklink 

1. In Brightspace Editor, click the Insert Quicklink icon. 
2. In the Third Party section, select the tool you want to add content from. The selected 

content is added into Brightspace Editor as a Quicklink. 

Add third-party content from Course Import 

1. In Content, click Table of Contents. 
2. From the Import Course drop-down list, select the third-party tool containing the content 

you want to add. 
3. In the Import Course Package dialog box, select the course package you want to add 

into your course. 
4. Click Import All Components. 
5. Click View Content. 
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Add third-party content from Import/Export/Copy Components 

1. From the Admin Tools menu, click Import/Export/Copy Components. 
2. Select the Import Course from External Learning Tool radio button and select the third-

party content provider you want to use to import course content. 
3. Click Start. 
4. In the Import Course Package dialog box, select the course package you want to add 

into your course. 
5. Click Import All Components. 
6. Click View Content. 

Add metadata to learning resources 
Metadata is information about a learning resource that you add to the resource to help other 
users locate it and understand its purpose.  
Administrators can create views, templates, and taxon schemas for your organization to enable 
users to enter repetitive metadata information quickly and consistently.  

Metadata and the Content tool 
You can add and edit metadata for content modules and topics when you publish them to 
Brightspace Learning Repository. You can also add metadata to content modules and topics 
from directly within the Content tool. 

Metadata and the Brightspace Learning Repository tool 
You can search for learning resources (objects and files) based on their metadata from within a 
Brightspace Learning Repository (LOR), and you can view an object’s metadata to determine 
whether it suits your needs before you import it into a course. Depending on your permissions, 
you can also edit the learning object’s metadata. Organizations can also require adding 
metadata when publishing a learning object to an LOR and can specify a set of required 
metadata that is mandatory for learning objects.  

Metadata interfaces 
There are two interfaces that you can use to enter metadata: 

• Basic interface - The basic interface presents a simple list of fields grouped into 
categories. Users cannot specify a language for their values or enter values in multiple 
languages, nor can they add additional values to a field (although they can configure a 
view to display a field multiple times in the basic interface, enabling users to enter multiple 
values). 
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• Advanced interface - The advanced interface enables users to specify their language, 
enter values in multiple languages, and enter multiple values for some fields. If a view is 
part of the IEEE LOM family, its fields display as a hierarchy in the advanced editor. 

Best practices for using metadata 

• If you want to only see category names instead of all of the fields in every category, 
enable the basic interface. If you choose to only display the category names, you can still 
show the fields in the first category by default. 

• If you want to use a template, import metadata, or copy metadata from another resource, 
do so before manually entering data. Any data you enter manually is erased when you 
apply existing metadata from another source.  

• In some fields, you may need to enter more than one value; for example, if a resource has 
multiple keywords or multiple authors/contributors. In the basic interface, if a field accepts 
multiple values, it is listed multiple times. In the advanced interface, you can manually add 
additional values to a field and then enter data for the additional values. Each value can 
have multiple translations in different languages.  

• If another resource in your course has similar metadata, you can copy that resource’s 
metadata and then modify it, rather than re-entering all of the information. 

• Views within the same family provide different ways of looking at (or entering) the same 
metadata, but views in different families provide access to different metadata. Keep this in 
mind when you determine what views to make available to users in your organization. 

• Switching views can lead to conflicts and will cause you to lose unsaved changes. Avoid 
switching views where possible. 

• Use a standard naming convention for templates in your organization. 
• Use replace strings to add dynamic information to a template.  
• If you want to specify the language of your metadata and enter data for a single field in 

multiple languages, use the advanced interface. 

Troubleshooting metadata conflicts 
Conflicts occur when a resource’s metadata violates restrictions set by the current view. You 
might encounter a conflict when you: 

• Switch between views 
• Switch from the advanced interface to the basic interface 
• Apply a template 
• Import metadata 
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Conflict Reason Result Resolution 

Character 
Limit 

The value of the data exceeds 
the character limit set for the 
field 

The value 
truncates 

Use a shorter value or cancel your 
changes and use the advanced interface 
or an alternate view 

Vocabulary The value of the data does not 
belong to the restricted 
vocabulary set for the field 

The value 
clears 

Select a value from the field’s restricted 
vocabulary or cancel your changes and 
use the advanced interface or an 
alternate view 

Multiplicity A field contains more values 
than the view allows 

Additional 
values save 
but do not 
display 

Use the advanced interface or an 
alternate view if you want to see or edit 
the additional values 

Language Occurs when you import data 
in a language not used by the 
Metadata tool in your 
organization 

The language 
changes to 
“unspecified” 

Select an alternate language, leave the 
language unspecified, or ask site 
administration to add the language 

Using metadata views 

Metadata views 
A view is a collection of fields. A field corresponds to one piece of data that you enter as part of 
a metadata object. For example, title, description, author, date created, and rights are all 
possible fields. Different views enable users to see and modify different fields when looking at 
metadata. 
Brightspace Learning Environment includes six base metadata views that implement widely 
used metadata standards: 

• Dublin Core (http://dublincore.org/documents/) - This view categorizes metadata using 15 
different elements: contributor, coverage, creator, date, description, format, identifier, 
language, publisher, relation, rights, source, subject, title, and type. 

• GEM - This view categorizes metadata using 9 different elements: general, life cycle, 
meta-metadata, technical, educational, rights, relation, annotation, and classification. 

• IEEE LOM - This view categorizes metadata using the 15 Dublin Core elements, plus 7 
additional elements: audience, cataloging, duration, essential resources, pedagogy, 
quality, and standard. 

• Normetic (http://www.normetic.org/ (French) or http://www.normetic.org/-English-.html 
(English)) - This view is a French version you can use to categorize metadata based on 
the IEEE LOM view. 

http://dublincore.org/documents/
http://www.normetic.org/
http://www.normetic.org/-English-.html
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• Object Publishing - This view categorizes metadata based on a simplified Dublin Core 
view using 3 different elements: title, description, and keywords. 

• Object Publishing IEEE LOM - This view categorizes metadata based on a simplified 
IEEE LOM view using 3 different elements: title, description, and keywords. 

Default system views refer to any of the views that ship with Brightspace Learning Environment 
by default. 
Brightspace Learning Environment also includes two default system views that inherit from the 
IEEE LOM base view: 

• CanCore (http://cancore.tru.ca/en/) 
• Asset Metadata 

Create a metadata view 
Creating a new metadata view may be necessary for any number of reasons. For example, you 
might require a view for a specific department to refine the general organization’s view, or a 
simplified view for users who do not require access to all of the metadata associated with your 
organization’s resources. 
You can create new views based on any of the available views, including views you have 
previously created. When creating a new view, you can rename, reorganize, and hide fields, 
change field types, and set data restrictions; however, you cannot add additional fields or 
radically alter the structure of the base view. 
Some of the fields in IEEE LOM and Dublin Core are cross-walked, meaning the values from 
those fields automatically synchronize between the two views. In fields that are not cross-
walked, the values entered in a view from one family are not visible across families. 
Keep this in mind when you determine what views to make available to users in your 
organization. Views within the same family provide different ways of looking at (or entering) the 
same metadata, but views in different families provide access to different metadata. 

1. From the Admin Tools menu, click Metadata Administration. 
2. On the Views page, click New View. 
3. Enter a View Name. 
4. From the Parent View drop-down list, select the parent view that contains the structure 

that you want your view to inherit. 
5. Do one of the following: 

• If you want your view to inherit its settings from its parent, select Inherit Properties 
from Parent View. 

• If you want your view to copy properties from an existing view, select Copy 
Properties from an Existing View. 

6. Click Save. 
7. On the Edit View page, using the provided tabs, further customize your General, 

Restrictions, and Layout options. 
8. Click Save. 

http://cancore.tru.ca/en/
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Import a metadata view 
You can add a metadata view by importing an XML file into Brightspace Learning Environment. 
Brightspace Learning Environment treats any view that you import as a customized view and 
maintains the language terms defined in the org unit that the view comes from. For example, if a 
French org defines a view with French terms and exports the view, then when you import the 
view in another org unit, users see the French terms even if they are using English. 

1. From the Admin Tools menu, click Metadata Administration. 
2. On the Views page, from the More Actions button, click Import View. 
3. On the Import View page, enter a View Name. 
4. To select the view that you want to import, click Browse. Locate your file and click Open. 
5. Click Import. 

Export a metadata view 
You can export a metadata view as an XML file. When you export a metadata view, it retains the 
language terms that you have in your org unit. For example, your French org defines a view with 
French terms and exports the view, then when other users import the view in another org unit, 
they see the French terms even if they are using English. 

1. From the Admin Tools menu, click Metadata Administration. 
2. On the Views page, from the More Actions button, click Export View. 
3. From the Export View drop-down list, select the view you want to export. 
4. Click Export. 

Using metadata languages 

Set initial metadata language 
The initial language serves two purposes: All the metadata you enter through the basic interface 
is associated with the initial language and the initial language is selected by default for values 
entered through the advanced interface. 

1. From the Admin Tools menu, click Metadata Administration. 
2. On the Metadata Languages page, in the Actions column for the language you want to 

set as default, click the Set Initial Language icon. 

Add a metadata language 
You can add a language for users in metadata fields. This enables users, when publishing a 
content topic, to enter multiple descriptions for the topic in different languages. For each 
language variant, users specify the language they use from the choices available. 
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1. From the Admin Tools, click Metadata Administration. 
2. On the Metadata Languages page, from the Select a Language drop-down list, click the 

language you want to add. 
3. If you want to identify regional variations for your chosen language, from the Select a 

Country drop-down list, click the country you want to add. 
4. Click Add. 

Using metadata templates 

Metadata template types 
Brightspace Learning Environment comes with 4 basic metadata template types: 

• Default Template 
• Dublin Template 
• GEM Template 
• IEEE Template 

Create a metadata template 
A template is a collection of predefined values that users can use to quickly add standard 
metadata to a resource. Templates enable you to quickly apply standard metadata to resources 
that have duplicate information, saving you from re-entering the same information for each 
resource. 
Templates can include static information that is the same every time a user applies the template 
and dynamic information based on replace strings that updates when a user applies the 
template. 
For example, if members of an anthropology department are cataloging images of pottery 
shards from a site, they can use a template to automatically fill in standard data associated with 
all of the images including the resource type, format, associated keywords, etc. 

1. From the Admin Tools menu, click Metadata Administration. 
2. On the Templates page, click New Template. 
3. Enter your New Template details. 
4. Click Save. 
5. On the Edit Template page, using the provided tabs, further customize your Properties 

and Values options. 
6. Click Save. 

Import a metadata template 

1. From the Admin Tools menu, click Metadata Administration. 
2. On the Templates page, from the More Actions button, click Import Template. 
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3. On the Import Template page, enter a Template Name. 
4. To select the template that you want to import, click Browse. Locate your file and click 

Open. 
5. Click Import. 

Export a metadata template 

1. From the Admin Tools menu, click Metadata Administration. 
2. On the Templates page, from the More Actions button, click Export Template. 
3. From the Export Template drop-down list, select the template you want to export. 
4. Click Export. 

Using metadata taxon schemas 

What is a taxon schema? 
A taxon is a collection of things grouped together according to their basic similarities. For 
example, an educational taxonomy may be defined as University > Faculty > Department > 
Specialties and so on. Schemas define the structure, content, and semantics of documents, and 
in this case, XML documents. In the context of Brightspace Learning Environment, taxon 
schemas are classification systems that can be used to categorize resources like learning 
objects. This enables users to browse for resources in Brightspace Learning Repository 
organized by categories in defined schemas. 
Only views in the IEEE LOM family support taxon schemas. The actual taxon schemas available 
to a user when entering metadata depend on the view selected. When editing a view, you can 
specify which of the taxon schemas are available in that view. 
By changing a view’s available schemas, you specify the classification systems available to a 
user when using the view to enter metadata for a resource. 

Taxon schema types 
Brightspace Learning Environment comes with 2 basic taxon schema types: 

• Bloom's Taxonomy 
• GEM - Subject Keyword 

Define your taxon schema in an XML file 
To add a schema, you must have an XML file that defines the schema. You can use the XML 
Sample File and the comments in it as a guide to creating your own. 

1. From the Admin Tools menu, click Metadata Administration. 
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2. On the Taxon Schemas page, in the Import a Taxon Path Schema area, click the XML 
Sample File link. 

3. Edit the sample file with an XML or text editor. 

Import your taxon schema from an XML file 
Once you've defined your taxon schema in an XML file, you can import it back into Brightspace 
Learning Environment. 

1. From the Admin Tools menu on the minibar, click Metadata Administration. 
2. On the Taxon Schemas page, in the Import a Taxon Path Schema area, enter your 

schema details. 
3. To select the schema you want to import, click Browse. Locate your file and click Open. 
4. Click Import. 

Configure a course for self-enrollment with Discover 
To provide learners with greater flexibility and control over their personal learning goals, the 
Discover tool allows them to search for active courses and self-enroll. In addition, learners can 
self-unenroll from the courses they self-enrolled in.  

 
Figure: Courses organized by New and Updated sections on the Discover homepage 
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Note the following:  

• By default, all courses configured to display in Discover are visible to any role within your 
organization. However, you can configure role-based access or custom user attribute-
based access to individual courses in Discover. For more information, see Configure the 
visibility of courses in Discover. 

• To easily browse courses by category, the Discover homepage organizes unenrolled 
courses into sections: New, Updated, and Featured. The New section includes courses 
added to Discover within the last 6 months. The Updated section includes courses 
updated within the last 6 months. This includes courses with updated course titles or 
descriptions only; courses with updated course content do not display in this section. The 
Featured section (if enabled) includes courses promoted in your organization by your 
administrator, typically popular courses or courses your organization wants to promote, up 
to a maximum of 4 courses.  

• Learners can enroll in a course prior to its Start Date (if configured), but they cannot enroll 
in a course past its End Date (if configured). 

• After configuring a course for self-enrollment, it may take a minute before the course 
appears in Discover search results. 

• To make it easier to index multiple courses for Discover, developers can use the 
Brightspace Developer Platform API to enable the Is Discoverable option on new or 
existing courses. Once the option is enabled, those courses are visible in Discover, 
available to learners for self-enrollment. For information, refer to the Brightspace 
Developer Platform documentation. 

•  To offer more flexibility in displaying course information that is important and relevant to 
learners, administrators can configure the display of semester and course code 
information in Discover.  

•  Depending on how Discover is configured in your organization, courses may be 
organized by one or more of the following sections on the Discover homepage: New, 
Updated, All, or Featured.  

To configure a course for self-enrollment 

1. Navigate to the course. 
2. Select Course Admin > Course Offering Information.  
3. Under Discover, check the Make this course available in Discover so Learners can 

self-enroll option.  
4. Under Description, include a course description to appear in Discover.  
5. Ensure that the Course is active option is checked. Inactive courses are not included in 

Discover. 
6. Click Save. 

Configure the visibility of courses in Discover 
To ensure that only relevant courses are visible to users with specific roles or user attributes in 
your organization, you can configure role-based access or custom user attribute-based access 
to individual courses in Discover. For example, with role-based access, a university may want to 

https://docs.valence.desire2learn.com/
https://docs.valence.desire2learn.com/
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ensure that professional development courses are only visible to instructors. With custom user 
attribute-based access, a corporate organization may want to ensure that leadership courses 
are only visible to managers in specific departments. By default, all courses configured to 
display in Discover are visible to any role within your organization. 

 
Figure: The Enrollment Rules for a course in the Course Offering Information page 
Note the following: 

• To create and edit enrollment rules in Discover, users require the Change Visibility in 
Discover permission. If users do not have this permission and have access to the Course 
Offering Information page, the Make this course available in Discover so Learners 
can self-enroll option and Enrollment Rules display as read-only. 

• Users with the Manage Discover permission can still edit the Featured section in 
Discover. In addition, they can still search for courses in the Browse Discover Library 
page and add any of those courses to the Featured section, regardless of whether they 
are entitled to the courses or not. When viewing the Featured section, enrollment rules 
continue to apply so that any user editing the selected courses in the Featured section 
might not see all selected courses there. 

• To define custom user attribute-based access to individual courses in Discover, ensure 
that Manager Dashboard and Learning Groups are enabled in your Brightspace instance. 
In addition, ensure that custom user attributes are created with the User Attributes tool. If 
custom user attributes are not available, Role in Organization is the only enrollment rule 
you can create for a course. 

• For role-based access to a course, you can add one enrollment rule, with one role 
condition that contains one or more role values. You can add a maximum of 10 role 
values. 

• For custom user attribute-based access to a course, an enrollment rule contains one or 
more conditions, with each condition containing one custom user attribute with one or 
more values. You can create a maximum of 10 enrollment rules per course, with each 
enrollment rule containing a maximum of 10 conditions and 10 custom user attributes per 
condition. 
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• Multiple enrollment rules are treated as "or" statements and custom user attributes are 
treated as "or" statements in conditions. Adding another condition treats each condition as 
an "and" statement. 

• If you make a course unavailable in Discover, any enrollment rules are permanently 
removed from the course. 

  
To configure role-based access to individual courses in Discover 

1. Navigate to the course you want to add a role-based rule to. 
2. From the Course Offering Information page, enable the Make this course available in 

Discover so Learners can self-enroll option. 
3. Click the Add Enrollment Rule option that appears, and then choose one or more role 

values for the Role in Organization attribute. The number of users matching the rule 
display. 

4. Click Done. 
5. From the Course Offering Information page, click Save. 

To configure custom user attribute-based access to individual courses in Discover 

1. Navigate to the course you want to add a user attribute-based rule to. 
2. From the Course Offering Information page, enable the Make this course available in 

Discover so Learners can self-enroll option. 
3. Click the Add Enrollment Rule option that appears, and then select a custom user 

attribute and corresponding value. If applicable, select multiple values. The number of 
users matching the rule display. 

4. Click Done or Add Another Condition. 
5. From the Course Offering Information page, click Save. 

Track user self-enrollment in courses 
To allow instructors to track which users are self-enrolling in courses using Discover, 
administrators can now optionally configure enrollment logs to record Discover (or a custom 
name) as the Enrolled By type. If administrators choose not to configure enrollment logs, 
D2LSupport is recorded by default. 
From the Users tool, instructors can then view which users are self-enrolling in course using 
Discover. 
To view which users are self-enrolling in courses using Discover 

1. From the Admin Tools menu, select Users. 
2. On the Users page, click the context menu of a user and select View User Enrollment 

Log. 

In the Enrolled By column, Discover displays as the enrollment type. 
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Self register into a course 
The Self Registration tool allows users to enroll themselves in courses that have the self 
registration feature enabled. You can define whether self registrations require your approval for 
users to be enrolled in your course. 
If your organization has the Self Registration tool set up, Brightspace Learning Environment 
users can access a list of all offered courses that allow self registration by clicking the Self 
Registration link on the My Home page navbar. Users can then register by clicking on the name 
of the applicable course and filling out the associated registration form.  
You can allow only users that have Brightspace Learning Environment accounts (existing users) 
to self-enroll in your course or allow both existing and new users (external users) to self-enroll in 
your course. If you allow external registration, a Self Registration link appears on your 
organization’s Brightspace Learning Environment login page to allow new users to complete 
course enrollment.  

Create new Brightspace Learning Environment users using the Self 
Registration tool 

1. On the course home page, click Course Admin. 
2. Click Self Registration. 
3. On the Registration List page, click Add Participant. 
4. Select the Create and add a new participant option. 
5. In the Enrollment Options area, do any of the following: 

• To require the user to change their password upon logging into the course for the 
first time, select Force password change on login. 

• To send an email to the user confirming their enrollment, select Send an 
enrollment email. 

6. In the Create User area, enter your user details. 
7. Click Enroll. 
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Enroll existing Brightspace Learning Environment users using the Self 
Registration tool 

1. On the course home page, click Course Admin. 
2. Click Self Registration. 
3. On the Registration List page, click Add Participant. 
4. Select the Add an existing participant option. 
5. In the Lookup Participant area, enter all or part of a user's name, username, or email 

address. Click Search. 
6. Select the users you want to enroll. In the Role column, from the drop-down list, assign 

the selected users a role.  
7. Click Enroll. 

Enable self registration in a course offering 
An administrator must enable the necessary configuration variables and security permissions 
and the Self Registration tool must be turned on in order for you to enable self registration in a 
course offering. 

1. On the course home page, click Course Admin. 
2. Click Course Offering Information. 
3. On the Course Offering Information page, in the Registration area, select Users can 

self-register. 
4. Click Save. 

Unenroll users from a course offering using the Self Registration tool 
Unenrolling a user from a course offering in the Self Registration tool will only remove the user 
from your course, not from Brightspace Learning Environment. 

1. On the course home page, click Course Admin. 
2. Click Self Registration. 
3. On the Registration List page, select every user you want to unenroll.  
4. Click the Reject Selected icon. 

Import users using the Self Registration tool 
The Import Participants page contains file formatting information for your import package, as 
well as a sample file you can download and repurpose. 
When importing an extremely large number of users (files containing 1000 or more users) you 
might receive a timeout error. If this occurs, contact your site administrator; they can use the 
Bulk User Management tool to import the users. 

1. On the course home page, click Course Admin. 
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2. Click Self Registration. 
3. On the Registration List page, click Import Participant. 
4. In the Import Participants area, do any of the following: 

• To require the user to change their password upon logging into the course for the 
first time, select Force password change on login. 

• To send an email to all users who are not already Brightspace Learning 
Environment users to confirm their enrollment, select Send email to new users. 

• To send an email to all users who are already Brightspace Learning Environment 
users to confirm their enrollment, select Send email to existing users. 

5. In the File area, click Browse. Locate your .csv or .txt file and click Open. 
6. Click Import. 

Run Self Registration reports  

1. On the course home page, click Course Admin. 
2. Click Self Registration. 
3. On the Registration List page, click Report. 
4. In the Search Options area, do the following: 

• Select the From and To dates you want to report on. 
• Select Show Self-Registrations only. 

5. Click Generate Report. 

Create registration forms 
A registration form contains fields that users must fill in when registering for a course.  

1. On the course home page, click Course Admin. 
2. Click Self Registration. 
3. On the Registration List page, click Form > New Form. 
4. Enter a Form Name. 
5. Click Save Form. 
6. Do any of the following: 

• To add a system field to the form, click Add System Field. 
• To add a custom field to the form, click Add Custom Field. 
• To change the order in which fields appear, click Reorder Fields. 
• To determine if the field requires a response, select or clear the Required check 

box for the field. 
7. Click Save Form. 

Associate a registration form with a course 
A course must have an associated registration form before you can list it on the Self Registration 
page. You can view information gathered from completed registration forms on the Registration 
Report page.  
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If a course does not have an associated registration form, a warning appears on the Course 
Offering Information page.  

1. On the course home page, click Course Admin. 
2. Click Self Registration. 
3. On the Registration List page, click Form. 
4. On the Registration Form page, in the Course Offering Forms area, select the form you 

want to associate. 
5. Click Save. 

Set restrictions on self registration 
The Registration Restrictions page allows you to set date restrictions for enrollment and specify 
the maximum number of registrations you will accept, as well as any prerequisite or anti-
requisite courses. 

1. On the course home page, click Course Admin. 
2. Click Self Registration. 
3. On the Registration List page, click Restrictions. 
4. Do any of the following: 

• To restrict registration to certain dates, select Registration Start Date and 
Registration End Date and enter a date range using the drop-down lists. The 
course only appears for users on the Self Registration page during the window of 
time you specify, although courses are always visible for users with cascading 
permissions.  

• To restrict registration to a number of participants, enter the number of allowed 
registrations in the Self Registration Limit field. This field is compared against the 
number of users that have self-registered and have an enrollment status of either 
approved or unassessed. 

• To add prerequisite courses, click Add Prerequisites. Locate the group of org units 
or specific org units you want to add. Click Add.  

• To add anti-requisite courses, click Add Excluded Enrollments. Locate the group 
of org units or specific org units you want to add. Click Add.  

5. Click Save. 

Approve self registrations 
To approve self registration enrollments, you must have the Approve Enrollments permission. 

1. On the course home page, click Course Admin. 
2. Click Self Registration. 
3. On the Registration List page, from the Show drop-down list, click All unassessed 

users > Search. 
4. Select every user you want to approve and click the Approve Selected icon. 
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Delete or reject self registrations 
When you delete a self registration request, the user is permanently removed from the list and is 
not enrolled in the course. When you reject a self registration request, the user remains on the 
list but is not enrolled in the course. 

1. On the course home page, click Course Admin. 
2. Click Self Registration. 
3. On the Registration List page, do one of the following: 

• To delete a registration request, select the check box for any user you want to 
delete and click the Delete Selected icon. 

• To reject a registration request, select the check box for any user you want to reject 
and click the Reject Selected icon. 

Troubleshooting self registrations 

Problem Solution 

My registration form is not displaying 
on the Self Registration page 

Create and associate a registration form with your course 

I want to use the same registration 
form in multiple courses without 
recreating it every time 

Create a standard registration form at the organization 
level 

I can't approve self registrations Make sure you have the appropriate security permissions 

I can't reject or delete self 
registrations 

Ensure your role has the Manage Courses > Unenroll 
Users from the Registration Area permission for the 
course offering level 

I can't enable self registration in a 
course offering 

Ensure the Self Registration tool, necessary configuration 
variables, and security permissions are enabled 

I can't find my course on the Self 
Registration page 

Make sure that your course has not reached its enrollment 
limit or registration end date 

Find activity that matches certain criteria 
The Intelligent Agents tool monitors an org unit to find activity that matches criteria that you set. 
The criteria that the agents search for are login activity, course activity, and release conditions in 
Brightspace Learning Environment.  
Example uses for agents include:  
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• Emailing users with grades below a certain level 
• Checking for users that have not logged in within a specific number of days 
• Checking for users that view a specific content topic 

Considerations for setting up agents 
When you create a new agent, you need to determine:  

• The criteria the agent looks for. The agent can check user login activity, course activity, 
and/or triggered release conditions. Be aware that intelligent agents evaluate the status of 
release conditions at the time that they run. A user that may have satisfied a release 
condition on a prior run, may no longer satisfy a release condition on a subsequent run, 
especially in the case of our 'NOT' conditions. 

• How often the agent is scheduled to run and find users that meet its criteria. If you don't 
set a schedule then the agent must be manually triggered on the Agent List page. 

• How often the agent takes action when a user satisfies the criteria. I.e. Will the agent send 
one email the first time the user triggers the agent, or send reminder emails to the user 
every time the agent runs? 

•  The action you want the agent to take when it finds a user that fits the criteria it is looking 
for. An agent could: change enrollment in the current course, or enroll into another course; 
send an email to the user, their auditor, or other user; or do nothing (choosing no action 
enables the agent to run and generate reports of who has satisfied the criteria during 
different runs of the agent).  
Notes:  

• You must have the appropriate enrollment permissions in the current or destination 
courses to create intelligent agents that change user enrollments.  

• File attachments and inserted images in emails cannot exceed the limit set for your 
institution for email attachments.  

Best practices for creating and using agents 
There are many things you should consider when setting up agents for your course in order to 
get the most benefit from using the tool. Agents are most useful when you have carefully 
considered how you are organizing and presenting them in a course. 
Some best practices include: 

• Use a standard naming convention to keep the order and purpose of each agent clear 
• Use the agent's Description area to collect reminder notes of what you need to adjust in 

the agent for each offering 
• Determine if your agent would benefit from repetition 
• Use replace strings to personalize emails and minimize editing 
• Avoid overusing agents, especially if you can get the information to learners another way 
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Replace strings for agents 

Replace String Description For Use In 

{InitiatingUser} The user who performs the action that 
meets the agent’s criteria 

Email address 
field  

{InitiatingUserAuditors} The auditors for the user who 
performs the action that meets the 
agent’s criteria 

Email address 
field 

{OrgName} The name of the organization Email body 

{OrgUnitCode} The code for the Org Unit Email body 

{OrgUnitName} The name of the Org Unit Email body 

{OrgUnitStartDate} The start date specified for the Org 
Unit 

Email body 

{OrgUnitEndDate} The end date specified for the Org 
Unit 

Email body 

{OrgUnitId} The org unit ID required to make 
quicklinks works 

Email subject 
line and email 
body 

{InitiatingUserFirstName} The first name of the initiating user Email body 

{InitiatingUserLastName} The last name of the initiating user Email body 

{InitiatingUserUserName} The username of the initiating user Email body 

{InitiatingUserOrgDefinedId} The Org Defined ID of the initiating 
user 

Email body 

{LastCourseAccessDate} The date the initiating user last 
accessed the course 

Email subject 
line and email 
body 

{LastLoginDate} The date the initiating user last logged 
in 

Email subject 
line and email 
body 

{LoginPath} The address of the login path for the 
site 

Email body 
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Using agents 

Create an agent 
To create an agent 

1. On a course navbar, click Course Admin.  
2. Click Intelligent Agents. 
3. On the Agent List page, click New. 
4. On the New Agent page, enter a name. 
5. If you want to assign a category to the agent, select an option from the Category drop-

down menu. 
• You can create a new category by clicking the Add Category link to the right of the 

Category drop-down menu. Enter a name into the Name field, and then click Save. 
6. Expand the Edit Description label and enter a description. 
7. If you want the agent to be active, select the Agent is enabled check box. 
8. Under Criteria > Role in Classlist, do one of the following: 

• If you want the intelligent agent to be applicable to all roles in the Classlist, select 
the All users visible in the Classlist check box. 

• If you want the intelligent agent to be applicable to select roles, select the Users 
with specific roles check box and select the respective roles. 

9. If you want your agent to target users' login habits, under Criteria > Login Activity, enter 
your criteria. Note: Login activity refers to logins at the platform level. 

10. If you want your agent to target users' course habits, under Criteria > Course Activity, 
enter your criteria. 

11. If you want your agent to run when a specific existing condition has been met, under 
Criteria > Release Conditions, click Attach Existing. Select the check box for any 
condition you want to attach and click Attach. 

12. If you want your agent to run when a specific new condition has been met, under Criteria 
> Release Conditions, click Create and Attach. Select a Condition Type from the drop-
down list. Complete any additional Condition Details that appear and click Create. 

13. Under Actions > Repetition, select how often you want the agent to take action. 
14. If your role has the Use Agent Enrollment Actions and Perform Unenroll permissions, 

you can set your agent to perform an enrollment or unenrollment action:  
• Under Change User Enrollments, select the Change user enrollments when the 

criteria are satisfied check box.  
• From the Enrollment Action drop-down list, select the action you want your agent 

to perform and select the course. 
• If you want to Enroll user in a course, select an available course from the 

dialogue. Only courses you have permission to enroll in will be shown. 
• From the New Role drop-down list, select what role the user will be enrolled with 

when the agent criteria is satisfied. 
15. If you want the agent to send an email when the set criteria are satisfied, under Actions 

> Send an Email, select the Send an email when the criteria are satisfied check box 
and enter your email details and relevant attachments. 
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16. If you want to schedule how frequently Brightspace Learning Environment evaluates the 
agent criteria, under Scheduling, select the Use Schedule check box. Click Update 
Schedule and set your scheduling details. 
Note: Scheduled intelligent agents stop running and are automatically disabled if the 
course is inactive, past its end date, or deleted. You can still set up a practice run or a 
manual run of an intelligent agent at any time in a course with a passed end date. 

17. Click Save and Close. 

Edit an agent 

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 

• You can filter what agents are viewed by selecting an option from the View drop-
down menu. The options are All Agents; By Category (which sorts the Agents by 
their assigned category); Enabled (only those Agents that have been enabled); and 
Disabled (only those Agents who are not currently enabled). 

3. From the context menu of the agent you want to edit, click Edit Agent.  
4. To edit multiple agents at once, click Bulk Edit. 

• Note: You can only change certain attributes (title, category, active/inactive state) 
using Bulk Edit. 

5. Make your changes. 
6. Click Save and Close. 

Copy an agent 
You can copy an agent to reuse or make minor editing changes to. All copied agents will be 
disabled by default.  

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 
3. From the context menu of the agent you want to copy, click Copy. A new agent is created 

and Copy of is added to the beginning of its name. 

Delete an agent 
To delete an agent 
You can delete an agent individually or in bulk. Deleted agents do not run if they have a 
recurring schedule. 

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 
3. In the Agent List, select the check boxes of the agents you want to delete and click 

Delete. 
4. To confirm the deletion, click Delete. 



 

71 
© 2022 D2L Corporation. All rights reserved. 

Restore an agent 
You can restore deleted agents. All restored agents maintain existing properties and history. 

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 
3. In the Restore Agents page, click Restore to restore any of the deleted agents. 

Add a link to the Intelligent Agents tool to the navbar 
You can add a link to the Intelligent Agents tool to your course’s navbar.  

1. From the Admin Tools menu, select Navigation and Themes. 
2. Click the link for the navbar, in which you want to add a link to the Intelligent Agents tool. 
3. On the Edit Navbar page, in the Links area, click Add Links. 
4. In the Add Links dialog box, select the Intelligent Agents check box. 
5. Click Add, and then Save and Close. 

Update Intelligent Agents settings 
You can adjust the settings in the Intelligent Agent tool to set custom values for the name that 
emails come from and the reply-to address that responses are delivered to. 

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 
3. Click Settings. 
4. On the Intelligent Agents Settings page, select one of the following: 

• Select Use the system defaults. 
• Select set custom values for this course and fill in the available fields. 

5. Click Save. 

Run an agent manually 
To run an agent manually 
Typically, agents are set up to run automatically. If you do not have a regular schedule set up for 
an agent, you must run it manually.  
When you run an agent manually, it sends a confirmation email to the user that requested or set 
up the agent. This email contains the following information: org unit code and name, which 
agent ran, time and date the request was submitted, time and date the request was finished, 
and whether the agent took action. 
You can set up a manual run of an intelligent agent at any time in a course with a passed end 
date. Agents do not need to be enabled in order to set up a manual run. 

1. On the navbar, click Course Admin. 
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2. Click Intelligent Agents. 
3. From the context menu of the agent you want to run manually, click Run Now. 
4. To confirm the manual run, click Run. 

Perform a practice run on an agent 
To perform a practice run on an agent 
You can have an agent perform a practice run to see who will be identified by the agent without 
sending those users an email. Agents do not need to be enabled in order to perform a practice 
run. 

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 
3. From the context menu of the agent you want to perform a practice run for, click Practice 

Run. 
4. To view the users identified, on the Agent List, in the Results of Last Run column, click 

the link. 

Change the status of an agent 
You can enable and disable agents individually or in bulk easily on the Agent List page. 
Disabled agents display an  Agent is not enabled icon by their name. 

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 
3. On the Agent List page, do one of the following: 

• To enable an agent, select the check box for any agent you want to enable and click 
the Enable link. 

• To disable an agent, select the check box for any agent you want to disable and 
click the Disable link. 

View the history of an agent 
You can view the history of an agent to see when the agent was run, who was identified, the 
type of run (Manual, Scheduled, or Practice), who ran the agent, and if any errors were 
encountered. 

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 
3. From the context menu of the agent you want to view the history of, click View History. 
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Export the history of an agent 
You can export the history of an agent to a CSV file to see when the agent was run, who was 
identified, the type of run (Manual, Scheduled, or Practice), who ran the agent, and if any errors 
were encountered. 

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 
3. Click More Actions, and select Export Agent History. 
4. Select an individual agent, or all agents. 
5. Select the Include Practice Runs checkbox if you want this information included. 
6. Set the date range to include in the CSV, and click Export. 
7. Click on the CSV file to download the history for review offline 

Note: On the Agent List page, select the context menu for an individual agent, and click Export 
History to generate a CSV file for specific agents. 

View scheduled agents' run time 
To view scheduled agents' run time 
You can view the time of day the scheduled agents will run. 

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 
3. Click Settings. 
4. On the Intelligent Agents Settings page, view the Scheduled Agents Run Time. 

View an agent's next run date 
You can view the next run date for scheduled agents. There is no next run date if a schedule is 
not enabled. 

1. On the navbar, click Course Admin. 
2. Click Intelligent Agents. 
3. On the Agent List page, view the Next Run Date. 

About SCORM in the Brightspace Learning Environment 
SCORM stands for Sharable Content Object Reference Model. It is a collection of standards that 
outlines how online learning materials and learning management systems should interact with 
one another. Instructors can import SCORM objects and include them in courses and lessons. 
Because SCORM is integrated into many features of Brightspace Learning Environment, there 
is a separate guide that pulls together all the information about SCORM from the many locations 
it has existed previous to Brightspace Platform 10.8.2. You can find the Using SCORM in 

https://community.brightspace.com/s/article/Using-SCORM-in-Brightspace-Learning-Environment-Administrator-Guide
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Brightspace Learning Environment - Administrator Guide in the Brightspace Community, and the 
topics continue to be available in the Brightspace Help. 

Accessibility for course design 
Course designers and instructors hold a pivotal role in ensuring that Brightspace Learning 
Environment is accessible to all users, regardless of their learning needs. It is your content that 
students must access, assess, and interact with. It is strongly recommended to follow 
accessibility best practices to ensure that you meet the learning needs of all your students. 

Adding an accessible template package to your course files 
D2L has designed a template package that course instructors can use to create accessible, 
HTML content files. The templates use cascading style sheets (CSS) to format the content in the 
HTML files. 
To the extent possible under law, D2L has waived all copyright and related or neighboring rights 
to the available accessibility templates. You can use these files in a single course, or for the 
whole organization through Shared Files, depending on your permissions.  
If you upload the template package and unzip it within Brightspace platform, it is structured 
properly and the sample files correctly reference the CSS file. If you choose only some of the 
available templates within the package to upload, you might need to recreate the folder structure 
for the files to correctly reference the CSS file. 
All the template packages use the same folder structure and name, which makes it easy to swap 
out your CSS file for different CSS files if you want to change the appearance of your course 
content. 
Download the template package from the Brightspace Community. 
To add a template package to your files. 

1. Save the template package to your PC. 
2. Do one of the following: 

• To share the templates across the organization, navigate to Shared Files. 
• To use the templates in a specific course, navigate to Manage Files. 

3. At the root level of the file tree, select Upload. 
4. Select the template package zip file and click Upload. 
5. Unzip the file. 

Meeting web content accessibility standards 
Most of the tips provided are web content standards set by the World Wide Web Consortium. 
For more information, review their Web Content Accessibility Guidelines. 

https://community.brightspace.com/s/article/Using-SCORM-in-Brightspace-Learning-Environment-Administrator-Guide
https://documentation.brightspace.com/EN/le/-/all/le_intro.htm
https://community.brightspace.com/
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• When possible, use HTML topics to create your course content. D2L provides accessible 
HTML templates to streamline the content creation process. If you need to use other file 
formats, such as video files, choose formats that are recognized by most browsers or offer 
the material in multiple formats. 

• Use a simple layout that does not use tables or columns to organize information. When 
information is organized simply, it is easier for students to read and understand. Simple 
layout is also easier for assistive technology devices to interpret and present, and for 
mobile and handheld devices to resize. 

• Use headings to communicate the relationships between sections. Use Heading 1 for the 
title, Heading 2 for major sections, Heading 3 for subsections, and so on. If headings are 
used correctly, screen reader users can quickly search a page by heading and 
participants with cognitive disabilities can understand how sections and content relate 
easier. 

• Make sure each heading, item, and file name are unique. 
• Include a table of contents that links to each section. Ensure that there are Back to top 

links at the end of each section for longer documents. 
• Include alternative text descriptions (alt text) for all graphics. Use double quotes (null) as 

the alt text if the object is a decorative element that does not add meaning to the topic. If 
the graphic is a link, begin the alt text with "Link to". Brightspace Editor in Brightspace 
Learning Environment automatically prompts you to include alt text when you insert an 
image. 

• Include detailed captions below tables and graphs. These captions should explain what 
information the objects convey, including important trends and statistics. For tables, 
include a caption using the caption element that explains how the table is organized. 
Check that tables make sense when read from left to right. Screen readers often have 
difficulty conveying information that reads from top to bottom. 

• Use the same text on-screen and in the alt text for links. Make sure that the text describes 
the action that will occur when you click the link. Do not use text such as Click Here as the 
link. Screen readers often use a list of links to quickly navigate actions on a page. This is 
not possible if links are not descriptive.  

• Include text alternatives of multimedia content, such as audio or video files. If you do not 
have the time to create a complete text alternative, include a descriptive label that 
summarizes the content. 

• Do not use blinking or flashing multimedia, as it can cause seizures in individuals with 
photo-sensitivity. Use animation when it helps convey a concept, and not to draw attention 
to an unchanging object. Use a combination of color, size, and prominence to draw 
attention to objects. 

• Do not use color to convey meaning. If you want to show how concepts relate to each 
other, use a combination of size, color, and text labels. 

• Ensure that there is a strong contrast between the text and the background colors in your 
course materials.  

• Use relative font sizes and make sure that the text and page layout adjusts when a user 
changes the font sizes. Users should not have to scroll horizontally.  

• If you use PDF files for content, scan them with optical character recognition (OCR) to the 
text can be read by screen readers. Scan pages with multiple columns one column at a 
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time so that the optical character recognition functions as expected. Add bookmarks for 
major sections to make the content easier to navigate. 

• If you create PDF files from Microsoft Word or another word processor, format titles and 
sections using heading so they are correctly tagged in the PDF. 

• If learners use text-to-speech software to read text aloud or highlight text as they go 
through it, test the software to ensure it functions correctly for specific tools and settings 
that you want to use. For example, if you turn off right-click in quizzes, it can prevent some 
text-to-speech software from tracking text.  

Improve the accessibility of course content using Blackboard Ally 
Blackboard Ally is a content accessibility service licensed directly from Blackboard. It is 
designed to help instructors improve the accessibility of their course content. Blackboard Ally 
provides accessibility checks for Course and Lesson content, provides suggestions for 
improving content, and provides alternative accessible formats to enable learners to use the 
format that best meets their requirements. 
Blackboard Ally provides an accessibility score from low to high using a color and gauge icon to 
indicate the current score of the file: 

•  Red indicates a low score resulting from many accessibility issues. Files with this 
rating should be improved as soon as possible. 

•  Yellow indicates a mid-range score. There are accessibility issues, but there are 
opportunities for improvement. 

•  Light green indicates a high score. The file is accessible, but there are still 
opportunities for improvement. 

•  Dark green indicates a perfect score. The file is fully accessible, there are no 
suggestions to improve the accessibility of the file. 

The main accessibility score panel also contains a link that opens the Instructor Feedback 
panel. The Instructor Feedback panel contains the following information: 

• Accessibility score percentage for the entire file with the corresponding color and gauge 
icon. 

• A link to a list of all issues in the file, with a Fix button that you can use to fix, save, and 
upload the file with the improved accessibility score. 

• A description of the issue and how to fix it. 
• An upload window that you can use to drag-and-drop a new version of the file, or browse 

to the updated file. 

For more information, see Blackboard Ally Help. 

https://help.blackboard.com/Ally/Ally_for_LMS
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Compliance to accessibility standards in HTML-authored content 
An accessibility checker is available within Brightspace Editor for use within Content, Widgets, 
Quizzes, Assignments, Calendar, Assignments, and any other tools where you can access the 
Editor. 
The accessibility checker is available in the top bar within Brightspace Editor. After you add 
content in Brightspace Editor, you can click the checker to ensure that the HTML page meets 
conformance to WCAG and Section 508 accessibility standards.  
The accessibility checker reviews content for the use of the following items:  

• Use of paragraphs as headings 
• Sequential headings 
• Adjacent links 
• Ordered list structure 
• Unordered list structure 
• Contrast ratio of text to background colors 
• Image ALT text 
• ALT text file name 
• Table caption 
• Complex table summary 
• Table caption and summary 
• Table heading scope, markup, and headers 

The checker indicates if the content is free of accessibility issues, or offers suggestions to fix 
them.  
Note that the accessibility checker does not check multiple files at the same time and does not 
check files that you have imported into a course. Also be aware that the accessibility checker is 
only available for HTML files in Brightspace Editor; it cannot be used to check any other file 
type, such as MS Word, PDF, PowerPoint, and so on.  

Use the Accessibility Checker on HTML-authored content 
The accessibility checker gives you a way to ensure that the content you author in Brightspace 
Editor conforms to WCAG and Section 508 accessibility standards. The accessibility checker is 
available within the Editor for use within Content, Widgets, Quizzes, Assignments, Calendar, 
Assignments, Discussions and any other tools where a user can access the Editor.  

1. Enter HTML content in Brightspace Editor. 
2. Click  to start the checker. 
3. If there are any compliance issues, read the report for suggestions on how to fix the issue. 
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Accessibility considerations when organizing your course 
All people learn differently. It can be difficult to organize your course in a way that supports the 
learning needs and styles of all users. Your learning materials need to effectively engage, 
educate, evaluate, and accommodate diverse learners. It can help to meet these benchmarks if 
you follow a few design decisions: 

• Set clear course expectations 
• Set flexible time limits and deadlines 
• Provide alternative learning materials 

Setting clear course expectations 
For many students, an online course marks a big change from a traditional classroom. This 
change can be even more challenging for students with physical or learning disabilities, as they 
can feel disconnected from their instructor and other support systems. The Brightspace Learning 
Environment provides course designers with flexibility in how they set up and organize content, 
however it can still be daunting for students who rely on assistive technologies to navigate the 
Brightspace Learning Environment, find course materials, and find and complete assignments. 
To help your students effectively use your online course, consider the following design 
guidelines: 

• Use Course Home to help familiarize your students with your course content. 
• Create a news topic on Course Home that introduces yourself (the course instructor) and 

any teaching assistants. Include contact information and encourage students to contact 
you if they have concerns, questions, or additional needs. 

• Include your course syllabus as a news topic, or provide a link in a news item to your 
syllabus on the Course Home. Make each item in the syllabus a Quicklink to the actual 
item in your course. Quicklinks provide a navigation shortcut to important content and 
helps students with learning disabilities clearly see how course content relates to course 
expectations. 

• Include a Announcements topic on the Course Home that highlights some of the personal 
tools available to students, such as Preferences and Class Progress. 

• Build redundancy into your course by repeating course information within different tools. 
For example, you can include all course syllabus information in the course calendar, and 
include information on how much a quiz, discussion topic, or assignment is worth in the 
description of the syllabus entry for the content item. When course expectations are 
clearly communicated in the course design, students can focus on learning content. 

• Set up a clear hierarchy in your course content using enumerations. In Content settings, 
set up enumerations so that the course structure is easier to navigate for users of screen 
readers and students with learning disabilities. 
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Making flexible time limits and deadlines 
In some cases, course designers may put users with learning and physical disabilities at a 
disadvantage without intending to. Usually, disadvantages result from users not having enough 
time to complete tasks or not having appropriately designed resources. Consider using the 
following best practices to organize course materials: 

• To encourage user participation and reflection, use Discussions instead of instant 
messaging tools. Instant Messaging can be difficult for users with visual, motor, or 
learning disabilities because they require users to quickly process and respond to 
information, using technology that doesn't match their needs. Discussions areas give all 
users time to reflect. If you use instant messaging, be aware that some users may need 
an alternative solution such as phone or face-to-face contact. Also consider how 
accessible the instant messaging interface is for the tool you are using. The D2L Instant 
Messages tool is specifically designed to be accessible by keyboard and screen readers.  

• Provide readings and assignments well in advance of deadlines so users can work ahead 
and prepare. Many students need the time to organize extra help and to read through the 
content more than one time. Use conditional release settings to release course content by 
module, and make sure you provide enough time to complete each component.  

• Be aware of the limitations that timed examinations place on students. Traditional 
examinations usually have a time limit in which students must prepare their responses. 
This can be difficult for students with learning or physical disabilities as they often need 
more time to articulate or record their responses. Consider whether strict time limits are 
necessary for your course material. If time limits are required, ensure that students are 
aware that they can request extra time.  

Providing alternative learning materials 
To improve student engagement, one of the most effective course design decisions you can 
make is to offer course materials and assignments that appeal to more than one sense. For 
example, the same material can have an audio, video, and text component. This type of 
redundancy helps engage students with different learning types, reinforces important concepts, 
and ensures that users with physical disabilities can access content in a suitable format. 
Consider adopting the following best practices: 

• Use Content for readings and course material. It is easier for assistive technologies to 
interpret HTML code than application-based files such as Microsoft Word. When creating 
HTML content, follow web content accessibility standards. 

• If you are scanning documents to use as course content or using PDF files, use optical 
character recognition (OCR) to ensure that documents with text can be read by screen 
readers. Also consider adding tags to your documents to ensure that screen readers can 
navigate more easily. For more information about PDF accessibility, see 
webaim.org/techniques/acrobat. 

• If your readings and lecture materials contain many graphics, tables, videos, or audio 
recordings, provide a text-only alternative. Text-only material should supplement, not 
replace, other delivery methods. Videos, graphics, and audio files are a great way to 
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generate interest in a topic, present material from different perspectives, and help 
students with learning disabilities through redundancy. Make the text-only alternatives 
easy to compile for print so that all the students can use them as study aids. 

• Allow students to demonstrate learning through different assignments associated with the 
same grade item or competency activity. For example, students might have the option of a 
written reflection, a recorded interview, or a slide show presentation. 

• Set up your discussion areas to encourage peer-to-peer support. Regularly review 
information in the forums and adjust your content according to the needs of the group. 

• Use the Equation Editor in combination with written descriptions of mathematical formulas. 
Although the Equation Editor supports accessible equations through MathML, these 
standards are not supported by all browsers or assistive technologies. Written 
descriptions help all students interpret what they need to complete the equation. 

• Use a vertical layout for quizzes so that only one answer or concept appears on each line. 
Screen readers more easily interpret the order of the material, so most students can more 
quickly interpret their options. A vertical layout also reduces formatting issues when a 
student adjusts text sizes. 

• Do not convert Microsoft PowerPoint presentations to images if you have any visually 
impaired students. Screen readers are not able to read the content of the images, and 
learners are not able to resize the text or graphics. PowerPoint slides are converted by 
default; on the Create File Resource pop-up page you need to turn off the Convert Word 
documents to HTML and PowerPoint slides to images option. As an alternative, you 
can make it easy for learners to request copies of the original content, and the learners 
can adjust and print them. 

Directing learners to accessibility resources 
It is a good practice to provide learners with information about how to find accessible information 
and additional support:  

• In Brightspace Learning Environment account settings, there are a number of settings that 
can be adjusted to improve accessibility. These user preferences are controlled by 
individual users, and can be set to the greatest benefit of individual learners. 

• The Brightspace Learning Environment tool provides learners with help about accessibility 
features, including tips on how to configure Brightspace Learning Environment for use 
with a screen reader, screen magnifier, or keyboard-only assistive technology device. You 
can find information about using zoom, color contrast, and navigating using keyboard-
only. 

• Your organization likely has a Disability Services office, library support staff, and tutoring 
staff available for students seeking additional help. As an instructor, familiarize yourself 
with the programs in your organization and share the information with students who seek 
additional support. 
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Scenarios for creating release conditions to increase accessibility in 
courses 
You can use Special Access and Release Conditions to set criteria around the availability of 
content, which can be useful for accommodating students with other needs. 
The following scenarios provide examples of when release conditions or special access can 
improve accessibility: 

• Create groups for students with special needs and use release conditions to provide 
course material, tasks, and work areas that are not available to other students. This is a 
good option if you do not want other students to see or have access to the additional 
course items. 

• If you are teaching a large course, you might not be aware of the individual needs of all 
the students enrolled in the course. Set up a checklist that learners can use to request 
extra resources, help, or course material in a different format. For example, for each week 
or major assignment, create checklist items for text-only versions of the course material, 
an extra help discussion forum, additional reading material, and alternative formats for 
multimedia material. Set release conditions for the checklist items so the requested 
content is automatically released. This option ensures that the majority of learners access 
the material as you intended, but learners needs are supported. 

• Set up a survey to help you determine the learning needs of learners. Use the survey 
results to determine what special access rights and extra resources to provide for the 
learners. 

• Set up quizzes, surveys, or assignment folders with time restrictions, but give special 
access to learners who need more time because of physical or cognitive disabilities. 
Alternatively, instructors creating quizzes might prefer to not set any time restrictions 
because they can impact the quality of answers. 

Creating Course Content 
Instructors can create course content with the following tools: 

• Create course content with the Content tool 
• Format HTML course content with the use of Brightspace Editor 
• Add URL links to a course with the Links tool 
• Create a custom learning path in a course with the Release Conditions tool 
• Notify learners about updated course content 
• Add availability and due dates in Content 
• Evaluate assignment submissions from Content 

Create course content with the Content tool 
Use the Content tool to post and organize course content so that information about course 
expectations, course syllabus, lecture notes, and important dates display to users clearly. 
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Course materials you post in Content can include documents, images, media files, CaptureCast 
presentations, URL links, and existing course activities. You can add release conditions, grade 
items, and learning objectives to topics to ensure users navigate through course materials while 
fulfilling specific course requirements and learning expectations. 
You can also monitor class and user progress as students work through course content by 
setting automatic (determined by the system) or manual (determined by the student) completion 
tracking. 

Content tool overview for instructors 
An overview of the Content tool for instructors  

 
1) When users access a course's Content tool for the first time, the first page they land on is the 
Overview. Use the Overview page to orient users to the course, content materials, and course 
expectations. If you decide not to add anything to this page, the Overview link and page is 
hidden from learners' view. Users can print and download an uploaded course syllabus directly 
from the Content Overview page. Note that the Print and Download buttons display differently, 
depending on whether or not the d2l.System.Services.DocumentConversion.IsEnabled 
configuration variable is enabled. If the 
d2l.System.Services.DocumentConversion.IsEnabled configuration variable is enabled, all 
document types except PDF will display the Download and Print options (PDF will only display 
the Download button). If the configuration variable is not enabled, only GIF, JPEB, JPG, JPE, 
PNG, BMP, TXT, HTML, CSS, and HTM file types will display both the Download and Print 
options. 



 

83 
© 2022 D2L Corporation. All rights reserved. 

2) Topics you bookmark appear in a list on the Bookmarks page. The number beside the 
Bookmarks link indicates how many bookmarks you have.  
3) The Course Schedule page lists course material due dates, start dates, end dates, overdue 
course activities, and other course events for the next seven days. If you set availability dates or 
a due date for a course object, it appears in the Course Schedule page and the Agenda view in 
the Calendar tool. If you set a due date for a course activity that has no end date or it has an 
end date that occurs after the due date, the activity appears on the Overdue tab for learners who 
miss the due date. The Overdue tab lists overdue course activities that learners can still 
complete before the item or course becomes unavailable.  
The dates listed on this page are not exclusive to content topics; upcoming events include all 
events within the course from the Calendar tool. The number beside the Upcoming Events link 
indicates how many upcoming events you have. 
4) The Table of Contents panel lists all modules available in your course. The number beside 
each module name in the Table of Contents panel indicates the number of topics you have set 
completion tracking for. The number beside the Table of Contents link indicates the total number 
of topics you have set completion tracking for. Use the number totals to determine the task load 
being put on learners per module.  
5) The course content administration options located on the Table of Contents page allow 
instructors to import and copy course content, bulk Course Admin content properties, manage 
course files, view reports on course content, and restore deleted course items. 

About course content organization 
Your course content is organized using content topics and modules. Use modules to organize 
the units of your course offering (for example, week 1, week 2, week 3, and so on) and topics to 
organize the content of each module (for example, lesson 1, lesson 2, lesson 3, and so on.) 
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Figure: An Astronomy 101 course in Brightspace Learning Environment 

Overview 
When users access a course's Content tool for the first time, the first page they land on is the 
Overview (also known as a course syllabus). Use the Overview page to orient users to the 
course, content materials, and course expectations. You can insert course overview information 
using the Brightspace Editor beneath the Overview title, and you can add a file attachment by 
dragging a file from your computer onto the upload target, or by clicking Add an attachment 
from the Overview page. 
Note: If you decide not to add anything to the Overview, the Overview link and page is hidden 
from student view. 
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Bookmarks 
Topics you bookmark appear in a list on the Bookmarks page. Click the Add Bookmark icon 
while viewing a topic to add it to your bookmarks list. The number beside the Bookmarks link 
indicates how many bookmarks you have. 

Course Schedule 
The Course Schedule page lists course material due dates, start dates, end dates, and other 
course events for the next seven days. If you set availability dates or a due date for a course 
object, it appears in the Course Schedule page and the Agenda view in the Calendar tool. 
The dates listed on this page are not exclusive to Content topics; upcoming events include all 
events within the course from the Calendar tool. Click Course Schedule to view all past, 
current, and future course events. The number beside the Upcoming link indicates how many 
upcoming events you have. 

Table of Contents 
The Table of Contents panel lists all modules available in your course. Click on a listed module 
to view and manage its details, topics, and sub-modules. You can also stay on the Table of 
Contents page to view and manage all modules and topics. Click the Table of Contents link to 
access the Table of Contents page. This page enables you to view and manage all modules 
and topics. You can add new topics to existing modules by dragging and dropping files from 
your computer onto upload targets on the Table of Contents page, and you can also rearrange 
course materials by dragging and dropping topics between modules.  
The number beside each module name in the Table of Contents panel listing indicates the 
number of topics you have set completion tracking for. The number beside the Table of 
Contents link indicates the total number of topics you have set completion tracking for. Use the 
number totals to determine the task load being put on students per module. 

About accessible courses and accessible course content 
Organizing your course in a way that supports the learning needs and styles of all users can be 
a difficult task. Your learning materials need to engage, educate, evaluate, and accommodate 
people effectively.  

Set clear course expectations 
There are some design decisions you can make that will help all learners use your online course 
effectively: 

• Use the Content Overview page to help familiarize your learners with your course content. 
• Add your course syllabus to the Content Overview page. This helps all users clearly 

understand your course expectations up front. Link each syllabus item to the actual item in 
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your course. This provides a navigation shortcut to important content and helps students 
with learning disabilities clearly see how course content relates to course expectations. 

• Set up enumerations in the Content tool's Settings to establish a clear hierarchy in your 
course content. Well-defined course structure is easier to navigate for screen reader users 
and learners with learning disabilities. 

Make time limits and deadlines flexible 
Provide readings well in advance of deadlines so users can work ahead and prepare. Many 
learners need the extra time to read through content multiple times. If you use release 
conditions to control when to release course content on a module by module basis, make sure 
you give learners plenty of time to complete each component. 

Provide alternative learning materials 
One of the most effective course design decisions you can make to improve engagement is to 
offer course materials that appeal to more than one sense. For example, the same material can 
have an audio, video, and text component. This type of redundancy helps engage learners with 
different learning types, reinforces important concepts, and helps ensure that users with physical 
disabilities can access content in a suitable format. 

• Use the Content tool for readings and course material. HTML code is easier for assistive 
technologies to interpret than application-based files such as Microsoft Word. Follow web 
standards when creating your content. 

• If you need to use PDF files for additional content, use optical character recognition 
(OCR) if you are scanning documents so the text can be read by screen readers. Also 
consider adding tags to your documents to enable screen reader users to navigate them 
more easily. For more information about PDF accessibility, go to 
http://webaim.org/techniques/acrobat. 

• If your readings and lecture materials use many graphics, tables, videos, or audio 
recordings, provide a text-only alternative. Text-only material should supplement, not 
replace, other delivery methods. Videos, graphics, and audio files are a great way to 
generate interest in a topic, present material from different perspectives, and help 
students with learning disabilities through redundancy. Make the text-only alternatives 
easy to compile for print so that all learners can use them as study aids at their leisure. 

Tips when creating HTML content 
Most of the following tips provided are web content standards set by the World Wide Web 
Consortium in the Web Content Accessibility Guidelines and should be considered when 
creating HTML content: 

• Use a simple layout that does not organize content in tables or columns. Simply organized 
material is easier for learners to read and understand, is easier for assistive technology to 
interpret and present, and is easier for mobile and handheld devices to resize. 

http://webaim.org/techniques/acrobat
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• Use headings to communicate the relationships between sections. Use Heading 1 for the 
title, Heading 2 for major sections, Heading 3 for subsections, and so on. If headings are 
used correctly, screen reader users can quickly search a page by heading and 
participants with cognitive disabilities can understand how sections and content relate 
easier. 

• Make sure each heading is unique. Do not use the same text for a Heading 3 (subsection) 
that you used for your Heading 1 at the start of the document. The same principle applies 
to file/item names. Make sure each file or item you create has a unique name. 

• For longer topics, include a table of contents that links to each section and "Back to top" 
links at the end of each section. 

• Include alternative text descriptions (alt text) for all graphics. Use double quotes (null) "" 
as the alt text if the object is a decorative element that does not add meaning. If the 
graphic is a link, begin the alt text with "Link to". The Brightspace Editor automatically 
prompts you to include alt text when you insert an image. 

• Include detailed captions below tables and graphs. These captions should explain what 
the objects convey, including important trends and statistics. This will help all learners 
interpret the objects. For tables, include a caption using the caption element that explains 
how the table is organized. Check that tables make sense when read from left to right. 
Screen readers have difficulty conveying information that reads from top to bottom. 

• Use the same text on-screen and in the alt text for links. Make sure the text describes the 
action that will occur. Never use text such as "Click Here" as the link. Screen reader users 
often use a list of links to quickly navigate actions on a page; this is not possible if links 
are not descriptive. 

• Include text alternatives of multimedia content, such as audio or video files. If you do not 
have the time to create a complete text alternative, include a descriptive label that 
summarizes the content. 

• Do not use blinking or flashing multimedia as it can cause seizures in individuals with 
photosensitivity. Use animation when it helps convey a concept and not to draw attention 
to an unchanging object. Use a combination of size, color, and prominence to draw 
attention to objects. 

• Never use only color to convey meaning. If you want to show how concepts and objects 
relate to each other use a combination of size, color, and text labels. 

• Ensure there is a strong contrast between the text and background colors used in your 
course materials.  

• Use relative font sizes and make sure the text and page layout adjusts when font sizes 
are changed. Users should not have to scroll horizontally. 

• If you create PDF documents from Microsoft Word or another word processor, make sure 
you format titles and sections using headings so they are tagged correctly in the PDF. 

• If users can use text-to-speech software to read text aloud or highlight text as they go 
through it, test the software to ensure it functions correctly for specific tools and settings 
you want to create. For example, disabling right-click in quizzes can prevent some text-to-
speech software from tracking text, so try your software to see if you experience similar 
issues. 

• Take advantage of D2L-compatible tools, such as ReadSpeaker, Visual course widget, 
and audio topics.  
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• D2L recommends that instructors and instructional designers who want to make good 
default choices for learners with dyslexia read Dyslexia Style Guide 2018: Creating 
Dyslexia Friendly Content from the British Dyslexia Association. Browser extensions such 
as OpenDyslexic Font for Chrome are also available for learners with dyslexia.  

What kinds of files can I use for course content? 
Instructors can upload a wide variety of document, image, and video file types to use for course 
content. Learners view the files inline; however, they can also download or print the files, if they 
have the Content > Compile and Print Content and Content > Download Content Topics 
permissions. For more information, contact your administrator. 
To display documents inline, the Document Conversion Service converts documents uploaded 
to the Content tool into PDFs. The documents are converted during upload instead of during 
learner access, which reduces wait times when rendering the documents to learners. For best 
performance, D2L recommends uploading all non-HTML documents as PDF files, since PDF 
files do not go through the conversion process. When learners download documents, they are 
saved in their native file formats. 
  

Extension File Type Notes 

HTM, HTML, MHT, 
MHTML 

Web 
document 

Brightspace Learning Environment strips the <title> tag and 
text within the tag from user created web documents 

RTF, PPT, PPS, PDF, 
DOC, DOCX, PPTX, 
XML, XLS, TXT, WPD, 
XLSX, XLS 

Text 
document 

When embedded in Content, PowerPoint presentations that 
contain animations do not play; however, downloading the 
PowerPoint presentations saves them in their native file format, 
allowing the animations to play 

JPG, JPEG, PNG, GIF, 
BMP, TIF, TIFF 

Image   

SWF, MPG, MPEG, RM, 
MP3, MP4, M4V, M4A, 
AVI, WAV, RAM, ASF, 
MOV, RA 

Media The extensions MP4, M4V, and M4A allow users to drag entire 
albums, video podcasts, and movies from iTunes 

Create a new module 
To create a new module 
You must create a module before you can add topics. You can create submodules (modules 
within existing modules) to establish a deeper hierarchy.  

https://cdn.bdadyslexia.org.uk/documents/Advice/Dyslexic-Employee/Dyslexia_Style_Guide_2018-final.pdf?mtime=20190409173541
https://cdn.bdadyslexia.org.uk/documents/Advice/Dyslexic-Employee/Dyslexia_Style_Guide_2018-final.pdf?mtime=20190409173541
https://chrome.google.com/webstore/detail/opendyslexic-font-for-chr/cdnapgfjopgaggbmfgbiinmmbdcglnam?hl=en
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If your course is SCORM 2004-compliant, new modules that you create are outside the 
sequencing and navigation built into the SCORM package. 

1. On the navbar, click Content. 
2. In the Table of Contents panel, in the Add a module field, enter the name of your new 

module and then press Enter. 

To add a submodule, click into the module. In the Add a sub-module field, enter the name of 
your new sub-module and then press Enter. 

Create a new topic 
To enhance the security of content files that execute scripts to create extra-rich HTML 
experiences (such as objects that can execute JavaScript), there is a sandboxing feature that 
creates a secure iFrame around the HTML file. This allows an HTML file to execute scripts (such 
as JavaScript) within the iFrame only but will prevent them from executing outside the iframe 
(against the domain). This enables some flexibility in creating rich content, but reassurance for 
the security-conscious that end user information remains secure in all situations, such as when 
learners in specific courses have a special role with permission to create content topics. 
To create a new topic 

1. On the navbar, click Content. 
2. In the Table of Contents panel, click on the module in which you want to create a new 

topic. 
3. From the New drop-down menu do one of the following: 

• To add a video or audio topic, click Video or Audio. 
• To add a Brightspace Capture topic, click Capture. 
• To add existing files from your computer, course offering files, or Shared Files 

area, click Upload Files. 
• To add a new file, click Create a File. 
• To add a link, click Create a Link. 

 
Note: It is recommended that all link topics open as an external resource to prevent 
any unexpected security conflicts. 

• To add existing files from Manage Files, click Add from Manage Files. 
• To add files from Brightspace Learning Repository, click Add Object from LOR. 
• To add a new checklist, click New Checklist. 
• To add a new discussion topic, click New Discussion. 
• To add a new assignment, click New Assignment. 
• To add a new quiz, click New Quiz. 
• To add a new survey, click New Survey. 

4. Follow the prompts on the screen to modify your new topic. 
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Delete a module or topic 
Note: Deleting a module deletes all topics within that module. 

1.  On the navbar, click Content.  
2. In the Table of Contents panel, click the module or topic you want to delete. 
3. If you are deleting a module, click Delete Module from the module's context menu. If you 

are deleting a topic, click Delete Topic from the topic's context menu. 
4. Decide whether you want to remove the module or topic from the Content view only or 

permanently delete the module or topic from the course (this will also delete all associated 
objects including discussions, quizzes, etc). 

5. Click Delete. 

Add an existing course object to Content 

To add an existing course object to Content 

1. On the navbar, click Content. 
2. On the Table of Contents page, for the module you want to add a course object to, click 

Existing Activities and do one of the following: 
• To add an existing assignment, click Assignments 
• To add an existing chat, click Chat. 
• To add an existing checklist, click Checklist. 
• To add an existing discussion topic, click Discussions. 
• To add an existing Brightspace ePortfolio item, click Brightspace ePortfolio. 
• To add an existing external learning tool, click External Learning Tools. 
• To add an existing form template, click Forms. 
• To add an existing online room, click Online Rooms. 
• To add an existing quiz, click Quizzes. 
• To add an existing self assessment, click Self Assessments. 
• To add an existing survey, click Surveys. 

Note: Additional menu options may be available depending on your institution. 
3. Do one of the following: 

• To insert an existing activity, in the Add Activity window, click on the activity. 
• To create and insert a new activity, in the Add Activity window, click Create New 

[activity]. Enter your activity details and click Create and Insert. 
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Audio-Video Player 

 
Figure: The Audio-Video Player 

Video Quality 
The Gear icon allows users to change the video quality for high-definition (HD) files. Viewing in 
standard definition (SD) assists with playback in situations with a slow or unstable network. 

 
Figure: Use the Gear icon to change video quality 

Search 
The search field allows users to search for a keyword in a video caption track and see those 
locations reflected on the timeline. A caption track must be present for the video and the user 
must have captions turned on to use the Search option. 
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Figure: Search field visible for videos with captions, location of text indicated by the points on 
the timeline 
For additional information on the Audio-Video Player and Editor, visit the Evolving The Audio-
Video Experience Community blog post. 

Audio-Video Editor 

 
Figure: The Audio-Video Editor 
Files uploaded to the Content Service can now use the features of the Audio-Video editor to edit 
video timelines, create chapters, and add captions to videos.  
Note: D2L recommends using the desktop experience when editing audio-video files. 

Access the Audio-Video Editor in the Classic Content Experience: 

1. Click Upload / Create and select Video or Audio. 
2. In the Add Video or Audio window, select the Upload tab. 
3.  Browse for your file, or drag your video file into the upload space. 

https://community.brightspace.com/s/article/Evolving-the-Audio-Video-Experience
https://community.brightspace.com/s/article/Evolving-the-Audio-Video-Experience
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4. The upload process begins Note: The transcoding process starts when the file reaches 
70% upload and may result in a momentary pause. 

5. When the upload is complete enter a title and select Advanced Editing. 

Access the Audio-Video Editor in the New Content Experience: 

1. Create a new Unit. 
2. Drag the media file from your local files and drop it into the correct Unit. 
3. The upload process begins Note: The transcoding process starts when the file reaches 

70% upload and may result in a momentary pause. 
4. When the upload is complete, click the ellipsis menu …, and select Edit. 
5. Select Advanced Editing to update the video’s name and make other changes.  
6. From the Editor you can set the language of the video, generate a caption track from the 

Closed Captions tab and access the Editing and Chapter features. 

Edit Timelines 
Use the Seek (arrow), Mark (line), and Cut (scissor) icons to make cuts from the timeline of the 
original upload/recording. It is also possible to expand the timeline by clicking and dragging on 
the timeline to make more precise edits. 

Add Captions 
On the Closed Captions tab, use the Auto-Generate or Upload options to add captions. 

Add Chapters 
On the Table of Contents tab, add chapter titles and set their locations. 

Access previous versions 
After changes have been saved the date indicator allows users to open a menu and select from 
previous versions. 
For additional information on the Audio-Video Player and Editor, visit the Evolving The Audio-
Video Experience Community blog post. 
  

Hide Content topics and modules 

1. Open the context menu of the topic or module you want to hide. 
2. Select Hide from Users. 

https://community.brightspace.com/s/article/Evolving-the-Audio-Video-Experience
https://community.brightspace.com/s/article/Evolving-the-Audio-Video-Experience
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OR 

1. Select the visibility icon for the topic or module. A visibility toggle appears to allow you to 
change between Visible and Hidden. 

The visibility status of a topic appears when the topic is not visible, when the table of contents is 
in bulk edit mode, or when a topic is in edit-in-place mode. The table of contents fly-out menu no 
longer provides the ability to switch the visibility of a topic or module. If a topic or module is 
already hidden, the hidden icon indicates its status. Open the context menu and select Make 
Visible to Users to allow user access. When creating activities from Content, (e.g. New 
Checklist, New Discussion, New Assignment, etc.) a Hide from Users checkbox displays below 
the title to allow instructors to easily control the visibility of the new activity. 

Create a quicklink to a rubric in Content 
Instructors with the See Rubrics permission enabled can create quicklinks directly to rubrics 
with the Rubric is visible to Students setting enabled. In addition, users with the Manage 
Rubrics permission enabled can also access Manage Rubrics at the bottom of the Quicklinks 
menu. The See Rubrics permission is not required for learners to access quicklinked rubrics 
that are visible to learners, however the rubric must be associated to a tool for evaluation in 
order for a learner to see it. 

1. In Content, create a new module. 
2. Click Upload/Create, and select Create a File from the drop-down menu. 
3. Click Insert Quicklink. 
4. In the Insert Quicklink menu, select Rubrics. 
5. In Rubrics, select the desired rubric, and click the pencil to edit the options for the rubric 

and choose to open in a new window. Note that Manage Rubrics is accessible in this 
menu. 

6. Click Publish. 

Note that only rubrics with Visible to all Users selected can be quicklinked. 

Manage Rubrics through the Quicklinks menu 
In order to make rubrics more accessible without navigating directly to Rubrics, instructors can 
access Rubrics through the Quicklinks menu. 

1. Click Insert Quicklink. 
2. In the Insert Quicklink menu, select Rubrics. 
3. Click Manage Rubrics (Opens in a new Tab). 
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Video Note Automatic Captioning 
In Brightspace Core, Video Note can automatically transcribe video note recording as they are 
uploaded and provide captions to videos without the need to manually create and upload a .vvt 
file. Updates to the user interface allow you to modify the auto-generated transcript to correct 
any inaccuracies and increase the accessibility of video notes. 
Captions are also generated for videos created before the automatic captioning feature was 
available. A transcript of the video and the caption file can be downloaded from Brightspace 
Learning Environment for use in other applications. 
Captions can be created in the following languages: 

• US English (en-US) 
• British English (en-GB) 
• Canadian French (fr-CA) 
• German (de-DE) 
• Brazilian Portuguese (pt-BR) 
• Korean (ko-KR) 
• Italian (it-IT) 
• Spanish (es-MX) - If not available, US Spanish (es-US) is used 
• Modern Standard Arabic (ar-SA) 
• Chinese Mandarin - Mainland (zh-CN) 
• Russian (ru-RU) 
• Japanese (ja-JP) 
• Turkish (tr-TR) 
• Dutch (nl-NL) 

Add subtitles to video topics 
You can add subtitles to uploaded videos by uploading an SRT or WebVTT file. You can also 
attach more than one subtitle file to a video to accommodate more than one language. This can 
make your video available to a broader audience. Subtitles appear to students as closed 
captions within the video player and they can decide if they want to view the video with subtitles 
enabled, as well as which of the available languages they want to use. Subtitles are not 
automatically generated for videos, and they are not automatically translated into different 
languages. The closed caption file uploads into a subfolder in the same location as the video 
file. You can only add subtitles to the videos that you upload. If you want to include subtitles for 
web videos hosted on another site, such as YouTube, you must follow the practices of that site.  

1. On the navbar, click Content. 
2. In the Table of Contents panel, click on the module in which you want to create a new 

video topic. 
3. From the Upload/Create button, click Video or Audio. 
4. In the Upload tab, upload your video. 
5. Click Add Subtitles. 
6. From the Subtitle Language drop-down list, select a language. 
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7. To upload the SRT or WebVTT file containing your close captions for the video, click 
Browse. Locate your file and click Open. 

8. Click Done > Save. 

About SRT files 
An SRT file is a .srt extension file that contains a formatted plain text list of timecodes 
(HH:MM:SS,MIL) matched with subtitles. Each item on the list is numbered sequentially starting 
with 1. You can create your own SRT file with a plain text editor such as Notepad or TextEdit, 
and save the file with extension .srt. The following is a .srt file example:  
1 
00:00:00,000 --> 00:00:07,000 
Hello, welcome to this CaptureCast presentation. 
2 
00:00:07,050 --> 00:00:12,000 
Today I will be speaking about changes in eLearning technology. 
3 
00:00:12,050 --> 00:00:20,000 
This is a thirty minute seminar. If you wish, you may take notes during 
this presentation.  

Managing course content using drag and drop 
In the Content tool, you can arrange your course content by dragging and dropping modules and 
topics using the module or topic's drag handle ( ).  
If you drag a module or topic above or below other modules and topics, a gray line appears to 
indicate you can drop the module or topic there. If you drag a module or topic over another 
module, the module appears orange to indicate you can drop it there. 
You can also automatically update your existing files by dragging the newest version of your file 
from your computer into the appropriate module. When a module contains no topics, an upload 
target displays. If you drag a file over an upload target, that area appears orange to indicate you 
can drop it there. When a module contains topics, you can still drag a file into it. A horizontal line 
indicates where the file will be dropped, allowing you to create new topics between pre-existing 
ones. You can also drop files from your computer directly into the Table of Contents panel.  
When you drag files from your computer into a module's upload target to add or update topics, 
the files will save in the Manage Files tool. A dialog prompt will appear asking you where in 
Manage Files you want to save the new file.  
Internet Explorer 9 and older currently do not support dragging and dropping files from your 
desktop into Brightspace Learning Environment.  
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Set up a quicklink to a discussion topic or forum within an existing Content 
topic 

1. From the course home page, click Content. 
2. Click the content module or sub-module for the topic you want to create a quicklink in. 
3. From the context menu of the topic you want to add a quicklink to, click Edit HTML.  
4. In the Content editor, enter the text you want to hyperlink to, highlight the text, and then 

click the Quicklink icon. 
5. In the Course Materials dialog box, click Discussions. 

• To add a discussion forum, click the Insert icon for the forum. 
• To add a discussion topic, click directly on the topic. 

Set up a quicklink to a discussion topic or forum so that it exists as a Content 
topic under a parent module or sub-module 

1. From the course home page, click Content. 
2. In the module or sub-module you want to add the quicklink to, click Existing Activities 

and then Discussions. 
3. Click the discussion forum that you want to add a quicklink to: 

• To add a discussion forum, click the Insert icon for the forum.  
• To add a discussion topic, click the topic. 

Insert Group Self-Enrollment Link 
In the Content tool, instructors can create a self-enrollment link for discussion groups to facilitate 
sorting the members of a course with many learners into groups. 

1. In the text editor, click Insert Quicklink. 
2. In the pop-up window, select Self-Enrollment Groups. 
3. Select a group in the Self-Enrollment Groups window, and click Select. 

Set a content topic or module's status 
If you set a module's status as draft, the module and all its topics are hidden from students. 

1. On the navbar, click Content. 
2. Do one of the following: 

• To set a topic's status, on the Table of Contents page, from the context menu of 
the topic you want to set, click View Topic. In the Activity Details tab, from the 
status drop-down list, select either Published or Draft. 

• To set a module's status, from the Table of Contents panel, click on the module's 
name. From the status drop-down list, select either Published or Draft. 
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Styling content topics consistently 
You can create a new HTML document based on any existing HTML file. If you set up a path to 
a directory containing HTML templates in Manage Files, these template choices appear in a 
drop-down list when you create a new document. All links to assets such as images, CSS, and 
JS files are maintained when you create a new HTML document from a template in Content. 
Therefore, you can build many documents from one central template housed in the template 
directory, with standard styles and images already included. 
If you have already created an entirely new HTML document, you can save it in your template 
directory for other documents. 

Enable HTML templates in Content 
To enable HTML templates in Content 

1. On the navbar, click Content. 
2. Click Settings. 
3. In the Content Authoring area, select the Enable HTML Templates check box. 
4.  To make it easier to find HTML templates, select the Sort HTML Templates by name 

option to sort templates in alphanumeric order based on filename. Administrators can set 
the default sort order for the org or specific org units by editing a configuration variable. By 
default, HTML templates are sorted alphanumerically based on directory structure.  

5. If you want to change where your templates are located, click Change Path. Select your 
new location, then click Select Path. 

6. Click Save. 

Apply an HTML template to a new document in Content 

1. On the navbar, click Content. 
2. On the Table of Contents page, from the Upload/Create button of the module you want 

to add a new document with an HTML template attached, click Create a File. 
3. Do one of the following: 

• If you have a defined template directory, from the drop-down list, click Select a 
Document Template. 

• If you do not have a defined template directory, click Browse for a Template. 
Locate the template you want to use, then click Add. 

4. Customize your topic according to your needs. 
5. Do one of the following: 

• To publish your topic, click Publish. 
• To save your topic for further edits, click Save as Draft. 
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Add a learning objective to a content topic 
You can associate topics with learning objectives directly from the Content tool, but you must 
have existing learning objectives in the Competencies tool before you can create these 
associations. 

1. On the navbar, click Content. 
2. On the Table of Contents page, click on the topic you want to associate with a learning 

objective. 
3. In the Learning Objectives tab, click Add Learning Objectives. 
4. Locate the learning objectives you want to add to your topic. Select the check box for 

each learning objective you want to add. 
5. Click Add Selected. 

Create a New SCORM object's grade item 
In addition, instructors and administrators can indicate the grade calculation method for new 
SCORM object when they add the new SCORM package to the course. In the legacy SCORM 
solution, only the latest grade calculation was available. With the new SCORM solution the 
default is the highest grade achieved; however, you can also set the method to lowest attempt, 
average of all attempts, last attempt, or first attempt. 

1. On the navbar, click Content. 
2. Click Upload/Create, and click Select new SCORM object. 
3. Select a SCORM object from the list of previously uploaded objects. 
4. Click Add. 
5. Click Yes to create a grade item for the SCORM object. When you save the object, the 

item is added to the Manage Grades table. 
6. Select the type of grade calculation method you want to use for the new SCORM object 

grade item. 
7. Click Add to add the SCORM object to the course, create the grade item, and send the 

grade specifications for the object to the Grade Book.  
8. If you want to make additional changes to the Grade Item, you can access the newly 

added object in the Manage Grades table to change the item name, add a description, or 
change the grading options. 

Create a legacy SCORM object's grade item 
You can edit SCORM packages with the same options that are available when you create 
content topics. Although you can add a grade item to a SCORM object, completing a quiz 
included in a SCORM package automatically generates a grade item in the grades list, 
populated with the quiz results. 

1. On the navbar, click Content. 
2. On the Table of Contents page, click on the SCORM topic for which you want to create a 

grade item. 
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3. In the Activity Details tab, in the Assessment area, click Add a grade item. 
4. Enter a Points value for the grade item. 
5. Do one of the following: 

• To add an existing grade item, from the drop-down list, select your item. 
• To create and attach a new grade item, click the New Grade Item icon. Enter your 

new grade item's details. Click Create. 
6. Click Save. 

Remove SCORM simple sequencing 
You can remove the sequencing and navigation rules from a SCORM package if you want to 
use some of the modules or topics in another course, or reorder modules and topics in the 
current course. 
Removing sequencing and navigation from a SCORM package resets progress tracking for 
those topics. 

1. On the navbar, click Content. 
2. From the Table of Contents panel, click on the module from which you want to remove 

simple sequencing. 
3. From the context menu of the module, click Remove Sequencing. 
4. Click Yes. 

Why are YouTube videos and other embedded media using Insert Stuff not 
working/loading? 
There are two potential reasons your content may not be working: 

1. When using the Insert Stuff framework to add a YouTube video/other embedded media in 
a Content frame, the Firefox internet browser blocks the content because it is unsecure 
without informing the user that there is actually an invisible block around where the media 
should be. This makes it appear as if the insert failed even though the browser is actually 
blocking the unsecure content.  
To resolve this issue, the URL that is linked from within the Content frames must use 
https:// and NOT an http:// URL. If the destination site doesn't have an https:// URL, then 
you might reconsider linking to this content. If it is necessary, ensure that your students 
know that they need to enable the ability to view unsecure content. 

2. It is possible your course is ‘Sandboxed’. To enhance the security of content files that 
execute scripts to create extra-rich HTML experiences (such as objects that can execute 
JavaScript), there is a sandboxing feature that creates a secure iFrame around the HTML 
file. This allows an HTML file to execute scripts (such as JavaScript) within the iFrame 
only but will prevent them from executing outside the iFrame (against the domain). This 
enables some flexibility in creating rich content, and provides reassurance for the security-
conscious that end user information remains secure in all situations (such as in courses 
where non-privileged roles are contributing content.)  
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To find out if your course is sandboxed, access Course Admin > Course Offering 
Information. An indication if your course is sandboxed or not, is available on that page. 

Why can't learners see the Content I posted? 
If learners indicate that they can’t see a Content Module or Topic that you posted, review the 
following settings for that Content Module/Topic: 

1. From the course homepage, click Content. 
2. Select the Content module/sub-module from the contents section. If learners can't see a 

content topic, click the topic's context menu and select Edit Properties. 
3. Click Add dates and restrictions. 
4. Review the following: 

• Ensure that the start and end dates set on the Content Module / Topic are accurate. 
If there is a start or end date set on the Content module / topic that wasn’t intended, 
remove the dates filled in the Start Date and End Date fields so that they are blank.  

• Under Release Conditions, ensure that the release conditions set on the Content 
Module / Topic are accurate. 
If there are release conditions set that weren't intended, remove the release 
conditions by clicking the Delete icon. 
If the start date, end date, and release conditions are set accurately, and learners 
still can’t view the Content module / topic, then the reason the learners cannot view 
the Content is due to them not having met the release conditions to be able to view 
the Content.  

Format HTML course content 
Brightspace Editor integrates with all Brightspace Learning Environment tools that have HTML 
content creation capabilities. For example, the Editor is available when you edit discussion 
topics, create custom instructions for assignment folders, give feedback, and create content 
topics. 

About Brightspace Editor 
Brightspace Editor is now the default editor across the Brightspace Platform.  
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Figure: The new Brightspace Editor 
The new Brightspace Editor includes the following enhancements: 

• Refreshed formatting options  
• The Lato font type  
• A refreshed color picker  
• A refreshed font size menu  
• A comprehensive and standard emoticon menu  
• A comprehensive and refreshed symbols menu  
• An advanced source code editor  
• A refreshed Tables feature, including data sorting  
• A refreshed Accessibility Checker  
• The placement of the Check Accessibility, HTML Source Editor, Preview, and Toggle Full 

Screen functionalities into the top bar  
• Word count functionality that includes words, characters, and text selection. 
• Context menus while editing to enable quick access to text, link, and image editing 

options; including advanced image editing options (where image editing is currently 
available).  

• A new overflow menu with additional, infrequently used menu options.  
• A format painter that enables you to copy and apply text formatting. 
• @mentions – @mentions is controlled by the organization unit configuration variable, 

d2l.Tools.WYSIWYG.Mentions, that is deployed in an OFF state. Once enabled by an 
administrator, in discussion posts, users can now tag other users within the same course 
using @mentions depending on permissions. Tagged users are notified by alerts in the 
minibar. External notifications are not yet available. 

• The Editor now allows users to set page attributes (title and language) in the Attributes 
menu. Page attributes only appears in legacy Content, Lessons, and Custom Widgets. 

• The Editor now remembers the open or closed state of the More Actions button, per 
user, in order to reduce clicks for users that frequently use options in the expanded editor. 

• The Editor now uses pixels (px) in the font size menu in order to match the Content 
Settings menu for an org unit’s default font size. 

• The drag/drop and copy/paste functionality for images in areas that do not contain user 
specific data is now available. Those areas include: 

• Content Module/Topic Descriptions 
• Quiz/Survey/Self-Assessment - Description, Header. Footer 
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• Grades - Description 
• Content Course Overview descriptions 
• Discussion Forum/Topic descriptions 
• Quizzes Feedback and Grades Feedback 
• Grades Comments 
• Discussions > Post feedback and Thread feedback 

Note: This functionality is available in user-specific areas that may contain images with 
learner-sensitive information. As a result, these images are stored in the database rather 
than the Manage Files area of a course offering. In addition, the Course Copy function 
does not include these images.  

 The list below outlines what is not included in the Editor:  

• Spell check functionality. D2L recommends using your browser spell check functionality. 
However, the d2l.Tools.Quizzing.ShowSpellCheckInAttempts org unit configuration 
variable is still respected and marks text in Quizzes to be ignored by the browser spell 
checker. It can be turned off for all quizzes at the org unit level. 

• Cut/Paste functionality. D2L recommends using your browser hot keys/menus for this 
functionality.  

  
The Brightspace Editor has three options you can choose when viewing content:  

View Description 

Design 
view 

The design view loads automatically when Brightspace Editor is accessed. Use this 
view to quickly create and format content without needing any prior knowledge of 
HTML. Enter your content and use the available controls to apply formatting to your 
text, insert images and tables, and create links.  

Source 
Editor 
view 

Click the  HTML Source Editor icon to display the source editor view. This view 
displays the code that structures and formats your content. Use this view if you 
have experience with HTML and prefer to author your content in HTML or want to 
apply styles from a cascading style sheet (CSS). If you have HTML-based content 
from another application, you can also copy and paste that code into the source 
editor view. 

Preview Use the view to display a preview of your HTML content in a new window. This 
allows you to preview content and ensure that it displays as expected prior to 
saving any changes.  

  
The Quiz Builder supports the new inline Editor.  
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The inline limited version of Brightspace Editor is now available in Activity Feed as the default 
editor. 
Brightspace Editor HTML options in Activity Feed include: Bold, Italic, Underline, Strike-through, 
Superscript, Subscript, Font Color, Bulleted Lists, Numbered Lists, Increase/Decrease 
Indentation, Insert Stuff, Insert Quicklink, and Emoji. Insert Stuff now includes various 
capabilities, including Video Note functionality. 
  

 
Figure: The updated inline limited version of Brightspace Editor in Activity Feed 
  
See Also: 

• Navigating the Brightspace Editor with a keyboard 

Administer Video Note 
Video Note enables you to insert video recordings through Brightspace Editor's Insert Stuff 
option, and anywhere video attachments are supported (Content, Discussions, Grading, 
providing feedback to learners, and Activity Feed).  
The ability to insert, upload, and administer Video Notes is controlled by Media Platform 
permissions set by your administrator. For example, if a user does not have the Can Upload 
Video Notes permission, the Add Video Note option does not display when using Insert Stuff 
to add a Video Note. 
Note: If you have permissions to access Video Note Search, you can also search and insert 
video notes made by you and other users. 
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Create and insert a video note in Brightspace Editor 
 You can use Video Note in a number of places throughout Brightspace Learning Environment, 
including: Content, Discussions, Activity Feed, and even when grading and providing feedback 
to learners. 
Note: The ability to add video notes is controlled by a permission set by your administrator. If 
you do not see the Add Video Note option, you do not have the required permission. 

1. From Content, click Upload/Create and select Create a File. 
2. Click  Insert Stuff.  
3. Click Add Video Note. 
4. To record your message, click New Recording. 
5. To finalize your message, click Stop Recording. 
6. Click Next. 
7. Enter a Title, Description, and select the Audio Language. 
8. To generate captions automatically, select Automatically generate captions from audio. 
9. Click Next. 

10. Click Insert. 

  
To upload a Video Note or to select an existing Video Note file: 

1. In Brightspace Editor, click Insert Stuff. 
2. Select Upload File or Choose Existing. 

If you select Upload File, do the following: 

1. Click Choose File and select the locally saved file you want to upload. 
Note: You can only upload MP4, FLV, F4V, or MOV files that are less than 5.00 MB in 
size. 

2. Click Next, and enter a title and description. 
3. Click Next, and then Insert. 

If you select Choose Existing, do the following: 

1. Select Video Note Search. 
2. Enter your search terms in the Search Notes field, then select Search. You can also 

perform a blank search to see all search results. 
3. Select the Video Note you want to insert. 
4. Click Add. 

Add closed captions to a video note 

1. Create a video note in Brightspace Editor using Insert Stuff. 
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2. Using a text editing program such as Notepad (PC), or TextEdit (Mac) create a .vtt file 
with the following format: 

WEBVTT [Required on first line to indicate file type] 

00:01.000 --> 00:03.000 [start and end timestamp in minutes:seconds.milliseconds] 
Insert caption text here [Type the captions you want displayed during this portion of the video] 
00:04.000 --> 00:08.000 
Insert caption text here. 
00:09:000 --> 00:14.000 
Insert caption text here. 

3. Save the text file as a .vtt file by including .vtt at the end of the file name, and setting the 
file type to All files. 

4. Return to Brightspace Learning Environment. 
5. From Admin Tools, select Video Note Captions. 
6. Search for the video note created in the previous steps and click it. 
7. Click Choose File, locate the .vtt file created in the previous steps, and click Open. 
8. Click Save Captions. 
9. Click the Video Preview, and select the options menu (...). 

10. Click Captions to change from Captions Off to Captions Default. 
11. Play the video and confirm the closed captions are visible and display at the appropriate 

times. 
Note: For more information on creating .vtt files, visit How to Create A WebVTT File. 
Ensure you follow the formatting exactly or the captions won't display. You can use any 
compatible third-party captioning method to complete this process. 

Reuse video notes 
If you have created previous video notes, and if you have permission to search and insert video 
notes, you can reuse video notes.  

1. In Brightspace Editor, click the Insert Stuff icon. 
2. Click Video Note Search. 
3. Enter your search terms in the Search Notes field, then click Search. You can also 

perform a blank search to see all search results.  
4. Select the video you want to insert and click Next.  
5. You can preview the video note before you insert it.  
6. Click Insert.  

Insert and edit images 
The Insert Image option is available wherever the Brightspace Editor is present. 

1. In Brightspace Editor, click the Insert Image icon.  

https://www.3playmedia.com/2017/06/30/how-to-create-a-webvtt-file/
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2. In the Add a File pop-up window, click either My Computer or Course Offering Files 
and select the image you want to insert, or click URL and link out to the image you want to 
insert.  
Note: If you want to save the image file in a specific location, click Choose Destination 
and select the path or create a new folder in which you want to save the same. 

3. Click Add, enter the Alternative Text, and click OK. 
4. Click Update. 
5. To edit the image properties, click on the image. A pop-up menu appears below the 

image. 
6. Click Edit Image or Image Options. 
7. Make your changes to the image, then click Save 

  
Note: Image changes save at the course-level root to Manage Files or, depending on user 
permissions, as new file attachments to the item (e.g. Discussions) every time a change is 
made. Multiple edits, in turn, create multiple files. If the course is copied, all image edits are 
copied as well. 

Inserting equations in the Brightspace Editor 
The Graphical Equation Editor enables users to insert mathematical equations within the 
Brightspace Editor. It supports the input of MathML, LaTeX, graphical, and chemistry equations.  
Note: LaTeX is now available in the new quizzing experience. 
The Graphical Equation Editor in Brightspace Learning Environment 10.2 and newer does not 
require Java support or have specific browser compatibility considerations. Existing equations 
created before Brightspace Learning Environment 10.2 will still require Java Applet support but 
are up-converted to MathML upon an edit.  

Concept Description 

MathML 
equation 

MathML is a standard adopted by the World Wide Web Consortium (W3C). It 
uses XML to describe mathematical notation by capturing both its structure and 
content. This enables MathML to support visual display and assistive 
technology access. 
As a standard, Brightspace Learning Environmentstores and displays all 
equations in the MathML format, regardless of the format you use to enter 
equations. Brightspace Learning Environment uses the MathJax JavaScript 
engine to display MathML equations.  
Go to http://www.mathjax.org to learn more about MathJax features. 

LaTeX 
equation 

LaTeX is a typesetting system based on TeX. It provides a text syntax for 
complex mathematical formulae. Brightspace Learning Environment stores 

http://www.mathjax.org/
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Concept Description 
equations entered in LaTeX format as MathML to ensure consistency and 
accessibility. 

Chemistry 
equation 

The Chemistry equation option offers specialized chemistry symbols for 
inorganic chemistry formulas.  

Graphical 
equation 

The Graphical equation option offers 10 tabs of symbols, arrows, Greek letters 
and numbers, matrices, scripts and layouts, decorations, big operators, 
calculus, and context for creating math equations.  

About the Graphical Equation Editor 
The Graphical Equation Editor is a Javascript-based application within the HTML Editor tool that 
enables users to add graphical, chemistry, MathML, and LaTeX equations to their content. The 
editor provides the necessary elements to construct equations quickly and easily. Each button in 
the editor tool bar opens a palette of related mathematical symbols. When equations are 
inserted into the HTML Editor, you can see the equations inline while editing your work. You can 
insert equations by typing them into the HTML Editor. 
Note: LaTeX is now available in the new quizzing experience. 
Before using the editor: 

• Ensure that you have installed the latest version of your internet browser and that you 
enable Javascript 

• Disable any software or browser settings that block pop-up windows 

Tabs in the Graphical Equation Editor 

Icon Name Description 

 Chemistry tab Add specialized chemistry symbols for inorganic chemistry equations 
Note: This tab only appears when you select the Chemistry equation option 

 General tab • Add a template for building equations.  
• Add and edit text in the equation using the Cut, Copy, Paste, Undo, 

Color, and other text editing function 

 Symbols tab Add mathematical symbols to equations 

 Arrows tab Update or add arrows to equations 

 Greek and 
letters tab 

Update or add uppercase and lowercase Greek characters to equations 
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Icon Name Description 

 Matrices tab Update or add matrices to equations 

 Scripts and 
layout tab 

Add scripts or layouts to build equations 

 Decorations tab Add fences such as brackets and vertical bars around text fields 

 Big operators 
tab 

Update or add big operators to equations 

 Calculus tab Add a template for building Calculus equations 

Create an equation using classic input mode 

1. Access the Brightspace Editor in the tool where you want to create an equation. 
2. From the Graphical equation drop-down list, do one of the following: 

• To insert a graphical equation, click Graphical equation. 
• To insert a chemistry equation, click Chemistry equation. 
• To insert a MathML equation, click MathML equation. 
• To insert a LaTeX equation, click LaTeX equation. 

Note: LaTeX is now available in the new quizzing experience.  
3. In the Insert Equation window, enter your equation using keyboard characters and your 

cursor to select symbols from the tabs. 
4. Click Insert. 

Edit an equation 

1. Navigate to the course item that contains the equation you want to edit. 
2. From the context menu of the course item, click Edit HTML. 
3. In Brightspace Editor, click on the box with the  capital sigma sign. 
4. From the Graphical equation drop-down list, do one of the following: 

• To edit the equation using the graphical equation format, click Graphical equation. 
• To edit the equation using the chemistry equation format, click Chemistry 

equation.  
• To edit the equation using the MathML equation format, click MathML equation. 
• To edit the equation using the LaTeX equation format, click LaTeX equation.  

Note: LaTeX is now available in the new quizzing experience. 
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5. Make your changes. 
6. Click Insert > Update. 

Add URL links to a course 
Use the Links tool to provide URL links to external web sites, quicklinks, and internal course 
offering areas that are useful to users in your course.  
All links are organized into categories. For example, a psychology course might provide the link 
categories General, Psychology, Reference Materials, Online Publications, and so on. 
Categories ensure better organization of links and enable users to quickly find the information 
they need.  

Create a link 

1. On the navbar, click Course Admin. 
2. Click Links. 
3. On the Manage Links page, click New Link. 
4. Do one of the following: 

• To add your link to an existing category, from the Category drop-down list, select a 
category. 

• To add your link to a new category, click New Category. Enter your category 
details. Click Save. 

5. Enter a title for your link. 
6. Do one of the following: 

• To add an external link, in the URL area, enter the URL in the field provided. 
• To add a quicklink, in the URL area, click the Quicklink icon. In the Insert 

Quicklink dialog, navigate to the link you want to insert. 
7. Click Save. 

Create a link category 

1. On the navbar, click Course Admin. 
2. Click Links. 
3. On the Manage Links page, click New Category. 
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4. Enter your category details. 
5. Click Save. 

Delete links and link categories 
Deleting a category also deletes all the links in that category. 

1. On the navbar, click Course Admin. 
2. Click Links. 
3. From the context menu of the link or link category you want to delete, click Delete. 

Fix broken links in Content 
Links in Content may be broken if users receive a "Not Authorized" error message when 
attempting to access a resource/tool by clicking on the quicklink. 
Note: If a user clicks a quicklink to a course activity that is outside the availability dates (not yet 
available or no longer available), the following error message appears: "Unavailable Quicklink. 
The <activity type> is not available". In this case, the quicklink is not broken. If you want users to 
gain access to the activity, then you must change the availability dates for the activity.  

1. On the course home page, click Content. 
2. Click on the module or sub-module that contains the topic with the broken link. 
3. Do one of the following: 

• If the topic is a direct quicklink, from the context menu of the quicklink, click Edit 
Link, make your changes, and then click Update. 

• If the body text of a topic contains a quicklink, from the context menu of the topic 
containing the broken link, click Edit HTML, highlight the affected link in the text 
box, click the Quicklink icon, and click on the tool (Quizzes, Discussions, etc.) you 
want to quicklink to, or select Url if the quicklink is a URL. 

Notify learners about updated course content 
You can notify learners when updating or changing an HTML topic in Content. They receive an 
Update alert notification in their minibar; clicking the alert brings them to the updated topic. 

1. On the navbar, click Content. 
2. In the Table of Contents pane, click on the module that contains the HTML topic you 

want to update, then click on the topic. 
3. Do one of the following: 

• To edit the contents of the topic, from the context menu of the topic, click Edit 
HTML. Make your changes. 

• To replace the topic, from the context menu of the topic, click Change File. To 
upload a new file, click Upload. Follow the prompts to add your new file. 

4. Select the Notify students that the content has changed check box. 
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5. If you want to describe your update changes, enter a description in the Add a summary 
of the changes field. 

6. If you want learners to revisit the topic to complete the activity, select the Reset 
completion tracking check box. 

7. Click Update. 

Add availability and due dates in Content 
Start and end dates specify when learners can access a topic or module. If you set a start, end, 
or due date for a topic or module, it will appear on the Upcoming Events page and the Agenda 
view in the Calendar tool. Setting an end date later than the due date for a topic enables 
learners to access and complete the topic from the Overdue tab on the Course Schedule page. 
Topics with a due date and no end date also appear in the Overdue tab on the Course Schedule 
page.  
Note: Adding a due date to a content item that is associated to an assignment overrides an 
existing end date that is further in the future. The due date also overrides the end date in the 
Calendar tool. 

1. On the navbar, click Content. 
2. On the Table of Contents page, click Bulk Edit. 
3. For any topic or module that you want to add availability or due dates to, click Add dates 

and restrictions. 
4. Do any of the following: 

• To add a start date, click Add start date. Enter your start date details. 
• To add a due date, click Add due date. Enter your due date details. 
• To add an end date, click Add end date. Enter your end date details. 

5. Click Update. 
6. Click Done Editing. 

Add a Release Condition to Content 

1. On the course navbar, click Content. 
2. In the Table of Content, locate the content item you want to have a release condition. 
3. Open the context menu, and select Edit Properties In-place. 
4. Click Add dates and restrictions…, and under Release Conditions click Create. 
5. From the Condition Type menu, select the condition you want to create. 
6. Add Condition Details, and click Create. 
7. Click Update to save your changes. The release condition details are now listed below the 

topic name. 

Evaluate assignment submissions from Content 
You can evaluate a learner's assignment submissions from Content even if the learner didn't 
submit anything to the assignment. As a result, you can assign comments and grades to 
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learners with no submissions (for example, a grade of 0), and to learners who submitted work 
outside of Brightspace Learning Environment.  

1. On the navbar, click Content. 
2. In the Table of Contents pane, click on the module that contains the assignment for 

which you want to evaluate submissions. 
3. Click on the assignment. 
4. In the Completion Summary tab, click on a user's name. 
5. Enter your feedback in the Evaluation area. 
6. Do one of the following: 

• To publish your feedback, click Publish. 
• To save your feedback without publishing, click Save Draft. 

7. Do one of the following: 
• To navigate to the next user in the list, click Next Learner. 
• To stop evaluating users, click Back to Folder Submissions. 

Create course content in the new Content experience (Lessons) 
Brightspace Learning Environment has an alternative Content experience that provides an 
intuitive way to create lessons aligned to standards, outcomes, and expectations. 
Instructors can build their course as they go, with a variety of activities and content to choose 
from, including their own HTML documents, or documents located in Google Drive or Microsoft 
OneDrive ™ online storage service, links and videos from the web, external learning activities, 
video assignments and more. 
Context can be added with visual and rich descriptions for content, including embedded images 
and videos. For organizations that have a catalog of templates to choose from for HTML 
documents, those templates can be accessed in a simple drop-down menu when new content is 
being created. 
The visibility toggle enables you to control the visibility of units, lessons, folders, HTML 
documents, and web links at the time of creation. 
As activities are added to the course, they can be shared with learners immediately via the 
Activity Feed or scheduled for later. Content can be made visible or hidden to learners using a 
quick ‘hide/show’ toggle, or by using release conditions to personalize the pace and path for 
individual learners. 
While building and teaching the course, it’s easy to see how the course satisfies the 
required outcomes, expectations, or standards. 
You can try it today — the new Content experience can be turned on as an “opt-in/out” option, 
allowing instructors to go back and forth between the two experiences and choose according to 
their preference. Note that the new experience does not yet offer advanced capabilities such as 
visual completion tracking or other visual statistics, bookmarking, and bulk editing. The new 
Content experience only displays content in courses up to four levels deep (unit > lesson > 
folder > material). If your course content is more than four levels deep, when you opt-in to the 
Lessons experience, a notification appears stating that some content cannot be displayed and 
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directs you to modify the course structure in the old Content experience before trying out the 
new Content experience. 

Organizing course content in Lessons 
In Lessons, course content is organized using the following components:  

• Units organize content categories. For example, in a course about William Shakespeare's 
work, units might include: Comedies, Tragedies, and Sonnets. 

• Lessons organize content in units. For example, in the Tragedies unit, lessons might 
include: Hamlet and Macbeth. 

• Folders organize content in lessons. For example, in the Hamlet lesson, folders might 
include: Lecture Notes and Materials. 

• Materials are individual course content items. Typically, these are the interactive 
components of a course. For example, the Materials folder in the Hamlet lesson might 
include a discussion, assignment, and quiz. 



 

115 
© 2022 D2L Corporation. All rights reserved. 

 
Figure: Course components in Lessons 
Organizing course content using units and lessons is a common teaching practice and very 
familiar to most teachers and students. To help reinforce the organization of content and make 
navigation easier, course components use different color schemes.  
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When course components are initially created, they are hidden from learners. This ensures that 
instructors don't display content until they are ready to share them with learners. The visibility 
toggle and icon indicate the status of a course component: Visible (  icon) or Hidden (  
icon).  
You can rearrange course components using drag-and-drop. You can also easily add content by 
choosing a material type or using drag-and-drop. 
To clearly indicate where you are adding material to, the top of the page displays breadcrumbs. 
This also allows you to easily navigate up or down the tree to add material at different levels. 

Navigating in the Lessons interface 
In the Lessons interface, the table of contents for the course is represented by a familiar tree 
structure, allowing you to easily organize and navigate course components (lessons, units, 
folders, and materials).  
Arrow icons display on tiles that contain additional course components, indicating the tiles can 
be expanded by clicking them.  
Hovering over a component displays a tool-tip. This is useful if the complete heading is too long 
to display in the table of contents. 
Each material type displays a unique icon, making it easier to visually distinguish materials. 
To familiarize yourself with the Lessons interface 
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1. Standards displays all content units and the learning standards they align to. The 
numbers in each column indicate the number of activities in a unit satisfying a standard. 
For more information, see Locate gaps in standards coverage. 

2. New Unit adds a new unit to the course. For more information, see Create a new unit. 
3.   Course options provides options to Pace Course, Preview as a Student, and View 

Reports. Pacing (previously known as scheduling) suggests when to start teaching 
different course materials in chronologically sequenced content units. For more 
information, see Set a course timeframe. View Reports takes you to the Content Report 
for the course. For more information, see Checking course content statistics. 

4. Availability date and due date information displays in the table of contents next to each 
course component. The availability date indicates when the component will be visible to 
students, and the due date indicates when the activity should be completed. 

5. The visibility toggle and icon indicate the status of units, lessons, and materials: Visible (
 icon) or Hidden (  icon). Visibility status is also indicated by icons in the table of 

contents next to each unit. To change the visibility of a unit, lesson, or material, select the 
item and then click the visibility toggle at the top of the page. 

6. Create New and Add Existing display full-screen pages with options for creating new 
materials, adding a new lesson, or inserting existing materials. For more information, see 
Create new material. 

7. (...) Options menu and select Edit for a unit, lesson, or folder, you can update its title, 
availability and due dates, and description. When you click the (...) Options menu and 
select Edit for materials, you can update their titles, properties, and dates. 
The (...) Options menu also allows you to view standards that align to a unit, lesson, or 
material; make units, lessons, and materials visible to or hidden from learners; organize 
materials using move and reorder features; and delete units, lessons, and materials. 
When you select course material in courses with Activity Feed on their homepage, the 
option to Post to Course Homepage is also available. Move to lets you move lessons, 
folders, and materials to a different unit. Reorder lets you organize lessons and materials 
within a unit. You can also use the drag and drop functionality in the table of contents to 
perform these actions. The selected tile displays handles indicating you can drag-and-
drop the tile to rearrange it in the table of contents. 

Create a new unit 
To create a new unit 

1. From a course with Lessons enabled, on the navbar, click Content. 
2. Click New Unit. 
3. Enter a Name for the unit. 
4. If desired, enter a Due Date, Description, Start Date, and End Date. 
5. Use the visibility toggle to make the unit visible or hidden from learners on creation. 
6. Click Save. 
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Create material by adding a link 
To supplement your course material with external resources, link out to these resources using a 
web link.  

1. From a course with Lessons enabled, on the navbar, click Content. 
2. Click Create New. 
3. Click WebLink. 
4. Enter the display name in the Name field and the web address in the Link field. 
5. If desired, enter a Due Date, Start Date, and End Date. 
6. Select the Embed on the page (iframe) radio button to embed a secure (https) link in the 

Lessons viewer or select the Open in a new tab radio button. 
7. Click Save. 

Create a new lesson 
To create a new lesson 

1. From a course with Lessons enabled, on the navbar, click Content. 
2. From the table of contents, select a unit. 
3. Click Create New. 
4. Click New Lesson. 
5. Enter a Name for the lesson. 
6. If desired, enter a Due Date, Description, Start Date, and End Date. 
7. Use the visibility toggle to make the lesson visible or hidden from learners on creation. 
8. Click Save. 

What kinds of files can I use with Lessons? 

Extension Notes 

PDF, JPG, JPEG, PNG, 
BMP, GIF, MP4, OGV, 
WEBM, OGG, AAC, FLAC, 
MP3 

Files with these extensions display in the 
embedded viewer in Lessons 

DOC, DOCX, PPT, PPTX, 
PPS, RTF, ODT, ODP, XLS, 
XLSX 

Files with these extensions display in the 
embedded view only if Document Conversion 
Service is turned on for your organization 

Note: All other file types uploaded to Lessons appear as download links for users to view 
outside of Brightspace Learning Environment. 
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Adding individual SCORM objects to Lessons 
After you upload new SCORM solution objects into Content, you can add those objects to 
Lessons. 

1. In Lessons, click Add Existing. 
2. Click SCORM Object. 
3. Select the SCORM you want to add to the Lesson.  
4. Click the ellipses (…) next to the name of the SCORM object for the following additional 

options: 
• Preview 
• Edit Properties: 

• Change the title 
• Change the description 
• Share object with other instructors (dependent on user permissions) 
• Indicate if you want to use external navigation 

• Upload New Version 
• Delete 

5. Click Next to add the selected SCORM object, and do any of the following: 
•  Add a grade item to the object.  

•  Choose the grade calculation method.  
•  Indicate if you want to link to the object with a static link (the current version of the 

object is always used) or dynamic link (the most recently updated version of the 
object is always used).  

•  Choose player options (either use an embedded player or open in a new browser 
window).  

6.  Click Add. 

Bulk Uploading SCORM objects to Lessons 

1. In Lessons, click Add Existing. 
2. Click SCORM Object. 
3. Click Bulk Upload. 
4. Drag and drop files or select Click to Upload. 
5. Click Upload. 
6. Once uploading is complete, click Keep Default Properties for all files or Edit 

properties for all files.  
7. If Edit properties for all files is selected, do the following for each uploaded SCORM 

object: 
a. Change the title. 
b. Change the description. 
c. Share object with other instructors (dependent on user permissions). 
d. Indicate if you want to use external navigation. 

8. Click Next to move to the next SCORM object. 
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See Also: 

• Bulk upload SCORM or xAPI objects to the Content Service (Classic Content Experience) 

Adding learning objects to Lessons 
In Lessons, you can add learning objects from Brightspace Learning Repository (LOR) as 
course materials. A learning object can be a quiz, presentation, image, video, or any other kind 
of document or file you use to create course content and learning materials for online learning. 
To add materials in Lessons, see Create new material. 
Note: This functionality requires that Brightspace Learning Repository is set up in Brightspace 
Learning Environment. 

Create new material 
To create new material 

1. From a course with Lessons enabled, on the navbar, click Content. 
2. Drag and drop locally saved files to the unit, lesson, or folder you want to add the material 

to directly in the navigation area. 
Or,  
From the table of contents, select the unit, lesson, or folder you are adding material to. 

3. Click Create New. 
4. Choose one of the available options: 

• New Lesson > Follow the steps in Create a new lesson. 
• HTML Document > enter a title and use the HTML editor to create your new 

content item > use the visibility toggle to make the HTML document visible or 
hidden from learners on creation > click Save. 

• WebLink > Follow the steps in Create material by adding a link. 
• Assignment > Follow the steps in Create an assignment using the new create and 

edit Assignment experience. 
• Discussion > choose a Forum and Enter a Name and Description, and then click 

Create and Insert. 
• Quiz > enter a Name and Description, and then click Create and Insert. You will 

need to access the Quiz in the Quizzes tool to add questions and edit the settings. 
• Checklist > enter a Name and Description, and then click Create and Insert. 
• Self-Assessments > enter a Name and Description, and then click Create and 

Insert. 
• Surveys > enter a Name and Description, and then click Create and Insert. 

Tip: To clearly indicate where you are adding material to, the top of the Create New menu 
displays breadcrumbs. This also allows you to easily navigate up or down the tree to add 
material at different levels. 
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Note: It is no longer possible to create a new External Tool Activity using the Create New menu. 
Instead, click Add Existing, click External Tool Activity, and then click Create New LTI Link. 

Add Existing material 

1. From a course with Lessons enabled, on the navbar, click Content. 
2. From the table of contents, select the unit, lesson, or folder you are adding material to. 
3. Click Add Existing. 
4. Choose one of the available options: 

• Google Drive > click Continue to Google Drive > Allow> choose an item to add. 
Note: When adding private files from a Google Drive account to Brightspace 
Learning Environment, a notification indicates if the file is private and instructors are 
given the option to change permissions so that anyone with the link can view the 
file. 
Note: Availability dates are not yet available for Google Drive links. 

• OneDrive > click Continue to OneDrive > select your account > enter credentials 
and click Accept > choose an item to add. 
Note: Availability dates are not yet available for OneDrive links. 

• Assignment > select an assignment from the list. 
• Discussion > select a discussion forum > click a discussion topic. 
• Quiz > select a quiz from the list. 
• Checklist > select a checklist from the list. 
• External Tool Activity > select from the tool providers that are in use by your 

institution, or click Create a New LTI Link to register a new LTI link. 
• SCORM/xAPI Object > select a SCORM course package to import into the 

Lessons tool. 
Note: Availability dates are not yet available for SCORM packages. 

• LOR > search or browse for a learning object from Brightspace Learning Repository 
(LOR). A learning object can be a quiz, presentation, image, video, or any other 
kind of document or file you use to create course content and learning materials for 
online learning. 

• Drag and drop a file onto the dialog box or click BROWSE to select a file from your 
computer. 

Tip: To clearly indicate where you are adding material, the top of the Add Existing menu 
displays breadcrumbs. This also allows you to easily navigate up the tree to add material at 
different levels. 
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Using HTML templates in Lessons 
When creating new documents in Lessons, you can add HTML templates to bring a more 
consistent feel to your course content. 

1.  From Lessons, select a unit, lesson, or folder.  
2.  Click Create New.  
3.  Click HTML Document.  
4.  Click Select Template.  
5.  Select a template from the list or click Browse for a Template.  
6.  If browsing for a template, select an existing template from your Course Offering Files.  
7.  Click Add, and begin inserting your materials into the template.  

Arrange materials 
To arrange materials 
Units, lessons, and materials can all be rearranged by dragging and dropping them to the 
desired position. You can also open the options menu and select Move or Reorder. 

1. From the content area's table of contents, click and hold a collapsed unit, lesson, or 
material. 

2. Drag it to the desired position and release your click. 

OR 

1. From the content area, select a unit, lesson, or material. 
2. From the (...) Options menu, select Move to or Reorder. 
3. Use the arrow keys on your keyboard to set the new location of the unit, lesson, or 

material. 

Note: When moving Units and Lessons, the number assigned is automatically updated (e.g. Unit 
2 becomes Unit 4 if it is moved into that position). 

Edit materials 

1. From the table of contents, select a unit, lesson, or material. 
2. Click the (...) Options menu and select Edit. 
3. Update the item. 
4. Click Save. 
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Linking to materials in Lessons 
When browsing in Lessons, a unique URL is assigned to each unit, module, topic, and lesson. 
This allows instructors to link to a specific location in Lessons without learners having to 
navigate to the item manually. 
When creating a new HTML document, you can insert a link to a specific location in Lessons 
using the HTML toolbar. 

1. In Lessons, click Create New. 
2. Click HTML Document. 
3. From the toolbar, click Insert Quicklink. 
4. Click Content. 
5. Find and select the material to create a link to, and then click Save 
6. Click Save. 

Post materials to a course homepage 
Your course homepage must include an Activity Feed for materials posted in this manner to 
display. 

1. Select a content item from the table of contents. 
2. Click the (...) Options menu and select Post to Course Homepage. 
3. Enter instructions for learners. 
4. Click Post. 

Publish course content to Brightspace Learning Repository 
In Lessons, you can select course content (unit, lesson, or material) you added and publish it to 
Brightspace Learning Repository (LOR). This allows you to store, manage, and share the course 
content as learning objects. 
If you added learning objects to Lessons, you can also edit and publish the updated objects 
back to LOR. 
Note: This functionality requires that Brightspace Learning Repository is set up in Brightspace 
Learning Environment. 

1. In Lessons, select a unit, lesson, or material. 
2. Click the (...) Options menu and select Publish to LOR. 
3. Do one of the following: 

• To publish to an existing repository, select Pick a Repository. From the drop-down 
list, select a repository.  

• To overwrite an existing learning object, select Overwrite an existing object. Click 
Search. Locate the repository you want to overwrite. To have your learning object 
inherit the previous object's metadata, clear the Replace existing object's 
metadata check box.  
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4. Click Sharing and Publishing Options. Do any of the following: 
• To include all original files in your new learning object, select Include all files from 

this course. 
• To leave the page while your package is being built, select Publish in the 

background. 
• To hide the learning object from searches, select Hide learning object in search 

results. 
• To associate the learning object with Creative Commons rights, select Creative 

Commons licensed. From the drop-down list, select your modifications preference. 
Creative Commons licensing enables you to retain copyright on your work while 
allowing different degrees of reuse to other users. Associating a creative commons 
license automatically populates the metadata rights fields with this information. 

5. In the Content area, clear the check box for any item you do not want to include in the 
package. Clearing a module clears all its associated topics and sub-modules. 

6. Click Next. 
7.  If all required files were not automatically detected, click Add Files or Add Folders to 

manually add those files or folders. 
8. Click Next.  
9. On the Metadata page, to classify your learning object, click Classifications. From the 

Classification Schema drop-down list, select a schema. Click Select. Click the Add icon 
for any classification you want to add. Click Save. 

10. In the Description field, add a description of the content of the learning object.  
11. In the Keyword field, add a keyword or phrase describing the topic of this learning object. 

This data element should not be used for characteristics that can be described by other 
data elements. 

12. Click Publish to LOR. 

Present course materials 

1. From the content area, select a piece of material. 
2. Click the fullscreen icon. 
3. Click Exit Fullscreen or press the Esc key on your keyboard to return to the content area. 

Set Release Conditions in Lessons 
To set release conditions in Lessons 

1. Select a unit, lesson, or material. 
2. Click the (...) Options menu and select View Release Conditions. 
3. To create a new release condition, click Create; or click Browse to locate existing release 

conditions. 
4. From the Condition Type menu, select from the available options. 
5. Under Conditions Details, select the appropriate condition, and click Create. 
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6. Confirm the details of the release condition, and click Save. If the unit, lesson, or material 
is visible, a Visible if conditions are met label and  icon display. If the unit, lesson, or 
material, is hidden, a Hidden. Conditions are inactive label and icon display. Clicking 
the conditions link displays the details of the release conditions. 

Add standards coverage to a course 
In Lessons, you can map course materials to learning expectations by importing the appropriate 
expectations from the Achievement Standards Network. 
Note: To import standards, your administrator must enable the Learning Outcomes tool and 
grant you the Manage Outcomes permission. 
To add standards coverage to a course 

1. From Lessons, click Standards. 
2. Click Add or Remove Standards.  
3. Under Filtering Options, choose the Jurisdiction, Subject, Framework, and Education 

Level that apply to the course.  
4. Under Available items, select check boxes for the standards that align to your course. 
5. Click Import Selected Outcomes.  
6. Click X to exit the standards information. 

Locate gaps in standards coverage 
To locate gaps in standards coverage 

1. From Lessons, click Standards. 
2. Select the Display only standards which have no course material check box. 
3. Determine if any units align with standards not linked to course materials. 
4. Close the dialog box and select a unit from the table of contents. 
5. From the (...) Options menu, select View Standards. 
6. Click Edit Standards Alignments and select check boxes to associate material from the 

selected unit to any of the available standards. 
7. Click Save Changes. 
8. Click X to exit the standards information. 

Edit standards alignment for a course 
To edit standards alignment for a course 

1. From the content area, select a unit or item of course material. 
2. From the (...) Options menu, select View Standards. 
3. Click Edit Standards Alignments and select check boxes for the standards that align to 

your content topic. 

http://www.achievementstandards.org/
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4. Click Save Changes. 
5. Click X to exit the standards information for the content topic. 

Set a course timeframe 
To help keep instructors on track with their course materials, pacing (previously known as 
scheduling) suggests when to start teaching different course materials in chronologically 
sequenced content units. When you pace a course, you define a start and end date for pacing 
content units evenly within the specified date range. This can be modified at any time and is only 
visible to instructors (it does not affect when content is available to learners, this is controlled by 
the availability dates). It is useful for keeping to a set schedule and ensuring there is enough 
time to complete all materials in the allotted time. 
The default date range is determined by the start and end date of the course. If no start and end 
date is set for the course, the start and end date of the semester is used.  

1. From the content area, click the Course options menu and select Pace Course. 
2. Set pacing dates. To turn off pacing dates, click X. 
3. Click Save. 

  
Note: Pacing in an existing course does not copy over to a new course (it turns off in the new 
course). 
Note: When availability and due dates are enabled in a course, pacing options and dates are 
hidden. 

Schedule posts to appear in your Activity Feed 
Your course homepage must include an Activity Feed Service for materials posted in this 
manner to display. 
1. Select a content item from the table of contents. 
2. Click the (...) Options menu and select Post to Course Homepage. 
3. Click Post Later, and enter a future date and time. 
4. Click Save and then Post. 
Note: A clock icon displays in the Table of Contents next to any content items that are 
scheduled in this manner, if the item is not hidden from students. Scheduled posts associated 
with Lessons material can be edited in Lessons, or from the Activity Feed on your course 
homepage. 
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Push assignments to Activity Feed 
Your course homepage must include an Activity Feed for materials posted in this manner to 
display. 
1. Select an assignment from the table of contents. 
2. Click the (...) Options menu and select Post to Course Homepage. 
3. Enter instructions for learners. 
4. Click Post. 

ReadSpeaker integrations for Lessons 
The Lessons tool supports the following ReadSpeaker integrations: 

• The ReadSpeaker HTML content integration solution automatically enables ReadSpeaker 
online text-to-speech technology for HTML content in the Lessons tool. Any learner can 
hear their HTML course content spoken aloud or download it as an MP3 using their 
internet browser. Learners can also highlight and play back a subset of the content. 

• The ReadSpeaker docReader integration provides audio rendering of supported 
document types in the Lessons tool. 

To enable the ReadSpeaker integrations: 

1. Contact ReadSpeaker to purchase licensing and obtain integration keys. 
2. Implement the ReadSpeaker integrations in your Brightspace instance, as described in 

the ReadSpeaker docReader and ReadSpeaker for HTML content topics. 
3. In Lessons, click the Listen ReadSpeaker icon to launch the ReadSpeaker integration. 

Create a custom learning path in a course 
Release conditions allow you to create a custom learning path through the materials in your 
course. When you attach a release condition to an item, users cannot see that item until they 
meet the associated condition. For example, you could attach a release condition to the second 
topic in your course’s content area that would hide that topic until users viewed the topic before 
it. Or you could create a condition that required users to view a content topic before gaining 
access to a quiz, or one that required them to post to a discussion topic before they could see a 
content module. 
If you attach multiple conditions to an item, users must meet all conditions before they can 
access the item. For example, you could require users to visit the first three content topics in a 
unit before gaining access to an associated quiz. 
NOTE Once a user meets a release condition, the condition is cleared for that user and cannot 
be reset. For example, if you attach a release condition to a discussion topic requiring users to 
achieve more than 60% on a quiz before they can access that topic, and one of your participants 

https://www.readspeaker.com/contact-us/
https://documentation.brightspace.com/EN/integrations/readspeaker_docreader/admin/about_readspeaker.htm?tocpath=Administrators%7CIntegrations%7CReadSpeaker%20docReader%7C_____0
https://documentation.brightspace.com/EN/integrations/readspeaker_html/admin/about_readspeaker.htm?tocpath=Administrators%7CIntegrations%7CReadSpeaker%20for%20HTML%C2%A0content%7C_____0
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receives 72% on the quiz but you adjust their grade to 55% they will be able to access the topic 
because they did meet the requirement at some point. 

Access Release Conditions 

1. Navigate to the course item you want to add release conditions to. 
2. From the context menu of the course item, click Edit [course item]. 
3. Do any of the following: 

• To access release conditions for a discussion forum or topic, checklist, assignment, 
grade item, quiz, or survey, click the Restrictions tab. 

• To access release conditions for a custom widget, click the Release Conditions 
tab. 

• To access release conditions for an Announcements item, scroll to the Additional 
Release Conditions area. 

Tools that support release conditions 
You can access release conditions for any of the following course items: 

• Awards 
• Checklist 
• Content modules and topics 
• Custom widgets 
• Discussion forums and topics 
• Assignments 
• Grade items and categories 
• Intelligent Agents 
• Announcements items 
• Quizzes 
• Surveys 

How do release conditions work? 
Release conditions allow you to create a custom learning path through the materials in your 
course. When you attach a release condition to an item, users cannot see that item until they 
meet the associated condition. For example, you could attach a release condition to the second 
topic in your course’s content area that would hide that topic until users viewed the topic before 
it. Or you could create a condition that required users to view a content topic before gaining 
access to a quiz, or one that required them to post to a discussion topic before they could see a 
content module.  
Note: Once users meet an associated condition, a pop-up notification appears to inform the 
user that additional content is now available. 
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Release conditions can also be added to intelligent agents to create email notifications for users. 
For example, you could create an intelligent agent that sends a reminder email to users who 
have not yet completed a required quiz or assignment in the course. This scenario is ideal for 
using release conditions with the "not" operator. 
If you attach multiple conditions to an item, users must meet all conditions before they can 
access the item. For example, you could require users to visit the first three content topics in a 
unit before gaining access to an associated quiz.  
Once a user meets a release condition, the condition is cleared for that user and cannot be 
reset. For example, if you attach a release condition to a discussion topic requiring users to 
achieve more than 60% on a quiz before they can access that topic, and one of your participants 
receives 72% on the quiz but you adjust their grade to 55% they will be able to access the topic 
because they did meet the requirement at some point.  

Best practices for creating release conditions 
To learn best practices for creating release conditions 

• Set up conditions before users access the course - Create all of your course materials 
and set up your release conditions before the course opens to users. This gives you a 
chance to check for mistakes in the conditions or for circular, contradictory, or 
unnecessary conditions. If you add new release conditions after users have accessed the 
course, users might be confused by resources disappearing. Since conditions cannot be 
reset, you also risk having users meet conditions before your resources are ready (for 
example, accessing a content topic before it is finished). 

• Avoid unnecessary conditions - Each condition you associate with a tool takes 
additional time for Brightspace Learning Environment to process. Using as few conditions 
as possible to set up a learning path minimizes the amount of time that users spend 
waiting for pages to load. For example, you set up a content topic, a quiz, and an 
assignment for the second week of class. You want users to read the topic before taking 
the quiz, and you want them to read the topic and attempt the quiz before submitting the 
week’s work to the assignment. For the assignment, you only need to attach the condition 
that users attempt the quiz. Since users must read the content topic before they can take 
the quiz, it is not necessary to add this condition to the assignment. 

• Avoid circular references - A circular reference makes it impossible for users to satisfy a 
set of conditions. For example, if you set the condition that users must view a content 
topic before they can access an assignment, and then set a condition that they must 
submit a file to the assignment before they can access the content topic, you have a 
circular reference. Users can’t satisfy either condition without satisfying the other one first. 
Circular references are more likely to occur with long chains of conditions. For example, a 
content topic that depends on a quiz that depends on an assignment that depends on a 
checklist that depends on the content topic. 

• Avoid impossible conditions - Ensure that your conditions are not impossible for users 
to satisfy. For example, a condition that users must achieve greater than 100% on a grade 
item would be impossible (unless the grade item is set to Can Exceed). If users are 
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unable to satisfy a condition, they are unable to access the content or tools to which the 
condition is attached. 

• Avoid contradictory conditions - Contradictory conditions occur when two or more 
conditions that cancel each other out are associated with an item. For example, the 
conditions User must achieve greater than 49.9% on Grade Item 1 and User must achieve 
less than 50% on Grade Item 1 are contradictory. Users cannot satisfy both conditions at 
the same time; they would not be able to see the item associated with these conditions. 

• Release content based on learning ability and course performance - Include 
additional content in your course specifically for users who need extra help and release 
this content to users who score below a specified threshold on a quiz or grade item. 
Alternately, release a special survey to users who attain a high score. 

• Release content in stages - To reveal content topics to users only after they have read 
prior content, attach release conditions on the subsequent topics or modules that require 
users to view earlier topics. This can provide a clear path through the material and prevent 
users from becoming overwhelmed by a large table of contents at the start of the course. 

• Release content based on enrollment date - If your course has rolling enrollment, you 
can set course materials and assessments to become available relative to a users' 
enrollment date. This allows you to provide a structured path through the course for every 
user regardless of their enrollment date. 

• Customize content for groups within a course - If your course has group projects and 
you want to provide different instructions or resources for each group, you can create 
separate content topics or modules for each project and attach release conditions based 
on group enrollment. Group members working on one project will see content related to 
their work without being distracted by content not relevant to them. 

• Use a checklist to organize activities - You can create a checklist that lists the activities 
users should complete throughout the course. For example, a checklist for the first week 
might include reading the course’s introductory content, posting to an introductory 
discussion topic, and submitting a list of learning goals to assignment. You can set 
release conditions based on users checking off items from their checklist. For example, 
you might release an Announcements item on your course’s homepage once users check 
off that they have completed the first week’s activities. 

• Use intelligent agents to monitor user activity or non-activity - You can set up 
intelligent agents with release conditions using the not operator to intervene with students 
who have not completed course work. For example, create an intelligent agent that sends 
a reminder email to users who have not yet completed a quiz attempt or submitted an 
assignment to an assignment.  

Release condition types 

Condition 
Type 

Description 

Awards - 
Awards 

The user must have earned a specific award in order to fulfill the release condition 
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Condition 
Type 

Description 

Checklist - 
Completed 
checklist  

The user must complete all items on the selected checklist in order to fulfill the 
release condition 

Checklist - 
Incomplete 
checklist 

The user must not complete one or more items on the selected checklist in order 
to fulfill the release condition 

Checklist - 
Completed 
checklist item 

The user must complete a specific item on the selected checklist in order to fulfill 
the release condition 

Checklist - 
Incomplete 
checklist item 

The user must not complete the specific item on the selected checklist to fulfill the 
release condition  

Classlist - 
Group 
enrollment 

The user must be enrolled in a specific group in order to fulfill the release 
condition 

Classlist - Org 
unit enrollment 

The user must be enrolled in a specific org unit in order to fulfill the release 
condition 

Classlist - 
Section 
enrollment 

The user must be enrolled in a specific section in order to fulfill the release 
condition 

Classlist - Role 
in current org 
unit 

The user must either: 

• be enrolled as a specific role 
• not be enrolled as a specific role 

in order to fulfill the release condition 

Classlist - Date 
of enrollment in 
current org unit 

The user must be enrolled in the current org unit for a specified number of days in 
order to fulfill the release condition 

Competencies - 
Competency 
achieved 

The user must complete a specific competency in order to fulfill the release 
condition 
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Condition 
Type 

Description 

Competencies - 
Competency 
not yet 
achieved 

The user must not complete a specific competency in order to fulfill the release 
condition 

Competencies - 
Learning 
objective 
achieved 

The user must complete a specific learning objective in order to fulfill the release 
condition 

Competencies - 
Learning 
objective not 
yet achieved 

The user must not complete a specific learning objective in order to fulfill the 
release conditions 

Competencies - 
Score on 
associated 
rubric 

The user must achieve a specified Score and Threshold level on a learning 
objective, based on an associated rubric, in order to fulfill the release condition 

Content - 
visited content 
topic 

The user must visit a specific content topic in order to fulfill the release condition 

Content - Not 
visited content 
topic 

The user must not visit the specified content topic in order to fulfill the release 
condition. Depending on your organization's security configurations, especially if 
the d2l.Tools.ManageFiles.UseContentRestrictedSecurity configuration 
variable is set to ON, users may not be able to access specified content topics at 
all when this release condition is set 

Content - 
Visited all 
content topics 

The user must visit all content topics in the course offering in order to fulfill the 
release condition 

Content - 
Completed 
content topic 

The user completes a content topic. The method of completing the topic depends 
on the type, such as viewing a file or submitting an assignment. 
This release condition ignores exemptions, meaning that if the learner completes 
the activity, the release condition can be met, regardless of the activity being 
required, optional, or exempt. 
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Condition 
Type 

Description 

Discussions - 
Posts authored 
in topic 

The user must author a specified number and type of posts in a designated 
module or topic in order to fulfill the release condition 

Discussions - 
No posts 
authored in 
topic 

The user must not author any number or type of post in a designated module or 
topic in order to fulfill the release condition  

Discussions - 
Score on 
associated 
rubric 

The user must achieve a specified Score and Threshold level on a discussion 
module or topic, based on an associated rubric, in order to fulfill the release 
condition 

Assignments - 
Submission to 
Assignment 

The user must make a submission to a specified assignment in order to fulfill the 
release condition 

Assignments - 
No submission 
to Assignment  

The user must not make a submission to a specified assignment in order to fulfill 
the release condition 

Assignments - 
Receive 
feedback on 
Assignment 
submission 

The user must receive feedback on a submission to a specified assignment in 
order to fulfill the release condition 

Assignments - 
Score on 
associated 
rubric 

The user must achieve a specified Score and Threshold level on an assignment 
submission, based on an associated rubric, in order to fulfill the release condition 

Grades - Grade 
value on a 
grade item 

The user must achieve a specified grade value on a grade item in order to fulfill 
the release condition 

Grades - No 
grade received 

The user must not receive a specified grade value on a grade item in order to fulfill 
the release condition 

Grades - 
Released final 
grade score 

The user must have their final grade score set to released, or set to released plus 
the final grade meeting a defined threshold, in order to fulfill the release condition.  
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Condition 
Type 

Description 

Note: This release condition is evaluated beginning from the first time the grade is 
released, and cannot be revoked once it is fulfilled. Therefore, if your grade book 
is set up to release final grades throughout a course, and/or drop ungraded items, 
the release condition may be fulfilled sooner than expected (i.e. before the end of 
the course). D2L recommends using this release condition in combination with 
other release conditions or intelligent agents to ensure that the event or content 
triggered by the released final grade score occurs at the anticipated time.  

Grades - Score 
on associated 
rubric 

The user must achieve a specified Score and Threshold level on a grade item, 
based on an associated rubric, in order to fulfill the release condition 

Quizzes - Score 
on a quiz 

The user must achieve a specified score on a quiz in order to fulfill the release 
condition. Score on a quiz is triggered by publishing a score on a quiz attempt or 
manually overriding a quiz score via Grades.  

Quizzes - 
Completed quiz 
attempt 

The user must achieve a specified number of attempts of a quiz in order to fulfill 
the release condition 

Quizzes - Score 
on selected 
questions 

When a quiz has a learning objective with associated questions and an 
assessment method attached to it, the user must achieve a specified grade value 
on the learning objective in order to fulfill the release condition 

Quizzes - Score 
on associated 
rubric 

The user must achieve a specified Score and Threshold level on a quiz, based on 
an associated rubric, in order to fulfill the release condition 

Quizzes - No 
completed quiz 
attempt 

The user must not complete any attempt on a quiz in order to fulfill the release 
condition 

Surveys - 
Completed 
survey attempt 

The user must achieve a specified number of attempts of a survey in order to fulfill 
the release condition 

Surveys - No 
completed 
survey attempt 

The user must not complete any attempt on a survey in order to fulfill the release 
condition 
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Administer a course 
Instructors can administer a course with the following tools: 

• Organize and manage week-specific course items with the Checklist tool 
• Set the calendar status of all course objects with the Manage Dates tool 
• Manage course events with the Calendar tool 
• Track attendance for activities in a course with the Attendance tool 

About course administration 
The Course Administration area is a central area for accessing tools related to setting up and 
managing your course. From the Course Administration area, you can access many tools to 
help you run your course smoothly. Some of the tasks you can accomplish include: 

• Editing course colors 
• Enabling and disabling course tools 
• Renaming course tools 
• Managing course offering information 
• Importing course components 
• Import learning outcomes 

Note: Course Administration is now the central location to manage learning outcomes. Learning 
Outcomes continue to appear in New Content Experience (Lessons), and any learning outcome 
you import in one location is reflected in the other. 

About course colors 
You can enhance the appearance of your course and help users identify your course more 
easily by modifying the colors used in the interface. Brightspace Learning Environment uses 
three color settings to render the areas within a course. 

Color Description 

Dark 
Color 

Used for the title bar, widgets, and pop-ups. White text is shown against this color. 

Light 
Color 

No longer used in most areas. D2L recommends you use the same color as the 
Dark Color. White text is shown against this color. 

Soft 
Color 

Used for tabs. Black text is shown against this color. 
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About course locale 
If your organization supports multiple locales, you can change the default locale used for your 
course offering. Normally users can specify their own locale within their preferences. You also 
have the ability to override locale preferences so that all users see the same locale in your 
course. You might use this if you are teaching a language immersion course and want all the 
cultural formatting and text in the course offering to reflect the language you are teaching. 

Change the status of a tool 
Course tools, such as Quizzes, Content, Discussions, Chat, Grades, and so on, are course 
components that you add to your course offering to share learning content, foster interaction, 
and evaluate performance. You can enable and disable course tools to specifically tailor your 
course to your pedagogy and course materials. 
Before enabling a tool, be aware of the following: 

• Some activated tools can only be accessed from the navbar or home page widgets.  

Before disabling a tool, be aware of the following:  

• Release conditions based on the tool are not enforced as long as the tool remains 
disabled.  

• Competency activities associated with the tool are hidden, but are still associated with any 
learning objectives to which they are attached. Users cannot complete these learning 
objectives while the tool is disabled. You should detach or delete any activities associated 
with a tool before disabling the tool.  

• Grade items associated with the tool remain, but you must manually update them in the 
grade book.  

• Quicklinks to the tool’s items persist but a “No Resource Found” message displays when 
they are followed. You should remove any related quicklinks when you deactivate a tool.  

• Deactivating a tool does not delete any items or user data inside the tool; it simply hides 
the tool from your course offering.  

1. On the navbar, click Course Admin. 
2. Click Tools. 
3. Do one of the following: 

• To enable a tool, toggle its status to  On. 
• To disable a tool, toggle its status to  Off. 

Activate a course offering 

1. On the course home page, click Course Admin > Course Offering Information. 
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2. Select the Course is active check box. 
Tip: You can deactivate a course offering to hide it from learners without actually deleting 
it. This way the content (including user data) can be kept for future use. 

3. Click Save. 

About course activation and course Start and End Dates 
When a course is active it becomes accessible to learners in the My Courses widget, and in the 
Select a Course menu. If no Start Date and End Date are set in the Course Offering 
Information the course is immediately available for learners to access. 
If a Start Date is set for any date after the activation occurs, when the start date is reached the 
course becomes visible to learners in the My Courses widget, and in the Select a Course 
menu. This is dependent on the configuration variable settings in use at your organization. 
When a course’s End Date is reached and the course is still active, the course is no longer 
visible to learners in the My Courses widget, and in the Select a Course menu. This is 
dependent on the configuration variable settings in use at your organization. 
Important Note: If a Start Date and End Date are set but the instructor does not select the 
Course is active check box, the course does not become accessible to learners on the selected 
Start Date. The course must be activated using the Course is active check box on the Course 
Offering Information page. 

Deactivate a course offering 
You can deactivate a course offering to hide it from users without actually deleting it. This way 
the content (including user data) can be kept for future use. 

1. From the Admin Tools menu, click Course Management. 
2. Search for the course offering's name. 
3. Click the course offering you want to deactivate. 
4. On the navbar, click Course Admin > Course Offering Information. 
5. Clear the Course is active check box. 
6. Click Save. 

Course Admin offering information 
You can edit the properties of your course offering, including course colors and course locale, 
on the Course Offering Information page.  

1. On the navbar, click Course Admin. 
2. Click Course Offering Information. 
3. Make your changes. 
4. Click Save. 



 

138 
© 2022 D2L Corporation. All rights reserved. 

Rename a tool 
You may want to rename a tool if your organization or geographic area is more familiar with 
different terminology. For example, you could rename Assignments to Assignment. 
Changing the custom navbar name for a tool does not replace all uses of the original term 
throughout the system. It only changes the display name for the tool on the navbar. To replace 
all references to a specific term, a site administrator can update your organization’s language 
pack using the Manage Languages tool.  

1. On the navbar, click Course Admin. 
2. Click Tools. 
3. In the Custom Navbar Name field for the tool that you want to rename, enter the new tool 

name. 
4. Press Enter or click outside the field. Your changes save automatically. 

Search for courses 
The Search for courses field only appears if you have been enrolled in the number of courses 
specified in the d2l.Tools.Homepages.MaxCourses ( Org ) configuration variable. The default 
setting for this configuration variable is 25. 

1. On the Course Updater page, in the Search for courses field, enter a value. 
2. To add parameters to your search, click Show Advanced Filters. 
3. Do any of the following: 

• To search for courses by department, in the Department drop-down list, select a 
department. 

• To search for courses by semester, in the Semester drop-down list, select a 
semester. 

• To search for courses by status, in the Active drop-down list, select active or 
inactive. 

• To search by start date, in the Course Start drop-down list, select an option. In the 
filter fields, enter dates. 

• To search by end date, in the Course End drop-down list, select an option. In the 
filter fields, enter dates. 

4. Click the Search icon. 

Add a link to Brightspace Help to your navbar 
You can add a link to the Brightspace help site to your course’s navbar. The link opens 
Brightspace Help in a new window. 

1. From the Admin Tools menu, select Navigation and Themes. 
2. Click the link for the navbar you want to add the help link to. 
3. On the Edit Navbar page, in the Links area, click Add Links. 
4. In the Add Links dialog window, select the Brightspace Help check box. 
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5. Click Add, and then Save and Close. 
6. On the navbar, click the Brightspace Help link. A new browser window opens to the 

welcome page of the Brightspace Help site. 

Import standards for a course 
From the Course Administration Learning Outcomes management page, an option is available 
to import program outcomes created by administrators at the Organization level. When the 
instructor selects the program, a list of outcomes for that program appears. If program outcomes 
have not been created for a course, an instructor can import learning outcomes from the 
Achievement Standards Network (ASN), or create custom learning outcomes, which enables 
you to control the wording of outcomes used within your institution. 
Note: The language term used to describe learning outcomes depends on the value set for the 
d2l.Languages.Terminology.LearningOutcomes configuration variable. For example, the 
Standards link in Course Administration might be labeled Competencies, Expectations, 
Objectives, or Learning Outcomes. 
To import course outcomes 

1. From within a course, click Course Admin on the navbar. 
2. Under Assessment, click Standards. 
3. Do one of the following: 

• Click Import from Program. Select a standard from the list. This list will not appear 
if the list was not previously created for the program.  

• Click Import from Achievement Standard Network. 
• Click Add Learning Outcome to create a custom learning outcome.  

4. Click Save. 

Managing course components 

About copying course components between org units 
The copy components utility lets you copy quizzes, content, grade items, discussion forums, 
Assignments folders, courses with S3 model configurations, and nearly every other type of 
component from another course offering or a course offering’s parent template. Copying 
components saves you from having to recreate your course's resources and can significantly 
reduce the amount of work required to create or re-offer a course.  
You can use the copy components feature to:  

• Reuse components created in a previous course offering.  
• Add components created by your peers into your own course offering.  
• Set up standard components inside a course template and copy them into a new course 

offering each time a course is re-offered. 
• Copy courses with S3 model configurations 
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• Include the selected course as an additional historic course 

Requirements 
To copy components between course offerings: 

• Depending on your role in your organization, you require one or both of the following 
course copy permissions: Copy Components into Org Unit or Copy Components out 
of Org Unit.  
These two separate permissions offer granular control over copying course components 
and enable workflows associated with parent content (in a course offering or parent 
template org unit).  
For example, an organization has a Science Course that is intended as a course that 
instructors can copy from, but not modify. Instructors can copy common course 
components in Science Course to other science courses, for example, Science 101 and 
Science 202. 
Jane has two roles: Reviewer role in Science Course, and Instructor role in Science 
101 and Science 202. 
The Reviewer role has the Copy Components out of Org Unit permission, but not the 
Copy Components into Org Unit permission. 
The Instructor role has the Copy Components into Org Unit permission, but not the 
Copy Components out of Org Unit permission. 
In Science Course, Jane cannot see the option to Copy Course Components in 
Content or Course Admin. She cannot copy any components into the Science Course. 
In Science 101, Jane can see the options to Copy Course Components. When she 
searches for courses to copy, she can see Science Course; however, she cannot see 
Science 202. 
Note: These permissions also affect the Copy From Parent Template option in Copy 
Course Components. This option is only visible if the instructor is enrolled in the parent 
template with a role that has the Copy Components out of Org Unit permission at the 
template level. 

• You must be enrolled in both offerings.  
• You need to be enrolled in and have access to the parent template to copy components 

from the parent into a course offering. Note that all copied intelligent agents are disabled 
by default, unless your administrator has disabled the 
d2l.Tools.IntelligentAgents.DisableAgentsOnCopy configuration variable. 

• To copy courses with S3 model configurations, you must enable the Student Success 
System at the instance and org level. 

You can also copy components into a course template, and you can create standard 
components within a template and then copy them into the template’s associated course 
offerings. 
A validation logic step is also included in the copy process. To help reduce duplicate objects and 
cleanup from the copy process, the validation logic informs you if you have previously copied 
from the source course. 
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Common concerns 
The following table addresses some common concerns around copying course components 
between org units: 

Concern Answer 

Overwriting 
and 
duplicating 
content  

The only components you might overwrite are course files. Course files are 
overwritten if one of the files being copied has the same name as an existing 
file. No other components are overwritten.  
For example, if you have three checklists in your current course offering, and 
copy two checklists from another offering, you will now have a total of five 
checklists in the current offering. This is true even if the components are 
identical. If you are copying components from the same source multiple times, 
be careful not to copy the same items more than once or you will create 
duplicates. 

User privacy 
might be 
compromised 
when copying 
course 
components 

User data is not copied. For example, if you copy the discussions component, 
only the forums and topics are copied, not the posts inside the topics. 
Similarly, if you copy Assignments folders or quizzes, user submissions and 
quiz attempts are not copied.  

Links and 
associations 
between 
components  

D2L recommends that you copy all components between courses to ensure 
you maintain all desired associations, and then delete any undesired material 
in the new course.  
If you are copying linked or associated components, you must copy all of the 
related components at the same time. For example, if a discussion topic has 
release conditions based on the results of a quiz, you must copy all three 
components—discussions, quizzes, and release conditions—at the same time. 
Similarly, if you have a quiz that is associated with a grade item, be sure to 
copy both the quiz and the grade item at the same time. As long as the 
associated components are copied together, links between them are retained.  
To copy release conditions, you must select the Release Conditions 
component.  

Special considerations when copying course components 
When you are copying course components, ensure that you have considered the following 
implications or associated tasks. 

Component Notes 
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Competencies Competencies, learning objectives, and associated activities are copied.  

Content Does not include files or content display settings; you must select these as 
separate components. Be sure to copy all course files used in the course as 
well as the content topics or only the content topic structure is copied.  

Checklist Due dates for checklist items are not changed when you copy them. 

Groups and 
Sections 

The new course does not automatically enroll groups and sections. You must 
enroll users yourself.  

Navbars If you have modified the names of any tools, you must also copy the tool 
names. 

Release 
Conditions 

Only release conditions that reference or are attached to other components are 
copied at the same time as the component. For example, if a quiz has a 
release condition that refers to a content topic, the release note is only copied 
if both the quiz and the content topic are copied at the same time. If you copy 
release conditions without selecting any other component, there is no action. 

Components for Import/Export/Copy 
The following table displays which components from Brightspace Learning Environment can be 
imported, exported, or copied between courses. 

Component Copy Import Export 
Announcements    
Assignments    
Attendance Registers    

Awards    
Calendar Events    
Chats    
Checklists    
Competencies    
Content    
Content Display Settings    
Content Metadata    
Course Files    
Course Appearance    
Discussions    
External Links    
FAQs    
Forms    
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Glossary    
Grade Settings    
Grades    
Groups    
Homepages    
Learning Outcomes  Partial. Import 

available for 
ASN outcomes but 
not locally 
authored or 
program authored 
outcomes. 

Partial. Export 
available for 
ASN outcomes but 
not locally 
authored or 
program authored 
outcomes 

Intelligent Agents    
Links    
LTI Links    
LTI TPs    
Navbars    
Question Library    
Quizzes    
Release Conditions    
Rubrics    
Rubric Associations    
Self Assessments    
Surveys    
Tool Names    
Widgets    

Copy course components 
Your ability to copy course components between course offerings is determined by assigned 
permissions and enrollment in course offerings and parent templates. Before you start, review 
About copying course components between org units. 
To copy course components 
In order to mitigate the risk that large courses may result in timeout failures for users, the Copy 
Course components job functions as an asynchronous job. You can view the progress of the 
copying job by clicking the View History link. 

1. In the course offering that you want to copy components into, on the navbar, click Course 
Admin > Import/Export/Copy Components. 

2. Do one of the following: 
• Select Copy Components from another Org Unit. Click Search for offering and 

locate the course offering containing the components you want to copy. Click Add 
Selected. 
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• Select Copy Components from Parent Template to copy components from the 
course template the current course offering belongs to.  

3. Do one of the following:  
• To copy all course components, click Copy All Components. D2L recommends 

that you copy all components between courses to ensure you maintain all desired 
associations, and then delete any undesired material in the new course.  

• To specify the components you want to copy, click Select Components. Select 
your components. To see details for course components, click the Show the 
current course components link, then click the View Detail icon beside a 
component to see existing items. For those course components that provide the 
option to include associated files, D2L recommends leaving the option turned on. 
Click Continue. 

• Select the Offset all dates of copied components check box and specify the days 
and hours that the dates should be offset by or calculate the range between two 
dates. 

• Click Finish. 
Note: If you encounter issues with the Include associated files option and want to 
remove it, contact D2L Support to ask them to turn off the 
D2L.LE.Conversion.Features.ICopyAssociatedFilesFeature feature toggle. 

4. Do one of the following: 
• To copy another package, click Copy Another Package. 
• To see the results of your copy, click View Content. 
• To review and manage course dates, click Review and Manage Dates. 

Notes:  

• If you copied a course with S3 model configurations, the course is listed in the Student 
Success System Administration page (Admin Tools > Student Success System).  

• Now when you copy groups to courses, the group setup (grade item, assessment option, 
and so on) is also copied over.  

• A validation logic step is included in the copy process. To help reduce duplicate objects 
and cleanup from the copy process, the validation logic informs you if you have previously 
copied from the source course. 

For information on the Student Success System permissions, refer to the Administering Courses 
– Administrator Guide. 

About importing course components from a file 
You can import components created in other learning management systems, provided by 
content vendors, or created in a content creation program (like Respondus). To import 
components, you must have a file containing the components in a format supported by the 
Import tool.  
You can also import components from Brightspace Learning Repository.  
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Import course components 
To import course components 

1. In the course offering that you want to import components into, on the navbar, click 
Course Admin > Import/Export/Copy Components. 

2. On the Import/Export/Copy Components page, select Import Components. 
3. Click Start. 
4. Select the file you want to import. 
5. Choose whether to Import All Components or Select Components and then follow the 

prompts.  
6. To review and manage course dates, click Review and Manage Dates. 

If you import course components with names that already exist in the course, or you import 
multiple components with the same name, duplicate names appear; they are not overwritten. 
For example, if your course contains a discussion topic called Exam Review and you import a 
course package that contains a discussion topic called Exam Review, your course will contain 
two topics called Exam Review. 
Note: When importing a course, if you previously had text in the quiz Introduction field, this text 
is automatically appended to the quiz Description field.  

Course import compatibility 
The following table provides a list of learning management systems (LMS) and content providers 
that you can import course content from. It is recommended that you work with your site 
administrator or D2L Client Sales Executive when importing content from another LMS. 

Component IMS CP QTI 

Blackboard 6.0 1.1.2 1.2.1 

Blackboard 6.1.5/6.2/6.3 1.1.3 1.2.1 

Blackboard 7 1.1.3 1.2.1 

Blackboard 8 1.1.2 1.2.1 

Blackboard 9 1.1.2 1.2.1 

Common Cartridge® 1.0 1.1.3 1.2.1 

Common Cartridge 1.1 1.2 1.2.1 

Common Cartridge 1.2 1.2 1.2.1 

Common Cartridge 1.3 (and ThinCC1.3) 1.2 1.2.1 
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Component IMS CP QTI 

Desire2Learn 8.x 1.1.3 1.2.1 

Respondus 2.0 N/A 1.2.1 

Respondus 3.x N/A 1.2.1 

Sakai Archive 1.1 1.2.1 

SCORM® 1.2 1.1.2 N/A 

SCORM 1.3 (2004) 1.1.3 N/A 

WebCT® CMU 1.x 1.1.2 1.2.1 

WebCT CMU 2.0 1.1.3 1.2.1 

 
You can convert packages into importable D2L-formatted packages using separate conversion 
tools. Work with your D2L Client Sales Executive to discuss converting and importing from the 
following systems: 

• ANGEL 7.3/7.4/8 
• Blackboard CE 6 (WebCT CE 6) 
• Blackboard CE 8 (WebCT CE 8) 
• Blackboard Vista 4 (Blackboard Vista 4) 
• Blackboard Vista 8 (Blackboard Vista 8) 
• eCollege 
• Moodle™ 1.9 
• Moodle 2.0/3.0 
• uCompass 

Converting Moodle Lessons 
Using the Import/Export/Copy Course Components tool in Brightspace Learning Environment, 
you can edit an existing course and upload an unconverted Moodle Lessons course package. 
During the course conversion process, entries from the IMSManifest.xml file are converted and 
imported into the Content tool as topics and files, placed into a content module named Imported 
Lessons. Each topic displays a Lesson: prefix to indicate that the topic is a converted Moodle 
Lesson. 
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View Course Import history 
Users can view the history of course import attempts for courses in a specific org unit. From the 
Import/Export/Copy tool on Course Admin, users can view the Course Import History page, 
which includes the following information for each course import attempt: 

• the original package name 
• status of the import 
• user who created the import job 
• the timestamp for the import attempt 

To view the Course Import History 

1. In Course Admin, click Import/Export/Copy Components. 
2. On the Import section of the page, click View Import History.  

 
Figure: The View Import History option enables you to view import logs for specific 
components. 

3. From the list, click View Import Log for the package you want to view. 
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 Figure: The View Import Log is available to view for all components imported into the 
course 

4. The log displays the import results in the order of operations. After reviewing the log, use 
the navigation breadcrumbs to navigate back to the Course Import History page. 

Troubleshooting: Course Conversion 
The following errors might be encountered during course conversion into D2L format. Try these 
troubleshooting steps first, and if they don't work, contact support for a more in-depth 
investigation of the issue. 

Error: Package was not recognized 
A package may not be recognized if: 

• It is not in a course archive format (for example, it is a .ppt or .pdf file instead of a course 
package exported from an LMS). 

• It was exported from a vendor that is not yet supported by D2L. 
• It failed to unzip. 

Package Failed to Unzip  
Symptoms 
When importing a course package, you encounter the message: "The package was not 
recognized". The processing logs indicate "Unpackaging uploaded file" followed by 
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"Unsupported file format". If the package was successfully unzipped, the processing logs would 
indicate "Successfully unpackaged file" instead. 
The processing logs also indicate that the final status of the issue was "NoConversion". You can 
access the processing logs directly on the error page in Course Import by clicking on "View 
Processing Logs". 
Cause 
The following are common causes of this error:  

• The package is not a valid archive file (for example, .zip, .mbz, .imscc, etc. which have 
been exported from an LMS). Verify that the file is an Archive or Compressed Folder file 
type before attempting your course import. The following file types are not valid for 
importing a course: .pdf, .ppt, .docx. If you are trying to add course content, use Content 
Tool - Add Module instead. 

• The course package does not have an imsmanifest.xml at the root level and it may 
instead be located in a sub-folder. 

• The course package contains file paths that are longer than 128 characters, which is a 
Windows limit. 

• An archive file has been corrupted or damaged. 

Resolution 
If you are using an archive file, to verify your course package can be extracted, try to unzip the 
package locally first. Try the following steps to resolve the problem: 

1. Use the built-in operating system extraction program and try to unzip the file on your 
computer. 
 
If you successfully unzipped the package on your local computer, re-zip the file using your 
local operating system zip program or the program you were using. Retry the course 
import with the newly zipped package.  

2. Unzip the package and examine the folder structure to ensure that the imsmanifest.xml 
file is at the root level. If the imsmanifest.xml file is not at the root level move the file to this 
location and re-zip the package and retry the course import. 
  

3. Use WinRAR (http://www.rarlab.com/) to unzip the file on your computer. 
 
Your package may contain file paths longer than 128 characters. In this case, most 
extraction programs on Windows will fail. WinRAR will still extract the files, but will warn 
that files exceeding the maximum path length were truncated. Once the extraction is 
complete, it is recommended that these paths are truncated manually or removed. Then 
re-zip the files and retry the course import. 
  

4. Re-export your course package from the original source. 
 
If neither of the previous troubleshooting steps worked and the extraction still fails, your 
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course package is likely damaged. Re-export the course package from the original LMS 
and retry the course import with a newly exported package. 

Error: Package was not converted  
This error commonly arises due to issues within the course package itself: 

• There may be key files missing (for example, imsmanifest.xml is a typical file expected to 
be among the course package structure). 

• There may be issues with XML in some of the files (for example, the files may have illegal 
characters or unmatched opening and closing brackets). 

Typically, it is recommended to review the processing logs and inspect the specific complaint. 
Then explore the contents of your package to verify that the information is corrected. You can 
also try to re-export the package from the original source. 

Invalid HTML  
Symptoms 
When importing a course package, you encounter the message "The package was not 
converted". The processing logs may indicate that an invalid or unexpected character has been 
encountered. 
The processing logs also indicate that the final status of the issue was "ProcessingFailed". To 
access the processing logs directly on the error page in Course Import, click View Processing 
Logs. 
Cause 
Invalid XML can often cause conversions to fail. Sometimes the error directly names the exact 
file that is causing the problem. If it is not explicitly stated, try the main imsmanifest.xml file. If 
the manifest is improperly formed, serious issues may occur. 
Resolution 
To verify that an XML file is valid: 

1. Open the file in Google Chrome. If the XML is valid, it should render correctly; if not, the 
page will remain blank or report an error. 

2. Use an online XML validator like: http://www.xmlvalidation.com/ 
3. If the XML is invalid, correct the XML, re-zip the package and retry importing your course 

package. 
4.  the XML is valid, the issue with your package is likely in the structure of the package (for 

example, missing key files). In this case, re-export the package from the original source 
and retry importing your course package. 
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Error: Conversion Service is Temporarily Unavailable 
If the Conversion Service is not available, it may relate to temporary issues that are being 
monitored by D2L support and will be resolved shortly. However, if you repeatedly see this error 
message, it may be worth verifying that the Conversion Service URL is properly configured. This 
can only be done by a D2L support representative. 

About exporting course components 
You can export components from your course offering to a file. This allows you to reuse these 
components in another learning management system, including another Brightspace Learning 
Environment, or to store the components and then re-import them into another course offering or 
template at a later date.  
Components are exported to an IMSCP-compliant zip file, a standard file format based on the 
IMS Content Packaging specification. This means you should be able to reuse these 
components in any learning management system that supports this format.  
You can export course components from the organization level, except for files in the 
organization or shared files areas.  
The following table addresses some common concerns around exporting course components: 

Concern Answer 

User privacy might 
be compromised 
when exporting 
course components 

User data is not copied. For example, if you copy the discussions 
component, only the forums and topics are copied, not the posts inside 
the topics. Similarly, if you copy assignment submissions folders or 
quizzes, user submissions and quiz attempts are not copied.  

Links and 
associations 
between 
components  

Associations between components will not be exported (for example, 
release conditions). The IMS Content Packaging specification, which the 
format for export files is based on, does not support these associations.  

Export course components 
To export course components 

1. In the course offering containing the components you want to copy, on the navbar, click 
Course Admin > Import/Export/Copy Components. 

2. Select one of the following options: 

• Export as Brightspace Package 
• Export as Common Cartridge 
• Export as Thin Common Cartridge 
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3. Click Start. 
4. In the Select Components to Export section, to export all components, select the Select 

All Components check box or select the check box for the particular components you 
want to export. To export only certain items from a component, select the Select 
individual items to export radio button.  

5. Click Continue. 
6. If you chose Select individual items to export for any component in the previous step, 

the Select Items page appears. This page lists all of the items and any sub-items 
contained in the current component. Otherwise, the Confirm Components to Export 
page appears. To view sub-items, click the + Expand icon next to an item. Select the 
individual items and sub-items you want to export and click Next. When you have finished 
selecting individual items from components, the Confirm Components to Export page 
appears.  

7. Click Continue.  
8. The Export started dialog displays to confirm the export is underway. 
9. Click Done. 

10. When the export package is ready for download, a notification is generated and can be 
accessed from the bell icon in the navigation bar. 

11. Click the Export finished notification message. This directs you back to the 
Import/Export/Copy Components tool in your course. 

12. Click the Click here to download the export Zip package link. 

Note: The Bulk Course Export file naming convention now includes the course offering code to 
make files more identifiable. 

What course components can be exported? 

• Announcements 
• Assignments 
• Calendar 
• Checklist 
• Competencies 
• Content 
• Course files 
• Discussions 
• External links 
• FAQ 
• Glossary 
• Grades (except calculated grade items) 
• Navbar templates (not navbars) 
• Question Library 
• Quizzes 
• Release conditions and any associations 
• Rubrics 
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• Self Assessments 
• Surveys 

Export and import course packages containing SCORM objects across orgs 
You can export and import course packages containing SCORM objects across orgs. For 
example, when you export a course containing SCORM objects from Org A, copies of the 
SCORM objects are added to the exported course package. The end result is a course package 
available for import and SCORM objects with all references to the SCORM objects retained 
within the original course. 
When you import the course package into Org B, the SCORM objects are added into the org 
and re-linked to the imported course so references are not broken (the physical copy SCORM 
objects now exist in Org B, separate from Org A, where the course package was exported from). 
As a result, any instructor with the Can insert new SCORM objects permission for a course 
can access the SCORM objects that were copied into the imported course. 
Note the following: 

• If a course contains multiple links to a single SCORM object, the object is exported 
multiple times, once for each link, and included as a copy in the exported course package. 
When importing the course package, the package is imported multiple times, once for 
each link.  

• Bulk Course Copy, Bulk Course Export, and Bulk Course Create also support this 
functionality.  

Create platform-independent packages of learning resources 
The IMS Common Cartridge standard allows publishers and content providers to create 
platform-independent packages of resources (content, assessments, question libraries, 
discussions, etc.) building on existing IMS content and QTI quizzing packaging standards. 
Package creators can optionally protect the package, requiring users to authenticate with the 
creator using web services before importing or accessing protected resources. Common 
Cartridge was designed to provide a standard way to package and protect content, as opposed 
to each publisher or each learning management system creating a proprietary method of 
protection and enforcement. 
For more detailed information on the Common Cartridge project and its role in the Digital 
Learning Connection, visit the IMS Global Learning Consortium website. 

About importing IMS Common Cartridge packages 
You can import IMS Common Cartridge packages and expand your course offerings to include a 
wide range of innovative, platform-independent, and diverse course content from publishers and 
content providers. 

http://imsglobal.org/
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Importing an IMS Common Cartridge package follows the same process as importing other files 
of supported import formats. Importing a cartridge automatically creates the applicable content, 
quizzes, questions, etc. in Brightspace Learning Environment and makes them immediately 
available for use. Package creators have the option of protecting cartridges on import or forcing 
the user to enter an access code at the beginning of the import process. 

How protected IMS Common Cartridge resources are handled 
Any protected resource that imports from an IMS Common Cartridge package displays a  
Protectedicon beside it. When users first try to access a protected resource, they are prompted 
for an access code, which is distributed by the package creator. Entering the access code and 
accepting the license agreement initiates the electronic authorization with the package creator’s 
authorization web service and unlocks the resource for the user. 
The user is not prompted to enter their access code when accessing additional protected 
content from the package until the authorization period ends. The length of the authorization 
period is determined by the package creator and changes from one package to another. If a 
course contains protected resources from multiple packages, users are typically prompted for 
authorization only once per protected package. 
Protected resources can be copied between courses, but cannot be exported from Brightspace 
Learning Environment. 

IMS Common Cartridge versions 
Brightspace Learning Environment currently supports the following versions of IMS Common 
Cartridge:  

• IMS Common Cartridge 1.0 
• IMS Common Cartridge 1.1 
• IMS Common Cartridge 1.2 
• IMS Common Cartridge 1.3 and IMS Thin Common Cartridge 1.3 

The following table provides an overview of each version, including a summary of the features 
and any other technical details worth noting.  

IMS 
Common 
Cartridge 
version 

Summary Technical details 

IMS 
Common 
Cartridge 
1.0 

In the resource 
metadata context, 
includes the higher 
education value. 

The package file should have the extension .zip. 
Cartridge manifest metadata must refer to version 1.0.0. 
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Contains metadata 
for the intended user 
roles: Learner and 
Instructor. These are 
the user roles that 
can view the 
resource. 
Contains the 
intendedUse attribute 
for Web Content 
Resources. This 
attribute must contain 
one of the following 
values: lessonplan, 
syllabus, or 
unspecified.  

IMS 
Common 
Cartridge 
1.1 

Offers easy support 
and integration with 
IMS Learning Tools 
Interoperability (LTI) 
v1.0 resources. You 
can integrate rich 
learning applications 
or premium content 
with platforms or 
other systems from 
which applications 
can be launched, 
without additional 
customization. 
In the resource 
metadata context, 
includes the following 
values: higher 
education, school, 
training, and other. 
Adds metadata for 
the Mentor intended 
user role.  
The intendedUse 
attribute for Web 
Content Resources is 

IMS Common Cartridge 1.1 supports LTI links through Brightspace 
Learning Environment User Interface, Bulk Course Create (BCC), and 
Course Import API. 
The package file should have the extension .imscc. This extension 
helps identify files that are likely to be Common Cartridges. 
Users are notified in the processing logs when the resource is imported 
successfully; however, their intendedUse type is discounted. 
Cartridge manifest metadata must refer to version 1.1.0. 
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optional in this 
Cartridge version. 

IMS 
Common 
Cartridge 
1.2 

Includes metadata for 
curriculum standards, 
which provides the 
option to associate 
the cartridge, 
resource, or question 
item with zero or 
more curriculum 
standard identifiers, 
from one or more 
providers. Users can 
use any curriculum 
standard, provided 
that it supports 
unique identifiers.  
The intendedUse 
attribute for Web 
Content Resources 
offers a new attribute 
called Assignment. 

Curriculum standards metadata is recognized in v1.2, but is not 
supported by Brightspace Learning Environment. As a result, it is 
discounted, and users are instead notified in the processing logs 
whether their data was imported successfully. 
Common Cartridge specification has deprecated authorization to the 
Course Import workflow. D2L still supports it, but recommends that 
users use Learning Tools Interoperability (LTI) links to access 
remote/secure content. 
Cartridge manifest metadata must refer to version 1.2.0. 

IMS 
Common 
Cartridge 
1.3 

Allows you to import 
multiple question 
banks within a single 
cartridge. 
Provides the ability to 
specify Common 
Cartridge XML 
descriptions within an 
imsmanifest.xml file, 
which are imported by 
Brightspace Learning 
Environment. 
Provides the option to 
add metadata to LTI 
links. In Brightspace 
Learning 
Environment, this 
metadata is 
incorporated into the 
content topic so that it 

Question banks have no titles, so they are categorized as "Section 1", 
"Section 2", and so on, in Brightspace Learning Environment. Question 
banks can be translated into any language that D2L supports. 
For multiple imports of multiple question banks, section numbering does 
not increment; it is constrained to the number of banks within the 
package. For example, if users import a package containing two 
question banks, and then again with only a single question bank, the 
following occurs: 
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can point to the LTI 
link. 
  

 
Multiple question banks in a question library 
The following new features are not entirely supported by Brightspace 
Learning Environment: 

• ePub3, Interactive Whiteboard (IWB) and Accessible Portable 
Item Profile (APIP) file extensions for resources 

• Other unknown extensions for resources 

Brightspace Learning Environment imports files with these extensions 
into the Manage Files tool, but does not create a content topic because 
the content type is not currently supported in the application. Users will 
receive a message about this in the processing logs. 
Cartridge manifest metadata must refer to version 1.3.0. 

To view IMS official specs on Common Cartridge for each version, click the following:  

• IMS Common Cartridge 1.0 
• IMS Common Cartridge 1.1 
• IMS Common Cartridge 1.2 
• IMS Common Cartridge 1.3 and IMS Thin Common Cartridge 1.3 

http://www.imsglobal.org/cc/ccv1p0/imscc_profilev1p0.html
http://www.imsglobal.org/cc/ccv1p1/imscc_profilev1p1-Overview.html
http://www.imsglobal.org/cc/ccv1p2/imscc_profilev1p2-Overview.html
http://www.imsglobal.org/cc/ccv1p3/imscc_Overview-v1p3.html
http://www.imsglobal.org/cc/ccv1p3thin/ims_thinCC_impl-v1p3.html
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Customize the look and feel of your mobile web interface 
Use the Mobile Brand Administration page to customize the look and feel of your institution's 
Mobile Web interface. You can customize the colors and logo in the interface to match your 
organization's branding or modify the appearance of titles and headings to help users identify 
courses more easily. 
Customizing branding at the organization level establishes the default settings for the org and all 
org units; child org units do not receive default settings from their parent org units. If you 
customize any setting at the org unit level, all settings become custom to that org unit. This 
means that future changes to the organization branding will not transfer or overwrite settings in 
an org unit with custom branding (unless you restore defaults). 

Update mobile branding  

1. Do one of the following: 
• To update mobile branding for the organization, from the Admin Tools menu, click 

Mobile Brand Administration. 
• To update mobile branding for an org unit, click Course Admin > Mobile Brand 

Administration. 
2. Make your changes. 
3. Click Save. 

Mobile branding reference sheet 
Depending on whether you access the Mobile Brand Administration page from the organization 
or org unit level, you may not have access to all settings.  
The Mobile Web navbar does not reproduce settings from the Navbar tool. 

General 
The General settings include the following: 

• Background sets the color that appears behind the main content interface elements 
• Link Color sets the color of system links. 

Figure: The mobile interface showing the link color and background color as set in the General 
settings. 

Navbar 
The Navbar settings include the following: 
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• Logo Image sets the image that appears at the top of every screen on the navbar. Use 
this option to tailor your Mobile Web navbar to match your institution's logo or crest. The 
dimensions of your image should be no larger than 200 x 50 pixels to fit correctly on 
mobile screens. 

• Fill Type sets the type of background for the navbar area. You can choose between a 
solid or gradient background. Once you select the fill type, corresponding color options 
appear. 

Page Title 
The Page Title settings include the following: 

• Fill type sets the type of background for the page title bar. You can choose between a 
solid or gradient background. Once you select the fill type, corresponding color options 
appear. 

• Border Color sets the color of a thin border on the bottom of the page title area. 
• Text Color sets the color of the page title text.  

Headings 
The Headings settings include the following: 

• Fill Type sets the type of background for the heading bar. You can choose between a 
solid or gradient background. Once you select the fill type, corresponding color options 
appear. 

• Border Color sets the color of a thin border on the top and sides of the heading area. 
• Text Color sets the color of the heading text. 

Subheadings 
The Subheadings settings include the following: 

• Fill Type sets the type of background for the subheading bar. You can choose between a 
solid or gradient background. Once you select the fill type, corresponding color options 
appear.  

• Border Color sets the color of a thin dotted border on the bottom of the subheading area. 
• Text Color sets the color of the subheading text. 

Organize and manage week-specific course items 
A checklist contains important or required assignments, readings, or other items to complete. 
Each checklist contains one or more categories, into which checklist items are organized. For 
example, you might have an “Assignments” checklist with categories for written assignments 
and quizzes, both of which could have multiple items that must be completed. 
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How do checklists organize information? 
Checklists contain categories, which are used to organize checklist items. For example, you 
might create the categories Week 1, Week 2, and Week 3, and place week-specific checklist 
items into the appropriate categories. Alternately, you might use a checklist to organize steps of 
an assignment. You can assign due dates for checklist items. 

Create a checklist 
Checklist items must reside in a category. 

1. On the navbar, click Checklist. 
2. Click New Checklist. 
3. Enter your checklist details. 
4. Click Save. 
5. On the Edit Checklist page, in the Categories and Items area, do any of the following: 

• To add a category to the checklist, click New Category. Enter your category details 
and click Save. 

• To add an item to the checklist, click New Item. From the Category drop-down list, 
select the category for your item. Enter your item details. If you want the item to be 
due by a certain date or time, select the check box and enter your Due Date 
information. Click Save. 
Note: The default due date for a checklist item is one month from the current date. 

6. Repeat step 5 until you've added all your content to the checklist. 
7. Click Save and Close. 

Copy a checklist 

1. On the navbar, click Checklist. 
2. Open the context menu for the checklist you want to copy, and click Copy. 
3. A new checklist is now visible at the bottom of the list of checklists with the title Copy of 

{original checklist name}. 

Set release conditions for a checklist 

1. On the navbar, click Checklist. 
2. From the context menu of the checklist for which you want to set release conditions, click 

Edit. 
3. In the Restrictions tab, do any of the following: 

• Click Attach Existing, then select the check box for any condition you want to 
attach. Click Attach. 

• Click Create and Attach, then select a Condition Type from the drop-down list. 
Complete any additional Condition Details that appear and click Create. 
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4. To set how accessing the checklist is controlled, from the drop-down list, select if All 
conditions must be met or Any condition must be met. 

5. Click Save and Close. 

About Manage Dates 
Use the Manage Dates tool to view, bulk edit, and bulk offset the date availability and set the 
calendar status of all content topics and modules, discussion topics and forums, assignment 
submissions folders, grades categories and items, announcement items, quizzes, checklists, 
and surveys in your course from one central location.  
These course objects display in a grid that you can sort by any of the column headings. You can 
also use the Type column to sort the Manage Dates page based on the tool-specific order and 
use advanced filter options to work with smaller sets of objects. If you filter your course objects, 
any bulk changes you make apply only to the filtered results. This enables you to update 
multiple availability dates based on specific criteria.  
In addition to managing dates, you can open each course object in a new window by clicking on 
its name. This launches the object's edit page where you can edit additional properties for that 
object without leaving the Manage Dates tool.  

Bulk edit dates in Manage Dates 
The Manage Dates tool enables you to bulk edit due dates and availability dates of your course 
content. 

1. On the navbar, click Course Admin. 
2. Click Manage Dates. 
3. Select the check box of the items for which you want to bulk edit dates. 
4. Click Bulk Edit Dates. 
5. In the Bulk Edit Dates dialog box, update the due dates and availability dates. 
6. Click Save. 

Offset dates in Manage Dates 
To offset dates in Manage Dates 
The Manage Dates tool enables you to move start dates and end dates forward or backward by 
a specified number of days. You can use this to move course content forward to a new term. 

1. On the navbar, click Course Admin. 
2. Click Manage Dates. 
3. Select the check box by any item for which you want to offset dates. 
4. Click Bulk Offset Dates. 
5. In the Bulk Offset Dates dialog box, enter your offset details. 
6. Click Save. 
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Manage course events 
Use the Calendar tool to arrange and visualize course events in multiple views and enable 
integration of course content and your Calendar. You can use iCal to synchronize the Calendar 
tool to your personal calendars (such as Outlook and Google Calendar, as well as iPhone and 
Android). 

Calendar interface overview 

 
1) Use the calendar views area to toggle between different event display layouts. Use the 
Agenda view to group your course events by Date, Course, or Category - events display in 
chronological order, and all-day events display at the top of each grouped listing. Use the Day, 
Week, and Month views to group your events in daily, weekly, or monthly increments. Use the 
List view to filter your events by Assignments, Checklists, Discussions, Grades, Materials, 
Modules, Quizzes, and Surveys.  
2) Use the calendar content area to navigate through your content. Navigation will vary 
depending on the view you select. 
3) Use the calendar menu to select multiple calendars to display, change the color scheme 
associated with individual calendars, and add new calendars.  
4) Use the mini calendar to navigate quickly to a specific day, week, or month.  



 

163 
© 2022 D2L Corporation. All rights reserved. 

5) Use the task pane to create, track, and maintain personal tasks.  

Create course events in Calendar 
To create course events in Calendar 

1. On the navbar, click Calendar. 
2. Click Create Event. 
3. To associate course content with the event, click Add Content. Select the module from 

which you want to add content. Click Add. 
4. Do one of the following: 

• If you've associated course content with the event and want to use a custom name 
for the event, select the Use custom name check box. Enter a name for your 
event. 

• If you have not associated course content with the event, enter a name for your 
event. 

5. To add date and time details to your course event, in the When area, click on the provided 
fields. 

6. To add recurrences to the event, click Add Recurrence. Enter your event recurrence 
details. 

7. To add restrictions to the event, click Add Restriction. Enter your event restriction details. 
8. To add a location for the event, from the Location drop-down list, select the location.  
9. Click Create. 

Change Calendar settings 

1. On the navbar, click Calendar. 
2. Click Settings. 
3. Make your changes. 
4. Click Save. 

Create multiple instances of an event for different groups and sections 
If you have more than one group or section participating in the same course event during 
different time intervals, you can create multiple instances of the same event, tailored to each 
group or section’s needs. The group or section events share the name and description fields, 
but once you finish creating the events in bulk, they display as individual events.  

1. On the navbar, click Calendar. 
2. Click Create Event. 
3. In the Attendees area, click Add Groups/Sections. This option is only available if you 

have already created at least one group or section for your course.  
4. In the Add Groups dialog, click on the group or section you want to add. 
5. Repeat steps 3-4 until you have added all of the groups and sections you want. 



 

164 
© 2022 D2L Corporation. All rights reserved. 

6. Enter the rest of your event details, including any customizations for an individual group or 
section. 

7. Click Create. 

Change visibility for events 

1. On the navbar, click Calendar. 
2. From the tool navigation, click List. 
3. Select the check boxes by any event for which you want to make visibility changes. 
4. From the More Actions button, click Change Event Visibility. 
5. From the Event Visibility drop-down list, select your visibility preference. 
6. Click Save. 

Offset dates for events 

1. On the navbar, click Calendar. 
2. From the tool navigation, click List. 
3. Select the check boxes by any event for which you want to offset dates. 
4. From the More Actions button, click Offset Dates. 
5. Make your changes. 
6. Click Save. 

Delete course events in Calendar 

1. On the navbar, click Calendar. 
2. From the tool navigation, click List. 
3. Select the check boxes of any event(s) you want to delete. 
4. From the More Actions button, click Delete. 
5. In the Confirmation dialog, click Yes. 

What are the basics of Attendance?  
The Attendance tool enables you to create registers that track attendance for activities within 
your organization or course. You can track attendance for any number of activities and 
customize your registers to suit your needs.  
Use the Attendance tool to create sessions to track attendance and define attendance statuses 
for your activities. You can assign grades for user attendance, view attendance results, and 
track users that have poor attendance.  
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How attendance is calculated 
The % Attendance field is calculated by adding the total assigned % for each status and then 
dividing it by the number of statuses that have an assigned %. This is represented using the 
following illustrated formula:  
Sum of Assigned % / Total of statuses with an Assigned % x 100 
To understand how this calculation works in practice, consider a scheme with the following set 
of statuses: 

Symbol Status Full 
Name 

Assigned % Order 

P Present 100 1 

A Absent 0 2 

L Late 75 3 

AA Authorized 
Absent 

  4 

If the associated register has four sessions and you assign a user each of the above statuses 
(one for each session), their % Attendance field would include the P, A, and L statuses and 
ignore the AA status since its Assigned % is blank. As such, the user would have a % 
Attendance of 58.33 ((100+0+75)/(100x3)x100=58.33). Adding an Assigned % of 100 to the AA 
status would change the user's % Attendance to 68.75 ((100+0+75+100)/(100x4)x100=68.75).  

Track attendance 

1. On the Attendance Data page, click the Enter Attendance Data icon and enter 
attendance data for your sessions. 

2. Use the Attendance Status drop-down lists to change the attendance status for your 
users. You can also click Set Status to set the same status for all users.  

Set your Cause for Concern percentage 
The Cause for Concern metric helps you track learners that fail to meet your attendance 
requirements by placing the Cause for Concern icon beside their names on the Attendance Data 
page.  

1. From the Attendance Registers page, click New Register or Edit Register from the 
context menu of an existing attendance register.  

2. In the Cause for Concern field, enter a percentage that indicates your minimum 
attendance requirement.  
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3. Click Save.  

Edit, delete, and restore attendance registers, sessions, or schemes 
To edit an attendance register: 

1. On the Attendance Registers page, from the drop-down menu of the register you want to 
edit, select Edit Register. 

2. Update the details of the attendance register and click Save. 
Note: You cannot change the scheme in an attendance register once session information 
has been added to it. 

  
To delete attendance registers: 

1. To delete an individual attendance register, on the Attendance Registers page, from the 
drop-down menu of the register you want to edit, select Delete. 
To delete attendance registers in bulk, select the check boxes of the attendance registers 
you want to delete, and on the More Actions drop-down menu, select Delete. 

2. On the Confirmation dialog box, click Delete. 

  
To restore attendance registers: 

1. On the Attendance Registers page, click the More Actions drop-down menu, and then 
select View Deleted Registers. 

2. Click Restore alongside the name of the register you want to restore. 

  
To delete sessions: 
Sessions are the components of an attendance register that define one or more events to which 
the register applies. 
For example, if you want to track attendance for a weekly seminar, create a Weekly Seminar 
register and then add sessions for each seminar (week 1, week 2, week 3, etc.). Attendance 
data is tracked for each session and displayed on the register's Attendance data page. 
Deleting a session in a register or a scheme clears all associated attendance data. Only delete 
sessions when you are confident that you no longer need the attendance data. 

1. On the Attendance Registers page, from the drop-down menu of the attendance register 
you want to edit, select Edit Register. 

2. Click Delete alongside the session you want to delete. 
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Modify the visibility of attendance registers 
You can modify the visibility of attendance registers individually or in bulk: 

1. On your navbar, click Course Admin. 
2. Under Learner Management, click Attendance. 
3. To modify the visibility of an individual register, from the context menu of the particular 

register, select Make Visible to Users or Hide from Users. 
4. To modify the visibility of registers in bulk, select the check boxes alongside the registers 

you want to make visible or hide from learner view. 
5. On the More Actions drop-down menu, select Make Visible to Users or Hide from 

Users. An icon appears next to hidden registers. 

Monitoring a course 
Instructors can monitor a course the following ways: 

• Track activity and user progress on SCORM objects 
• About tracking content completion and participation 
• Manage completion tracking settings for a topic 
• Check completion tracking for a content topic 
• Checking course content statistics 
• Check course content feedback 
• Change content display settings 
• View user progress in Content 

Track activity and user progress on SCORM objects 
If your course is based on SCORM, or uses SCOs as part of the course content, you have 
access to additional activity reports for each SCORM object and user. The reports track the 
activity on a topic and individuals’ progress with meeting defined objectives, and in defined 
interactions with the course content. 
The data in these reports depends on the data communicated to Brightspace Learning 
Environment by your SCOs. For example, if the SCO does not set values for objectives, then no 
objective information is available in the SCORM reports for that SCO. This data also depends on 
the SCORM solution you are using. If you are using the new SCORM solution, the available 
data is limited at this time. Note that you can export SCORM statistics; however, unlike non-
SCORM courses, you cannot reset the statistics. If you are using the legacy SCORM solution, 
the following information and steps apply: 

1. On the navbar, click Content. 
2. On the Table of Contents page, from the Related Tools button, click View Reports. 
3. In the Legacy SCORM Reports area, do one of the following: 
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• To view information on user progress and whether their progress is complete or 
incomplete, their status, their score, number of attempts, time spent, average time 
spent, and when they last accessed it, in the SCORM Objects tab, click the 
Summary icon. 

• To view information on user progress with the course objectives including their 
score, status, progress, and progress measure, in the SCORM Objects tab, click 
the Objective Details icon. 

To view information on user attempts at the interactions in an objective including question 
type, correct response, learner response, result, weighting, and time spent, in the SCORM 
Objects tab, click the Interaction Details icon. 

• To view information on a specific user, in the Users tab, click on a user's name. For 
more information about a user's progress with a specific object, click the Details 
icon. 

If you are using the new SCORM solution, the following information and steps apply: 

1. On the navbar, click Content. 
2. On the Table of Contents page, from the Related Tools button, click View Reports. 
3. In the SCORM Reports area, do one of the following: 

• Click the Summary Icon in the SCORM Objects tab to view information on user 
progress and whether their progress is complete or incomplete, their status, their 
score, number of attempts, time spent, average time spent, and when they last 
accessed it. 

• In the SCORM Objects Tab, click the Objectives icon to view information on user 
progress with the course objectives including their score, status, progress, and 
progress measure. 

• To view information on user attempts at the interactions in an objective including 
question type, correct response, learner response, result, weighting, and time spent, 
in the SCORM Objects tab, click the Interactions icon. 

• To view information on a specific user, in the Users tab, click on a user's name. 
Click the Details icon for more information on a user's progress with a specific 
object. 

What does Brightspace Learning Environment report on for SCORM objects? 
For each SCORM object, Brightspace Learning Environment records: 

• The number of user attempts on the object. 
• The number of attempts completed. (Some attempts appear as incomplete if a user ends 

the attempt at an object). 
• The number of attempts passed, the passing score, and the average score. 
• Average time spent on the object (for the legacy SCORM solution). 
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You can also view details on user attempts, objectives, and interactions for each item in both the 
legacy SCORM solution and the new SCORM solution. These details can be accessed by 
navigating to SCORM Reports from a course's reports page (Content > Table of Contents > 
Related Tools > View Reports > SCORM Reports), and selecting the Summary, 
Interactions, or Objectives button. 
Note: If a learner views a content topic using a direct link to the topic in full-screen mode, the 
SCORM reports won’t reflect that the learner accessed the topic. 

What does Brightspace Learning Environment report on for users of SCORM 
objects? 
For each user of SCORM content, Brightspace Learning Environment records: 

• The user’s name and ID numbers. 
• The number of SCORM objects attempted. 

In both the legacy SCORM solution, and the new SCORM solution, you can access details on a 
user's progress, status, scores, attempts, time spent, date last accessed, objective details, and 
interaction details.  
Note: If a learner views a content topic using a direct link to the topic in full-screen mode, the 
SCORM Reports won’t reflect that the learner accessed the topic. 

About tracking content completion and participation 
Completion tracking enables instructors to set the method of completion for an activity and 
provides progress indicators for learners as they complete course activities. There are two types 
of completion tracking you can use in your course offerings: 

• Automatic Completion - Completion tracking that automatically determines whether 
users have completed a topic when they click to view it. For some activities, automatic 
tracking requires users to participate in a chat or discussion, submit a file or form, or 
complete an assessment such as a quiz or survey before completion is successful.  

• Manual Completion - Completion tracking that is manually set by users. Users can select 
the completion check box beside each content topic to indicate they have completed it. 
Although users can use manual tracking to indicate that they have accomplished a task 
before it is completed (for example, selecting the completion check box beside a quiz 
activity before attempting the quiz at all), this does not affect assessment scores or user 
attempts counted towards an activity.  

Changing an automatically tracked topic to manual completion resets completion tracking for 
that topic. This means that users might have to return to the topic to mark it complete; users do 
not need to resubmit files or assessment activities.  
For the new SCORM solution, the checkmark that appears in the integrated learning platform 
only appear when a learner has completed the SCORM content (rather than when the learner 



 

170 
© 2022 D2L Corporation. All rights reserved. 

launches the object). Note: The checkmark only appears if the SCORM object was programmed 
with a completion event. 

Manage completion tracking settings for a topic 

1. On the navbar, click Content. 
2. On the Table of Contents drop-down menu, select Set All Completion. 
3. Select one of the following completion methods: 

• Required: Automatic 
• Required: Manual 
• Not Required 

4. Click Update. 

Check completion tracking for a content topic 
To check completion tracking for a content topic 

1. On the navbar, click Content. 
2. Click on the topic you want to view completion tracking results for. 
3. In the Completion Summary tab, do any of the following: 

• To view all users' results for the topic, click All. 
• To view all users who have completed the topic, click Completed. 
• To view all users who have not completed the topic, click Incomplete. 

Note: You can only view a Completion Summary for courses with fewer than 1000 learners 
enrolled. 

Checking course content statistics 
Course content statistics can display the total number of users, the number of users who visited 
course content, and the average time users spent viewing content. You can view overall course 
content statistics as well as specific statistics for individual modules and topics. 

To check course content statistics in the classic Content experience: 

1. On the navbar, click Content. 
2. On the Table of Contents page, from the Related Tools drop-down list, click View 

Reports. 
3. In the Statistics area, do any of the following: 

• To view all statistics for a module or topic, in the Content tab, click the Available 
To or Users Visited value for the module or topic. 

• To view statistics for a particular user, in the Users tab, click the user's name. 
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To check course content statistics in Lessons: 

1. On the navbar, click Content. 
2. On the Content Navigation Tree, from the  Course options drop-down list, click View 

Reports. 
3. In the Statistics area, do any of the following: 

• To view all statistics for a module or topic, in the Content tab, click the Available 
To or Users Visited value for the module or topic. 

• To view statistics for a particular user, in the Users tab, click the user's name. 

Some things to consider when checking course content statistics: 

• A user who visits multiple times is only counted once. 
• The total number of users counted in statistics does not include any users with the 

Manage Content permission. 
• Calculated time users spent viewing overall content or individual modules or topics does 

not include user session timeouts and users currently visiting content, modules, and topics 
as you view statistic details. 

• Reset Statistics only resets the number of visits to, and the time spent in each content 
topic that is displayed on the Content Statistics page and in the Class Progress tool. 

• Reset Statistics does not reset the content completion status of any content topic(s) for 
any user, in the Content tool or in the Class Progress tool. 

• Export Statistics allows you to generate a CSV file containing all of your statistics for 
viewing and analysis outside of Brightspace Learning Environment. 

•  The Available To value on the Content tab displays the number of users (from the class 
list) that the content is available to. A topic or module is available to a user if the following 
is true:  

•  Current date is within the availability dates of the topic or module  
•  Users have met all required release conditions  
•  Content topic or module is published/visible  

Note: This value takes into account the following: release conditions, special 
access (assignments and quizzes), group access (assignments and discussions), 
availability dates, hidden/visible state, and if the module parent is "available."  

Check course content feedback 
Feedback shows the ratings and comments users submit about specific course content. Users 
can submit ratings and comments anonymously or include their user names. 

1. On the navbar, click Content. 
2. On the Table of Contents page, from the Related Tools drop-down list, click View 

Reports. 
3. In the Feedback area, click the Ratings link for the topic. 
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Change content display settings 

1. On the navbar, click Content. 
2. Click Settings. 
3. Make your changes and click Save. 

View user progress in Content 
You can view general details of a user's completion tracking in the Class Progress tool. 
If you access the Content section on the Class Progress page, you can track how many visits a 
user makes to the Content tool, how much time is spent viewing course material, and how many 
topics were visited. Expand the report details under each module to find a further breakdown of 
a user's actions. The expanded details show all topics and sub-modules within the module, how 
many visits the user made for each topic, and how much time was spent in each topic. Clicking 
on the module or topic's name brings you to that module or topic in the Content tool. 

1. On the navbar, click Content. 
2. On the Table of Contents page, click on the topic you want to view progress for. 
3. In the Completion Summary tab, hover your mouse over the profile picture for the user 

you want to review progress for. 
4. In the user's profile badge that displays, click Progress. 

The Progress Summary page displays, showing overall user progress results for the current 
course. To only view Content results, from the course side panel, click Content. 
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About D2L 
A global leader in EdTech, D2L is the creator of Brightspace, the world’s first integrated learning 
platform. 
The company partners with thought-leading organizations to improve learning through data-
driven technology that helps deliver a personalized experience to every learner, regardless of 
geography or ability. D2L’s open and extensible platform is used by more than 1,100 clients and 
almost 15 million individual learners in higher education, K–12, healthcare, government, and the 
enterprise sector—including Fortune 1000 companies. 
The company has operations in the United States, Canada, Europe, Australia, Brazil, and 
Singapore. www.D2L.com 
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